
ICS-1500 ION CHROMATOGRAPHY SYSTEM
OPERATOR’S MANUAL

Document No. 031917
Revision 02

September 2005

Anuta
New Stamp



©2005 by Dionex Corporation
All rights reserved worldwide.
Printed in the United States of America.

This publication is protected by federal copyright law. No part of this publication 
may be copied or distributed, transmitted, transcribed, stored in a retrieval system, or 
transmitted into any human or computer language, in any form or by any means, 
electronic, mechanical, magnetic, manual, or otherwise, or disclosed to third parties 
without the express written permission of Dionex Corporation, 1228 Titan Way, 
Sunnyvale, California 94088-3603 U.S.A.

DISCLAIMER OF WARRANTY AND LIMITED WARRANTY
THIS PUBLICATION IS PROVIDED “AS IS” WITHOUT WARRANTY OF 
ANY KIND. DIONEX CORPORATION DOES NOT WARRANT, 
GUARANTEE, OR MAKE ANY EXPRESS OR IMPLIED 
REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE 
USE, OF THIS PUBLICATION IN TERMS OF CORRECTNESS, ACCURACY, 
RELIABILITY, CURRENTNESS, OR OTHERWISE. FURTHER, DIONEX 
CORPORATION RESERVES THE RIGHT TO REVISE THIS PUBLICATION 
AND TO MAKE CHANGES FROM TIME TO TIME IN THE CONTENT 
HEREINOF WITHOUT OBLIGATION OF DIONEX CORPORATION TO 
NOTIFY ANY PERSON OR ORGANIZATION OF SUCH REVISION OR 
CHANGES.

TRADEMARKS
AES, Atlas, Chromeleon, EluGen, IonPac, OnGuard, and SRS are registered 
trademarks of Dionex Corporation. CarboPac, MicroMembrane, MMS, Reagent-
Free, and RFIC are trademarks of Dionex Corporation.
Acrobat, Adobe, and Adobe Reader, are registered trademarks of Adobe Systems, 
Incorporated.
PEEK is a trademark of Victrex PLC.
Teflon is a registered trademark of E.I. duPont de Nemours & Company.
Microsoft and Windows are registered trademarks of Microsoft Corporation.

PRINTING HISTORY
Revision 01, March 2003
Revision 02, September 2005



Doc. 031917-02 9/05 i

Contents

1 • Introduction

1.1 Introduction to Ion Chromatography (IC) . . . . . . . . . . . . . . . . . . . . . . .1-1

1.2 Overview of the ICS-1500 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-4

1.3 About This Manual  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-5

1.3.1 Safety Messages and Notes  . . . . . . . . . . . . . . . . . . . . . . . . . . .1-6

1.3.2 Safety Labels  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-8

2 • Features

2.1 Operating Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-1

2.1.1 Front Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-1

2.1.2 Top Cover . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-5

2.1.3 Component Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-6

2.1.4 Rear Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-9

2.2 Flow Schematic . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-11

2.3 The Chromeleon Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-13

2.3.1 The Chromeleon Main Window and Browser . . . . . . . . . . . .2-14

2.3.2 The ICS-1500 Control Panels . . . . . . . . . . . . . . . . . . . . . . . . .2-15

2.4 System Component Details . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-21

2.4.1 Vacuum Degas Assembly (Optional)   . . . . . . . . . . . . . . . . . .2-21

2.4.2 Eluent Valve . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-23

2.4.3 Pump . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-23



ICS-1500 Ion Chromatography System

ii Doc. 031917-02 9/05

2.4.4 Injection Valve  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-26

2.4.5 Column Heater . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-28

2.4.6 Suppressor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-28

2.4.7 DS6 Heated Conductivity Cell  . . . . . . . . . . . . . . . . . . . . . . . 2-29

3 • Operation and Maintenance

3.1 Operation Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-1

3.2 Power Up the System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-3

3.3 Start Chromeleon  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-4

3.4 Set Up the Eluent Reservoir . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-6

3.4.1 Prepare the Eluent  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-6

3.4.2 Degas the Eluent  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-6

3.4.3 Filter the Eluent . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-7

3.4.4 Fill the Reservoir . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-7

3.4.5 Set the Eluent Level . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-8

3.4.6 Connect the Reservoir . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-9

3.5 Check All Connections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-9

3.6 Prime the Pump  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-10

3.7 Set System Operating Conditions . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-11

3.8 Equilibrate the System and Verify Operational Status   . . . . . . . . . . . 3-11

3.9 Prepare Samples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-13

3.9.1 Collecting and Storing Samples  . . . . . . . . . . . . . . . . . . . . . . 3-13

3.9.2 Pretreating Samples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-13

3.9.3 Diluting Samples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-13



Contents

Doc. 031917-02 9/05 iii

3.10 Loading and Injecting Samples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-14

3.10.1 Loading Samples with a Syringe  . . . . . . . . . . . . . . . . . . . . . .3-15

3.10.2 Loading Samples with a Vacuum Syringe . . . . . . . . . . . . . . .3-16

3.10.3 Loading Samples with an Autosampler  . . . . . . . . . . . . . . . . .3-16

3.10.4 Injecting Samples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-17

3.10.5 Example Chromeleon Commands for Loading and 
Injecting Samples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-17

3.11 Process Samples  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-18

3.11.1 Manual Sample Processing  . . . . . . . . . . . . . . . . . . . . . . . . . .3-18

3.11.2 Automatic (Batch) Sample Processing . . . . . . . . . . . . . . . . . .3-19

3.12 Maintenance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-21

4 • Troubleshooting

4.2 Error Messages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-1

4.1 Troubleshooting Error Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-3

4.2 Liquid Leaks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-9

4.3 Pump Difficult to Prime or Loses Prime . . . . . . . . . . . . . . . . . . . . . . .4-11

4.4 Pump Does Not Start . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-13

4.5 No Flow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-14

4.6 Erratic Flow/Pressure Reading  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-15

4.7 Excessive System Backpressure  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-15

4.8 Peak “Ghosting”  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-16

4.9 Nonreproducible Peak Height or Retention Time . . . . . . . . . . . . . . . .4-17

4.10 Abnormal Retention Time or Selectivity  . . . . . . . . . . . . . . . . . . . . . .4-17

4.11 No Cell Response  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-18



ICS-1500 Ion Chromatography System

iv Doc. 031917-02 9/05

4.12 High Cell Output  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-18

4.13 Baseline Noise or Drift . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-19

4.14 Vacuum Degas Assembly Does Not Run . . . . . . . . . . . . . . . . . . . . . . 4-21

5 • Service

5.1 Diagnostic and Calibration Procedures  . . . . . . . . . . . . . . . . . . . . . . . . 5-1

5.1.1 Chromeleon Wellness Panel Overview . . . . . . . . . . . . . . . . . . 5-2

5.1.2 Diagnostic and Calibration Touch Screen Overview  . . . . . . . 5-4

5.1.3 Calibrating the Conductivity Cell  . . . . . . . . . . . . . . . . . . . . . . 5-5

5.1.4 Calibrating the Flow Rate  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-8

5.1.5 Calibrating the Vacuum Degas Assembly . . . . . . . . . . . . . . . 5-10

5.2 Isolating a Restriction in the Liquid Lines . . . . . . . . . . . . . . . . . . . . . 5-11

5.3 Replacing Tubing and Fittings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-13

5.4 Rebuilding the Injection Valve . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-14

5.5 Cleaning and Replacing the Pump Check Valves  . . . . . . . . . . . . . . . 5-15

5.6 Replacing a Pump Piston Seal and Piston Rinse Seal  . . . . . . . . . . . . 5-17

5.7 Replacing a Pump Piston  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-21

5.8 Replacing the Waste Valve or Priming Valve O-Ring . . . . . . . . . . . . 5-22

5.9 Replacing the Conductivity Cell . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-24

5.10 Replacing the Suppressor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-27

5.11 Replacing the Column Heater . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-28

5.12 Replacing the Column Heater Heat Exchanger  . . . . . . . . . . . . . . . . . 5-31

5.13 Replacing the Eluent Valve  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-32

5.14 Replacing the Leak Sensor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-34



Contents

Doc. 031917-02 9/05 v

5.15 Priming the Pump with Isopropyl Alcohol  . . . . . . . . . . . . . . . . . . . . .5-35

5.16 Changing Main Power Fuses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-36

A • Specifications

A.1 Electrical  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-1

A.2 Physical  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-1

A.3 Environmental . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-1

A.4 Front Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-2

A.5 Pump  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-2

A.6 Detector . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-3

A.7 Conductivity Cell with Heat Exchanger  . . . . . . . . . . . . . . . . . . . . . . . A-3

A.8 Injection Valve  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-3

A.9 Vacuum Degas Assembly (Optional)  . . . . . . . . . . . . . . . . . . . . . . . . . A-3

A.10 Column Heater   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-4

B • Installation

B.1 Facility Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-1

B.2 Unpacking the ICS-1500 System  . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-2

B.2.1 Unpacking the Computer (North America only). . . . . . . . . . . B-4

B.2.2 Unpacking the Computer (outside North America)  . . . . . . . . B-4

B.3 Installing Chromeleon . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-5

B.4 Installing the Chromeleon Software License  . . . . . . . . . . . . . . . . . . . B-6

B.5 Connecting the ICS-1500 to the Chromeleon PC  . . . . . . . . . . . . . . . . B-9

B.5.1 Connecting the ICS-1500 to the PC  . . . . . . . . . . . . . . . . . . . . B-9



ICS-1500 Ion Chromatography System

vi Doc. 031917-02 9/05

B.5.2 Connecting Additional USB Devices. . . . . . . . . . . . . . . . . . .B-10

B.6 Connecting the Power Cord  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-11

B.7 Turning On the ICS-1500 Power  . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-12

B.8 Setting Up Chromeleon  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-14

B.8.1 Assigning the ICS-1500 to a Timebase  . . . . . . . . . . . . . . . . .B-14

B.8.2 Assigning DX-LAN Devices to the Timebase (Optional) . . .B-19

B.9 Installing and Plumbing the Columns and Suppressor . . . . . . . . . . . .B-22

B.9.1 Setting Up the Column Heater  . . . . . . . . . . . . . . . . . . . . . . .B-22

B.9.2 Installing the Columns . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-23

B.9.3 Installing the Suppressor  . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-24

B.10 Connecting the Waste Lines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-26

B.10.1 Installing the Gas Separator Waste Tube . . . . . . . . . . . . . . . .B-26

B.11 Setting Up the Eluent Reservoir . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-28

B.12  Setting Up a Chromeleon Application . . . . . . . . . . . . . . . . . . . . . . . .B-29

B.12.1 Verifying Chromeleon Communication . . . . . . . . . . . . . . . . .B-38

B.13 Setting the Eluent Level . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-39

B.14 Priming the Pump . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-40

B.14.1 Priming the Eluent Lines with a Syringe . . . . . . . . . . . . . . . .B-40

B.14.2 Priming with the Prime Button. . . . . . . . . . . . . . . . . . . . . . . .B-42

B.15 Equilibrating the System  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-43

B.16 Verifying Operational Status  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-43

B.17 Connecting an AS or AS50 (USB) Autosampler (Optional)  . . . . . . .B-44

B.17.1 AS or AS50 (USB) Connections  . . . . . . . . . . . . . . . . . . . . . .B-45

B.17.2 AS or AS50 (USB) Chromeleon Setup  . . . . . . . . . . . . . . . . .B-47

B.18 Connecting an AS40 Automated Sampler (Optional)  . . . . . . . . . . . .B-48



Contents

Doc. 031917-02 9/05 vii

B.19 Analog Output Connection (Optional)  . . . . . . . . . . . . . . . . . . . . . . . B-50

B.20 Pressurizing the Eluent Reservoir (Optional)  . . . . . . . . . . . . . . . . . . B-50

B.20.1 Connecting the Gas Source (Optional) . . . . . . . . . . . . . . . . . B-51

B.20.2 Pressurizing the Eluent Reservoir (Optional) . . . . . . . . . . . . B-52

B.21 Pump Continuous Seal Wash Connections (Optional)  . . . . . . . . . . . B-53

B.22 Manually Connecting to a Control Panel  . . . . . . . . . . . . . . . . . . . . . B-55

B.23 Installation Troubleshooting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-57

C • Touch Screen Operation

C.1 Using the Touch Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C-1

C.2 Using the Touch Screen with Chromeleon  . . . . . . . . . . . . . . . . . . . . . C-4

C.3 Overview of ICS-1500 Touch Screen Pages . . . . . . . . . . . . . . . . . . . . C-5

C.4 Home Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C-6

C.4.1 Home Page Pump Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . C-6

C.4.2 Home Page Column Heater. . . . . . . . . . . . . . . . . . . . . . . . . . . C-8

C.4.3 Home Page Injection Valve Controls . . . . . . . . . . . . . . . . . . . C-8

C.4.4 Home Page Detector Controls. . . . . . . . . . . . . . . . . . . . . . . . . C-8

C.4.5 Other Home Page Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . C-9

C.5 Plot Page  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C-10

C.6 Status Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C-11

C.6.1 Viewing Other Status Parameters . . . . . . . . . . . . . . . . . . . . . C-13

C.6.2 Status Parameter Details . . . . . . . . . . . . . . . . . . . . . . . . . . . . C-15

C.7 Pump Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C-15

C.7.1 Setting Pump Pressure Limits and Selecting the Pressure 
Unit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C-16



ICS-1500 Ion Chromatography System

viii Doc. 031917-02 9/05

C.7.2 Setting Degas Operating Parameters (Optional)  . . . . . . . . . .C-17

C.7.3 Controlling the Eluent Valve . . . . . . . . . . . . . . . . . . . . . . . . .C-18

C.8 Suppressor Page  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-18

C.9 Detector Page  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-20

C.9.1 Setting the Data Rise Time. . . . . . . . . . . . . . . . . . . . . . . . . . .C-20

C.9.2 Selecting the Conductivity Polarity . . . . . . . . . . . . . . . . . . . .C-21

C.9.3 Setting Analog Out Options . . . . . . . . . . . . . . . . . . . . . . . . . .C-21

C.10 Information Page  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-23

C.11 Module Setup Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-24

C.12 Input/Output Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-25

C.13 Diagnostic and Calibration Pages . . . . . . . . . . . . . . . . . . . . . . . . . . . .C-26

D • TTL and Relay Control

D.1 TTL and Relay Connections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .D-1

D.1.1 Selecting TTL Input Functions and Control Types . . . . . . . . .D-3

D.2 Controlling TTL and Relay Outputs . . . . . . . . . . . . . . . . . . . . . . . . . . .D-5

D.3 Example Setup for Stand-Alone Operation  . . . . . . . . . . . . . . . . . . . . .D-7

E • Reordering Information

F • FAQ

F.1 How do I hook up an autosampler?  . . . . . . . . . . . . . . . . . . . . . . . . . . . F-1

F.2 How do I print? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-1

F.3 Why are the retention times moving? . . . . . . . . . . . . . . . . . . . . . . . . . . F-1



Contents

Doc. 031917-02 9/05 ix

F.4 How do I adjust retention times? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-1

F.5 When should I remake standards? . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-1

F.6 When should I remake eluents? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-2

F.7 How do I start Chromeleon?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-2

F.8 How do I delete data?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-2

F.9 How do I back up data? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-2

F.10 How do I shut off the system? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-2

F.11 How do I store columns? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-2

F.12 How do I know when a column is dirty? . . . . . . . . . . . . . . . . . . . . . . . F-2

F.13 How do I clean a column? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-3

F.14 Why is the conductivity high? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F-3

G • Glossary



ICS-1500 Ion Chromatography System

x Doc. 031917-02 9/05



Doc. 031917-02 9/05 1-1

1 • Introduction

1.1 Introduction to Ion Chromatography (IC)

The Dionex ICS-1500 Ion Chromatography System (ICS-1500) performs ion 
analyses using suppressed or non-suppressed conductivity detection. An ion 
chromatography system typically consists of a liquid eluent, a high-pressure 
pump, a sample injector, a guard and separator column, a chemical suppressor, a 
conductivity cell, and a data collection system. 

Before running a sample, the ion chromatography system is calibrated using a 
standard solution. By comparing the data obtained from a sample to that obtained 
from the known standard, sample ions can be identified and quantitated. The data 
collection system, typically a computer running chromatography software, 
produces a chromatogram (a plot of the detector output vs. time). The 
chromatography software converts each peak in the chromatogram to a sample 
concentration and produces a printout of the results. 
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A typical IC analysis consists of six stages (see Figure 1-1).

1. Eluent Delivery 

• Eluent, a liquid that helps to separate the sample ions, carries the 
sample through the ion chromatography system. The ICS-1500 is an 
isocratic delivery system. This means that the eluent composition and 
concentration remain constant throughout the run.

2. Chromatography Management System Sample Injection 

• The liquid sample is loaded into a sample loop either manually or 
automatically (if an automated sampler is installed). When triggered, 
the ICS-1500 injects the sample into the eluent stream. 

• The pump pushes the eluent and sample through the guard and 
separator columns (chemically-inert tubes packed with a polymeric 
resin). The guard column removes contaminants that might poison the 
separator column.

Figure 1-1.  Ion Analysis Process
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3. Separation

• As the eluent and sample are pumped through the separator column, 
the sample ions are separated. In the ICS-1500, the mode of 
separation is called ion exchange. This is based on the premise that 
different sample ions migrate through the IC column at different rates, 
depending upon their interactions with the ion exchange sites.

4. Suppression

• After the eluent and sample ions leave the column, they flow through 
a suppressor that selectively enhances detection of the sample ions 
while suppressing the conductivity of the eluent.

5. Detection

• A conductivity cell measures the electrical conductance of the sample 
ions as they emerge from the suppressor and produces a signal based 
on a chemical or physical property of the analyte.

6. Data Analysis

• The conductivity cell transmits the signal to a data collection system.

• The data collection system (for the ICS-1500, this is Chromeleon) 
identifies the ions based on retention time, and quantifies each analyte 
by integrating the peak area or peak height. The data is quantitated by 
comparing the sample peaks in a chromatogram to those produced 
from a standard solution. The results are displayed as a chromatogram 
and the concentrations of ionic analytes can be automatically 
determined and tabulated.
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1.2 Overview of the ICS-1500

The ICS-1500 is an integrated ion chromatography system containing a pump, 
injection valve, column heater, and conductivity detector. Other system 
components, including a guard column, separator column, and suppressor vary, 
depending on the analyses to be performed.

The ICS-1500 can optionally be configured with a vacuum degas assembly, for 
online eluent degassing.

ICS-1500 operation can be controlled in one of two ways:

• Remotely, with a personal computer running Microsoft® Windows® XP or 
Windows 2000 and Chromeleon software (version 6.5 SP2 or later). 
Chromeleon also provides data acquisition and data processing functions.

• Locally, with the front panel LCD touch screen. The touch screen is used for 
instrument control only. It does not provide data acquisition or data 
processing functions. An analog output on the rear panel can be connected to 
a separate data acquisition device.

For communication between the ICS-1500 and Chromeleon, the ICS-1500 is 
connected to a USB (Universal Serial Bus) port on the computer or a USB hub. 
For installation instructions, see Section B.5 and also refer to Installing the 
Chromeleon Chromatography Management System with a Dionex Ion 
Chromatograph (IC) (Document No. 031883).
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1.3 About This Manual

The electronic version (i.e., PDF file) of the ICS-1500 operator’s manual contains 
numerous hypertext links that can take you to other locations within the file. 
These links include:

• Table of contents entries

• Index entries

• Cross-references (underlined in blue) to sections, figures, tables, etc.

If you are not familiar with how to navigate PDF files, refer to the Help system for 
Adobe® Acrobat® or Adobe Reader® for assistance

Chapter 1
Introduction

Introduces ion analysis and the ICS-1500; explains the 
conventions used in this manual, including safety-related 
information.

Chapter 2
Features 
Overview

Provides an overview of ICS-1500 operating features and 
system components; introduces the Chromeleon user 
interface. 

Chapter 3
Operation and 
Maintenance

Provides operating instructions and describes routine 
preventive maintenance procedures.

Chapter 4
Troubleshooting

Lists problems and presents step-by-step procedures for 
how to isolate and eliminate the cause of each problem.

Chapter 5
Service

Provides step-by-step instructions for routine service and 
parts replacement procedures that the user can perform.

Appendix A
Specifications

Lists the ICS-1500 specifications and installation site 
requirements.

Appendix B
Installation

Describes how to install the ICS-1500.

Chapter C
Touch Screen 
Operation

Describes the operating features available from the front 
panel touch screen.
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1.3.1 Safety Messages and Notes
The ICS-1500 is designed for IC (ion chromatography) applications and 
should not be used for any other purpose. If there is a question regarding 
appropriate usage, contact Dionex at 1-800-346-6390 before proceeding. 
Outside the United States, call the nearest Dionex office. 

This manual contains warnings and precautionary statements that, when 
properly followed, can prevent personal injury and/or damage to the 
instrument. Safety messages appear in bold type and are accompanied by 
icons, as shown below.

Appendix D
TTL and Relay 
Control

Describes the ICS-1500 TTL and relay control features.

Appendix E
Reordering 
Information

Lists spare parts for the ICS-1500.

Appendix F
FAQ

Provides answers to frequently asked questions about ICS-
1500 operation.

Appendix G
Glossary

Defines terms commonly used in ion analysis.

Indicates an imminently hazardous situation which, if not avoided, will
result in death or serious injury.

Indicates a potentially hazardous situation which, if not avoided,
could result in death or serious injury.

Indicates a potentially hazardous situation which, if not avoided, may
result in minor or moderate injury. Also used to identify a situation or
practice that may seriously damage the instrument, but will not cause
injury.

Indicates that the function or process of the instrument may be
impaired. Operation does not constitute a hazard.
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Messages d'avertissement en français

Warnhinweise in Deutsch

Notes

Informational messages also appear throughout this manual. These are 
labeled NOTE and are in bold type:

NOTE NOTES call attention to certain information. They alert
you to an unexpected result of an action, suggest how to
optimize instrument performance, etc.

Signale une situation de danger immédiat qui, si elle n'est pas évitée,
entraînera des blessures graves à mortelles.

Signale une situation de danger potentiel qui, si elle n'est pas évitée,
pourrait entraîner des blessures graves à mortelles.

Signale une situation de danger potentiel qui, si elle n'est pas évitée,
pourrait entraîner des blessures mineures à modérées. Également
utilisé pour signaler une situation ou une pratique qui pourrait
gravement endommager l'instrument mais qui n'entraînera pas de
blessures.

Bedeutet unmittelbare Gefahr. Mißachtung kann zum Tod oder
schwerwiegenden Verletzungen führen.

Bedeutet eine mögliche Gefährdung. Mißachtung kann zum Tod oder
schwerwiegenden Verletzungen führen.

Bedeutet eine mögliche Gefährdung. Mißachtung kann zu kleineren
oder mittelschweren Verletzungen führen. Wird auch verwendet, wenn
eine Situation zu schweren Schäden am Gerät führen kann, jedoch
keine Verletzungsgefahr besteht.
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1.3.2 Safety Labels
The TUV GS and c TUVus Mark safety labels and the CE Mark label on 
the ICS-1500 indicate that the ICS-1500 is in compliance with the 
following standards: EN 61010-1:2001 (safety), CAN/CSA-C22.2 No. 
1010.1-92 +A2:97 (safety), UL 3101-1/10.93 (safety), and 
EN 61326:1997, including A1:1998 and A2:2001 (EMC susceptibility 
and immunity).

The symbols below appear on the ICS-1500 or on labels affixed to the 
ICS-1500.

Alternating current

Protective conductor terminal (earth ground)

Power supply is on

Power supply is off
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2 • Features

This chapter describes key ICS-1500 features and introduces the Chromeleon user 
interface.

2.1 Operating Features

2.1.1 Front Panel 
Figure 2-1 illustrates the front panel of the ICS-1500.

Injection Port
The sample to be analyzed can 
be injected manually into the 
injection port, using a syringe. 
For automated sample 
injection, the ICS-1500 must be 
connected to an autosampler. 
For more information about 
sample injection, see 
Section 3.10.
Touch Screen
The LCD touch screen provides 
local control of most ICS-1500 
functions. You can control 
many of these functions 
directly on the touch screen’s 
HOME page (see Figure 2-2). 
From the HOME page you can 
also go to a series of pages that 
provide access to all other 
locally controlled ICS-1500 
operating functions.

Figure 2-1.  ICS-1500 Front Panel
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Summary of Touch Screen Operation

NOTE To adjust the screen contrast, open the front door and
adjust the knurled knob under the screen (see
Figure 2-8).

• Edit fields and command buttons have blue text on a shaded 
background. Fields that display status information are not shaded. 

• Edit fields have square corners, while command buttons are rounded.

• To select a command button or edit a field, touch and release the 
command button or edit field with your fingertip.

NOTE When you touch a button or edit field, the action is
taken when you lift your finger. If you unintentionally
touch a button or field, you can cancel the action by
sliding your finger away from the button or field before
lifting.

• Touching a command button (for example, ) executes the 
command immediately. 

Figure 2-2.  ICS-1500 Touch Screen Home  Page
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• Selecting a command button changes the button’s appearance to 
white text on a dark backgound (for example, ).

• Touching an edit field (for example, ) opens a page 
with a number keypad (see Figure 2-3). Use the keypad to enter the 
desired numerical value for the field and then touch the ENTER 
button.

Figure 2-3.  Number Keypad

Touch a
number to

enter the
value. Touch ENTER to 

confirm the 
entry and return 
to the previous 
page.

Touch CANCEL 
to cancel the 
entry and return 
to the previous 
page.
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• Touching the page name (for example, ) in the 
bottom right corner opens a menu of pages (see Figure 2-4).

• Touching a page name on the menu of pages displays the selected 
page. For example, touching SUPPRESSOR displays the 
SUPPRESSOR page (see Figure 2-5). See Appendix C for details 
about each touch screen page.

Figure 2-4.  ICS-1500 Touch Screen Menu of Pages

Figure 2-5.  Suppressor Page
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• Touching  returns you to the HOME page.

• Touching  opens a list of options (see Figure 2-6). 

2.1.2 Top Cover
Figure 2-7 illustrates the top cover of the ICS-1500.

Reservoir Storage

The ICS-1500 top cover has room 
for up to three 2-L plastic 
reservoirs (P/N 044129).

Tubing Chase

The tubing chase under the top 
cover routes tubing to the front of 
the ICS-1500.

Figure 2-7.  ICS-1500 (Top View)

Figure 2-6.  Suppressor Page: Selecting an Option
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2.1.3 Component Panel
Figure 2-8 shows the user-accessible components installed on the 
component panel behind the ICS-1500 front door.

Figure 2-8.  ICS-1500 Component Panel
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Eluent Valve

The eluent valve controls the flow from the eluent reservoir. The eluent 
valve opens automatically when the pump is started and closes when the 
pump is turned off. 

Leak Sensor

The leak sensor is installed in the drip tray at the bottom of the component 
panel. If liquid accumulates in the tray, an error message is logged in the 
Chromeleon Audit Trail and displayed on the LCD touch screen.

Pump Heads

The ICS-1500 includes a dual-piston serial pump. The flow rate can be set 
to 0.00 mL/min or to between 0.05 and 5.00 mL/min. However, for 
optimum performance, set the flow rate to between 0.40 and 
2.00 mL/min. Setting the flow rate to 0.00 mL/min turns off the pump. 
See Section 2.4.3 for details about the pump.

Pressure Transducer

The pressure transducer measures the system backpressure.

Injection Valve

The injection valve is a six-port, electrically-activated valve. A 25-µL 
sample loop (P/N 042857) is installed on the valve at the factory. See 
Section 2.4.4 for details about valve operation.

Separator and Guard Columns

Both the separator and guard columns are packed with resin and perform 
the separation of the sample ions. The main function of the guard column 
is to trap contaminants and remove particulates that might damage the 
separator column.

Column Heater

The column heater controls the temperature of the separator and guard 
columns. The temperature can be set to between 30 and 60 °C, however it 
must be set at least 5 °C above the ambient temperature. See Section 2.4.5 
for details about the column heater.
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Suppressor

The suppressor reduces the eluent conductivity and enhances the 
conductivity of the sample ions, thereby increasing detection sensitivity. 
Either an AES® Atlas Electrolytic Suppressor, SRS® Self-Regenerating 
Suppressor, or MMS™ MicroMembrane™ Suppressor can be used with 
the ICS-1500. See Section 2.4.6 for details about the suppressor.

DS6 Heated Conductivity Cell

The flow-through conductivity cell measures the electrical conductance 
of analyte ions as they pass through the cell. A heat exchanger inside the 
cell regulates the temperature, which can be set to between 30 and 55 °C. 
For optimum performance, set the temperature to at least 7 °C above the 
ambient temperature. See Section 2.4.7 for details about the cell.

Screen Adjustment Knob

Use this knob to change the LCD touch screen contrast.

Tubing Chases

The upper tubing chase routes tubing from the top cover to the component 
panel. The lower tubing chase routes tubing from the component panel, 
through the ICS-1500 interior, to the rear panel.
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2.1.4 Rear Panel
Figure 2-9 illustrates the ICS-1500 rear panel.

 

Analog Output Connector

The analog output connector outputs conductivity data (scaled to 1 volt) 
to an integrator or recording device. See Section B.19 for connection and 
setup information.

USB Connectors

A USB receptacle is provided to allow connection to the Chromeleon 
computer. Two USB ports are provided for connecting to other USB 
devices. See Section B.5 for connection instructions.

Figure 2-9.  ICS-1500 Rear Panel
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TTL and Relay Connector

The TTL and Relay connector strip provides two TTL outputs, two relay 
outputs, and four TTL inputs. The outputs can be used to control 
functions in other TTL- or relay-controllable devices. The inputs can be 
used to switch the injection valve position, turn on the pump, perform an 
autozero command, and send an event mark to the analog output. See 
Section D.1 for connection instructions.

Tubing Clips

The tubing clips hold tubing routed from the top cover in place.

Power Switch

The power switch provides on/off control of power to the ICS-1500.

Main Power Receptacle

The power supply cord plugs into the AC power receptacle.

The power supply cord is used as the main disconnect device. Make
sure the socket-outlet is located near the ICS-1500 and is easily
accessible. 

Le cordon d'alimentation principal est utilisé comme dispositif
principal de débranchement. Veillez à ce que la prise de base soit
située/installée près du module et facilement accessible.

Das Netzkabel ist das wichtigste Mittel zur Stromunterbrechung.
Stellen Sie sicher, daß sich die Steckdose nahe am Gerät befindet und
leicht zugänglich ist.
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2.2 Flow Schematic

Figure 2-10 illustrates the liquid flow path through an ICS-1500 when using 
suppression in autorecycle mode.

Figure 2-10.  ICS-1500 Flow Schematic
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pump . The eluent is then pushed through the pressure transducer , which 
measures the system pressure.

• From there, the eluent is pushed through a pulse damper , which smooths 
minor pressure variations from the pump to minimize baseline noise. The 
eluent then flows into the injection valve.

• After sample is loaded into the sample loop  and the injection valve is 
toggled to the Inject position, eluent passes through the sample loop. 

• The eluent/sample mixture is pumped through the heat exchanger , which 
heats the mixture to the column heater temperature.

• The mixture then goes to the guard  and separator columns and through the 
suppressor.

• From the suppressor, the mixture flows through the cell , where the analytes 
are detected. A digital signal is sent to Chromeleon software. Analog output 
can be collected simultaneously. 

• Finally, the mixture flows out of the cell and is recycled back into the 
suppressor, where it is used as the water source for the regenerant chamber. 
Flow is then routed to waste.

11

12
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2.3 The Chromeleon Interface

NOTE This section provides a brief overview of the
Chromeleon interface. For details, refer to the
Chromeleon Help or user’s manual. 

Chromeleon software is used for remote control of ICS-1500 operation. Two 
modes of software control are available: direct control and automated control.

• With direct control, you select operating parameters and commands from the 
Chromeleon menu bar, toolbars, and Control panels. Direct control commands 
are executed as soon as they are entered. Section 2.3.2 describes the 
commands available from the ICS-1500 Control panels.

• With automated control, you create a list of samples (a sequence) to be 
processed automatically. The sequence includes programs with commands 
and parameters for controlling the ICS-1500, acquiring sample data, and 
producing reports. Section 3.11.2 describes automatic sample processing.
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2.3.1 The Chromeleon Main Window and Browser
When you start Chromeleon, the main window and the Chromeleon 
Browser appear (see Figure 2-11). 

Figure 2-11.  Chromeleon Main Window and Browser 

NOTE The Chromeleon Browser looks and functions like
Windows Explorer, but do not confuse the two. If you
copy files from the Chromeleon Browser into Explorer,
the files will be corrupted.

The Browser displays the directories in which chromatographic data is 
located, and allows you to open, move, and delete data.

• The left pane of the Browser shows the directory tree structure. By 
clicking the ‘+’ signs next to the folders and expanding the directory 
tree, you can access sequences, System Control panels, Wellness 
Panels, and reports.

• The right pane displays information about the item selected in the left 
pane.
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2.3.2 The ICS-1500 Control Panels
Chromeleon provides two types of Control panels for the ICS-1500. 

• System Control panels are used for controlling and monitoring ICS-
1500 operation. System Control panels are described below.

• The Wellness Panel is used for performing calibration and diagnostic 
functions. The Wellness Panel is described in Section 5.1.

System Control Panels

System Control panels for the ICS-1500 are located in the Dionex 
Templates/Panels/Dionex_IC\ICS-1500 folder. Chromeleon provides 
panels for each ICS-1500 system configuration. There are two styles of 
panels:

• Traditional system panels (see Figure 2-12) provide controls on a 
single window with minimal graphics. 

• System panels (see Figure 2-13) provide a more graphical interface 
than the traditional style. On these panels, clicking a control often 
brings up another window in which you enter a value. 

When you open a System Control panel, select a panel that matches your 
system configuration and choose the style that you prefer. 
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Figure 2-12.  ICS-1500 System Control Panel (Traditional)

 

Figure 2-13.  ICS-1500 System Control Panel (Graphical)
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System Controls Overview

This section provides brief descriptions of the various controls available 
on the ICS-1500 System Control panels. 

NOTE The examples are from the traditional style of panel.

Sample

System

Datasource
Displays the database in which the chromatographic data for the sample 
is saved.

Sequence
Displays the sequence in which this sample is included.

Sample
Displays the name of the sample that is running.

Program
Displays the name of the program that is running.

Elapsed Time
Displays the time that has elapsed since the sample analysis began.

Run Time
Displays the total run time.

Startup
Starts the pump and suppressor. The flow rate and suppressor current 
settings that were in effect at system shutdown (see below) are restored.

Shutdown
Stops the pump and suppressor. The flow rate and suppressor current 
settings currently in effect are remembered and will be restored at 
system startup (see above).
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Audit Trail

The Audit Trail displays an account of every event that occurs during 
ICS-1500 operation. This includes errors, status messages, operational 
events, etc.

Pump

Eluent Bottle
The entry field and gauge indicate the level 
of liquid (in liters) in the eluent bottle. This 
is a user-controlled feature. The level must 
be entered by the user when the reservoir is 
filled. See Section 3.4.4 for details.

Connected
Connects the ICS-1500 to the Chromeleon 
Control panel, enabling communication 
between the PC and the module. Clearing 
the check box disconnects the ICS-1500 

from the PC.

Hold Mode
Indicates when an automatic (batch) run is on hold; pump flow is not 
stopped.

Stop Mode
Indicates when an automatic (batch) run is stopped; pump flow is stopped 
also.

Flow Rate
Sets the pump flow rate in mL/min.

Pressure
The sliders select the upper and lower pressure limits. The Pressure field 
displays the current pressure.
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Column Heater 

Detector

On, Off, Prime
Turn the pump on and off or start the pump priming function.

Inject Valve
Displays the current position of the inject 
valve. The Inject and Load buttons select 
the position.

Eluent Flow Valve
Displays the current position of the eluent 
flow valve. The Closed and Open buttons 
select the position.

Set Temp
Sets the temperature of the column heater.

Connected
Connects the ICS-1500 to the Chromeleon Control panel, enabling 
communication between the PC and the module. Clearing the Connected 
check box disconnects the ICS-1500 from the PC.
Autozero 
Sets the conductivity to zero.
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Ready
Indicates whether the detector is ready to begin data acquisition.
Signal
Displays the offset conductivity.
Data Rate
Sets the rate at which data points are recorded.
Supp. Type
Selects the type of suppressor installed.
SRS Current
Sets the current supplied to the suppressor.
Cell Temp
Sets the temperature of the cell.
SRS Mode
Turns the suppressor on or off.
Show Plot
Displays the ICS-1500 detector signal plot in a separate window.
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2.4 System Component Details

This section provides details about ICS-1500 system components, including the 
vacuum degas assembly (optional), pump, injection valve, column heater, 
suppressor, and conductivity cell.

2.4.1 Vacuum Degas Assembly (Optional) 
The vacuum degas assembly provides online eluent degassing at the time 
and duration specified by the user. The assembly, which must be installed 
in the ICS-1500 at the factory, consists of:

• A single-channel degas chamber (with degas membranes) with 
internal capacity of 17 mL

• A dual-stage diaphragm vacuum pump

• A solenoid valve

• An on-board vacuum sensor

• The electronics required to operate the vacuum pump

• Tubing, fittings, and other accessories

By default, the ICS-1500 monitors the degas pressure reading and turns 
the degas pump on and off as needed. A different degas operating mode 
can be selected from the touch screen PUMP page (see Section C.7) or 
from Chromeleon. To select degas operating options from Chromeleon, 
open the Server Configuration program, select the ICS-1500 device icon 
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under the timebase, and select Edit>Properties. Select the Options tab 
(see Figure 2-14).

Figure 2-14.  Server Configuration Properties: Degas Mode Options 

Degas Mode Options

• Always Off: The degas pump is always off.

• Always On: The degas pump is always on. This setting is for test 
purposes by a Dionex Service Representative. Do not use this setting 
for routine operation.

• Cycle: The degas pump cycles on and off according to the times 
specified in the Cycle On and Off fields. Cycle On specifies for how 
long the degas pump runs during a cycle. Cycle Off specifies the time 
between cycles.

• Monitor: (default mode) The ICS-1500 monitors the degas pressure 
reading and turns the degas pump on and off as required.
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2.4.2 Eluent Valve

2.4.3 Pump
The ICS-1500 pump is a microprocessor-based isocratic eluent delivery 
system. Its variable speed, dual-piston series design ensures pulse-free 
pumping for the most demanding applications. 

Primary Pump Head

The primary pump head pumps eluent into the secondary head (see 
Figure 2-16). The check valves, which prevent reverse flow through the 
pump, are located on the bottom (inlet) and top (outlet) of the primary 
pump head. The priming valve is on the front of the pump head.

The eluent valve controls the flow 
from the eluent reservoir. The 
valve opens automatically when 
the pump is started and closes 
when the pump is turned off. The 
valve can also be opened and 
closed manually either from the 
Chromeleon Control panel (see 
Section 2.3.2), or the touch screen 
PUMP page (see Section C.7). This 
lets you perform service 
procedures on pump components 
without eluent leaks occurring.

Figure 2-15.  Eluent Valve
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To open the priming valve, turn the knob one-quarter to one-half turn 
counterclockwise. When the priming valve is open, liquid can flow into 
and out of the primary pump head via the port in the front of the valve. 

NOTE The priming valve must be open when the pump is
being primed with a syringe or with isopropyl
alcohol. For detailed priming instructions, see
Section B.14.

Secondary Pump Head

The secondary pump head delivers eluent to the remainder of the 
chromatography system (the injection valve, column, and detector). The 
waste valve is located on the front of the secondary pump head (see 
Figure 2-16). 

To open the waste valve, turn the knob one-quarter to one-half turn 
counterclockwise. When the waste valve is in the open position, all output 
is directed to waste.

NOTE The waste valve must be open when the pump is
being primed using the Prime button. For detailed
priming instructions, see Section B.14.

Figure 2-16.  ICS-1500 Pump Components
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Pressure Transducer

Flow exiting the secondary pump head is directed to the pressure 
transducer (see Figure 2-16), which measures the system pressure.

Pressure readings indicate that the pumping system is delivering smooth, 
accurate flow. Pressure readings can be monitored from the Chromeleon 
Control panel or the touch screen HOME page.

The system pressure should remain consistent (no more than a 3% 
difference from one pressure reading to the next). High and low pressure 
limits can be used to stop the pump flow if a limit is exceeded. The 
pressure limits can be set from Chromeleon (in the Server Configuration 
or in the control program) or from the touch screen PUMP page (see 
Section C.7).  See Section 4.1 for troubleshooting information if a 
pressure limit is exceeded.

Pulse Damper

Flow output from the pressure transducer continues to the pulse damper, 
which smooths minor pressure variations. From there, flow is directed to 
the injection valve and then to the remainder of the chromatography 
system.

Piston Seal Wash

The pump includes a piston seal wash assembly that can be set up to 
continuously rinse the back of the piston seals to remove salt crystals and 
prolong the life of the seals. To use this feature, an external water source 
must be connected. See Section B.21 for connection instructions.

For continued protection of the pump, replace the piston rinse seals (see 
Section 5.6) and O-rings in the seal wash assembly every 6 months, or 
whenever you replace the main piston seals for the ICS-1500 pump.
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2.4.4 Injection Valve
The injection valve (P/N 057968) is a six-port, electrically-activated 
valve. A 25-µL sample loop (P/N 042857) is installed on the valve at the 
factory.

The valve has two operating positions: Load and Inject (see Figure 2-17). 

Eluent flows through either the Load or Inject path, depending on the 
valve position.

• In the Load position, sample is loaded into the sample loop, where it 
is held until injection. Eluent flows from the pump, through the valve, 
and to the column, bypassing the sample loop. Sample flows from the 
syringe or automated sampler line (if installed), through the valve, 
and into the sample loop. Excess sample flows out to waste.

• In the Inject position, sample is swept to the column for analysis. 
Eluent flows from the pump, through the sample loop, and on to the 
column, carrying the contents of the sample loop with it. Section 3.10 
describes how to inject samples.

Figure 2-18 shows the injection valve connections. The injection valve is 
plumbed at the factory with all tubing and fittings for connection to the 
pump, injection port, column, and waste. A 25-µL PEEK sample loop 
(P/N 042857) is installed between ports L (1) and L (4). Dionex offers 

Figure 2-17.  Injection Valve Flow Schematics
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sample loops in various sizes. If necessary, the pre-installed 25-µL loop 
can be replaced with a loop that has a different sample injection volume. 

Figure 2-18.  Injection Valve Plumbing
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2.4.5 Column Heater

2.4.6 Suppressor
The suppressor reduces the eluent conductivity and enhances the 
conductivity of the sample ions, thereby increasing detection sensitivity. 
Either an Atlas Electrolytic Suppressor, Self-Regenerating Suppressor, or 
MicroMembrane Suppressor can be used with the ICS-1500.

For details about any of the suppressors or for information about selecting 
a suppressor for your application, refer to the suppressor manuals. The 
manuals are on the Dionex Reference Library CD-ROM (P/N 053891).

The column heater provides temperature 
control for the separator and guard column.
 
The heater temperature can be set to between 
30 and 60 °C. However, the set temperature 
must be at least 5 °C above the ambient 
temperature. A thermistor mounted in the 
heater block monitors the temperature. 
Setting the temperature to 0 °C turns off the 
column heater.

If the temperature exceeds 65 °C, the 
column heater is shut off and the error 
message “Column heater exceeds safe 
temperature.” is displayed on the touch 
screen and in the Chromeleon Audit Trail. 
See Section 4.1 for troubleshooting 
information.

Figure 2-19.  Column Heater
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2.4.7 DS6 Heated Conductivity Cell
The ICS-1500 flow-through conductivity cell measures the electrical 
conductance of analyte ions as they pass through the cell. Two passivated 
316 stainless steel electrodes are permanently sealed into the PEEK cell 
body. The cell design provides efficient sweep-out, low volume (1 µL), 
and low dispersion. Temperature control and compensation help ensure 
good peak reproducibility and baseline stability.

Temperature Control

Temperature directly affects the conductivity of a solution. For example, 
laboratory heating and air conditioning systems can cause a regular slow 
cycling in the baseline. This, in turn, can affect the reproducibility of an 
analysis. The higher the conductivity, the more pronounced the effect.

In ion analysis, the effect of temperature variation is minimized by 
suppressing eluent conductivity. To further reduce the effect of 
temperature variation, a heater inside the cell regulates the ttemperature. 
The cell heater can be set to between 30 °C and 55 °C. The set 
temperature must be at least 7 °C above the ambient temperature. Setting 
the cell temperature to 0 °C turns off the cell heater.

Temperature Compensation

Built-in preset temperature compensation of 1.7% per °C helps minimize 
changes in the baseline or in peak heights when the operating temperature 
is different from the temperature at which the cell was calibrated.

DS6 Heated Conductivity Cell Components

The cell front cover provides CELL IN and CELL OUT fittings for 
connecting the cell to the suppressor (see Figure 2-8). The remaining cell 
components are mounted behind the component panel. To replace, the cell 
remove the screws on the cell front cover and pull the entire cell assembly 
out through the component panel. See Section 5.9 for cell replacement 
instructions.
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3 • Operation and Maintenance

This chapter describes routine operating and maintenance procedures for the ICS-
1500 Ion Chromatography System.

The ICS-1500 is designed for IC (ion chromatography) applications and should 
not be used for any other purpose. Operation of the ICS-1500 in a manner not 
specified by Dionex may result in personal injury.

3.1 Operation Overview

Figure 3-1 illustrates the basic steps for routine operation of the ICS-1500.

Figure 3-1.  ICS-1500 Operation Flow Chart
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Sample Processing Overview
Samples can be run manually (one at a time), or they can be grouped and run 
automatically in batches. Figure 3-2 shows the typical steps for manual and batch 
sample processing.

Figure 3-2.  Sample Processing Overview
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3.2 Power Up the System 

* When you start the suppressor, the value used last is restored.

Press the power switch on the ICS-
1500 rear panel (see Figure 3-3) to 
turn on the system power. Table 3-1 
shows the ICS-1500 conditions at 
power up.

Also turn on the power to the 
computer and the autosampler (if 
used).

Figure 3-3.  ICS-1500 Rear Panel

Feature Power-Up Condition

Pump Off
Injection valve Load position
Cell Reading current value
Suppressor Off*
Cell heater Set to the last value used. The default when the 

ICS-1500 is turned on for the first time is 35 °C.
Column oven temperature Set to the last value used. The default when the 

ICS-1500 is turned on for the first time is 30 °C.

Table 3-1. ICS-1500 Power-Up Conditions

Power
Switch
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3.3 Start Chromeleon

NOTE If you are beginning operation of an ICS-1500 that has
not been configured in a timebase, see Section B.8 for
Chromeleon setup instructions.

1. If the Chromeleon Server is not running (the icon on the taskbar is crossed out 

in red ), start the Server by right-clicking the icon and selecting Start 

Server. When the server starts, the icon changes to gray . 

2. Start Chromeleon by selecting Start>Programs>Chromeleon> 
Chromeleon. The Chromeleon main window and the Browser will open. 
Your screen display should resemble Figure 3-4. If the Browser does not 
open, select File>Browser to open it.

Figure 3-4.  Chromeleon Main Window and Browser
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3. In the Browser, expand the Dionex Templates\Panels\Dionex_IC\ICS-1500 
System Panels folder. Several ICS-1500 Control panels (.PAN files), 
corresponding to various system configurations, are provided. Two styles of 
panels are available:

• Traditional panels provide controls on a single window with minimal 
graphics. 

• System panels provide a more graphical interface than the traditional style 
and include more controls.

You can choose either style of panel, depending on your personal preference.

4. Open a panel for your system configuration by double-clicking its name in the 
list. For example, if your system includes an ICS-1500 and an AS50 
autosampler, double-click either ICS-1500_Traditional_System_AS50.pan 
or ICS-1500_System_AS50.pan.

5. The Control panel opens, unconnected (see Figure 3-5). To connect to the 
timebase, open the Control menu and click the name of the ICS-1500 
timebase in the list at the bottom of the menu. 

Figure 3-5.  ICS-1500 System Control Panel (Unconnected)
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Figure 3-6 shows a connected Control panel for an ICS-1500 system.

Figure 3-6.  ICS-1500 System Control Panel (Connected)

3.4 Set Up the Eluent Reservoir

3.4.1 Prepare the Eluent
Prepare the eluent according to the instructions in the column manual. 
Column manuals are included on the Dionex Reference Library CD-ROM 
(P/N 053891).

3.4.2 Degas the Eluent
Eluent quality significantly affects the performance of the ICS-1500. To 
ensure optimal pump performance, observe the following precautions:

• Dionex strongly recommends vacuum degassing all eluents. This 
helps prevent bubbles, caused by outgassing, from forming in the 
pump heads and the detector flow cell.

• The optional vacuum degas assembly provides programmable, online 
degassing. The degas assembly must be installed in the ICS-1500 at 



3 • Operation and Maintenance

Doc. 031917-02 9/05 3-7

the factory. If the ICS-1500 does not contain a degas assembly, 
manually degas eluents daily (following the instructions below) and 
store it in pressurized reservoirs.

Manual Degassing of Eluent

1. Prepare the eluent required for the application and pour it into a 
vacuum flask

1. Pour the deionized water into a vacuum flask

2. Attach the flask to a vacuum pump or water aspirator.

3. Vacuum degas the eluent deionized water for 5 to 10 minutes by 
shaking or sonication.

4. Remove the flask from the vacuum. Do not allow water to flow 
from the aspirator back into the flask.

5. Pour the degassed eluent deionized water into a pressurizable 
reservoir. Do not shake the eluent.

6. Install an end-line filter on the eluent deionized water line (see 
Section 3.4.3).

7. Pressurize the reservoir (see Section B.20).

3.4.3 Filter the Eluent
Filtering removes small particulates in the eluent that may contaminate 
the pump check valves and cause erratic flow rates or loss of prime. An 
end-line filter (P/N 045987) is provided in the ICS-1500 Ship Kit 
(P/N 057905) for this purpose. 

Install the end-line filter on the end of the eluent line, inside the reservoir. 
Verify that the end of the filter extends to the bottom of the reservoir and 
that the filter is submerged in eluent. This prevents air from being drawn 
through the lines.

3.4.4 Fill the Reservoir
Fill the reservoir with the prepared eluent.
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3.4.5 Set the Eluent Level
After filling the reservoir, enter the volume of liquid in the reservoir in 
one of the following locations:

• On the HOME page in the Eluent Level field (see Figure 3-7) 

• In the Eluent Bottle field on the Chromeleon Control panel (see 
Figure 3-8)

The ICS-1500 determines the eluent usage by monitoring the flow rate 
and the length of time the pump is on. The ICS-1500 updates the field as 
the eluent is used up. A warning first appears if the level falls below 
200 mL. Warnings are repeated at 100 mL and 0 mL. 

The STATUS page (see Figure 3-9) also displays the amount of liquid 
remaining in the reservoir and an estimate of how many hours remain 

In order for the eluent level displayed on the screen to be accurate,
the level must be entered by the user when the reservoir is filled. The
ICS-1500 does not automatically detect when the reservoir is filled,
nor when it is empty.

Figure 3-7.  Home Page: Setting the Eluent Level

Figure 3-8.  Chromeleon Control Panel: Setting the Eluent Level

Enter the volume of
liquid in the reservoir

Note: The Eluent Level 
field is updated as the 
liquid is used up.

Enter the volume of
liquid in the reservoir

Note: The Eluent Bottle 
field and slider gauge 
are updated as the 
liquid is used up.
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before the eluent reservoir is empty. See Section C.6 for details about the 
STATUS PAGE. 

3.4.6 Connect the Reservoir
If it is not already connected, connect the ELUENT BOTTLE OUT line from 
the reservoir cap to the ELUENT IN line, which extends from the plumbing 
and cable chase on the top of the ICS-1500.

3.5 Check All Connections

1. Make sure the eluent reservoir is filled and the tubing connecting the reservoir 
to the ICS-1500 tubing is securely connected.

2. Make sure the USB cable from the computer is connected to the USB 
receptacle on the ICS-1500 rear panel.

Figure 3-9.  Status Page
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3.6 Prime the Pump

1. Verify that the priming valve on the primary pump head (see Figure 3-10) is 
closed (turned all the way clockwise).

2. Open the waste valve on the secondary pump head by turning the knob one-
quarter to one-half turn counterclockwise. Opening the valve directs the 
eluent flow path to waste and eliminates backpressure.

3. Press Prime on the Chromeleon Control panel or the ICS-1500 touch screen 
HOME page. The pump will begin pumping at approximately 3 mL/min.

4. Continue priming the ICS-1500 until all air and previous eluent are purged 
and no air bubbles are exiting the waste line.

5. Press Pump Off.

6. Close the waste valve. Do not overtighten. The pump is now ready for 
operation.

If you changed eluent or if the eluent lines are dry, prime the lines first
with a syringe before following the procedure below to prime the
pump. See Section B.14 for instructions on priming the lines with a
syringe.

Figure 3-10.  Priming the Pump
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3.7 Set System Operating Conditions

NOTE This section is an overview of the steps needed to start
up the system and begin running samples. Actual
operating parameters (flow rate, cell heater
temperature, suppressor current, etc.) depend on the
application to be run. Refer to the column manual for
the required parameters for your application.

Set or verify system operating parameters from either the Chromeleon Control 
panel or from the touch screen HOME page. Operating parameters can also be set 
automatically by loading a Chromeleon sequence.

NOTE Clicking the System Startup button on the Chromeleon
Control panel starts the pump and suppressor. The flow
rate and suppressor current settings that were in effect
when the system was shut down are restored.

1. Verify that the pump is on and set to the correct flow rate.

2. Verify that the suppressor current is on and that the setting is correct.

3. Verify that the cell heater is set to the correct value.

4. Verify that the column heater is set to the correct value.

Automatically Turning on the Suppressor
You can set up the ICS-1500 to turn on the suppressor automatically when the 
pump is turned on. To do this, select the Automatically turn on with pump 
option from the SUPPRESSOR page. 

The suppressor is always turned off automatically when the pump is turned off.

3.8 Equilibrate the System and Verify Operational Status 

NOTE You can monitor system functions (conductivity,
pressure, cell temperature, etc.) from the Chromeleon
Control panel or from the touch screen HOME page.
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1. Allow the system to equilibrate. During equilibration, the Chromeleon 
Control panel displays the background conductivity (the conductivity of the 
eluent before sample injection) and the system backpressure.

2. Monitor the background conductivity. Refer to the column manual for the 
appropriate background conductivity for your application.

3. Offset the background and zero the reading by clicking the Autozero button 
on the Chromeleon Control panel (see Figure 3-4).

4. Monitor the system pressure from the Control panel to make sure it is at the 
expected pressure for the installed column (refer to the column manual for 
details) and is stable. 

• If the pressure is less than the expected amount, gas may be trapped in the 
system. To release the gas, remove the pump fitting on the injection valve 
port, labeled P (2). Allow the air to escape and then reconnect the fitting. 

• If the pressure fluctuates by more than about 0.13 MPa (20 psi), prime the 
pump. See Section 4.3 for additional troubleshooting information.

• If the pressure is too high, there may be a restriction in the system 
plumbing (see Section 3.6). See Section 4.7 for troubleshooting 
information.

5. Verify that the baseline conductivity is at the expected reading for your 
application and is stable. In general, it should be <30 µS for a system set up 
for anion analyses and <2 µS for a system set up for cation analyses. See 
Section 4.12 for troubleshooting information if the conductivity is too high. 
See Section 4.13 if the baseline is drifting or has excessive “noise” (large 
fluctuations in readings).

6. Verify that the cell heater is at the set point and is stable. The temperature is at 
equilibrium when the Set Temperature and the Current Temperature 
readings on the Control panel are the same, or when the “=” symbol is 
displayed next to the Column Heater temperature on the HOME page.

7. Verify that the column heater temperature is at the set point and stable. The 
temperature is at equilibrium when the Set Temperature and the Current 
Temperature readings on the Control panel are the same, or when the “=” 
symbol is displayed next to the Column Heater temperature on the HOME 
page.

The system is now ready for sample processing.
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3.9 Prepare Samples

NOTE Sample preparation can be performed while the system
is equilibrating.

3.9.1 Collecting and Storing Samples
Collect samples in high density polyethylene containers that have been 
thoroughly cleaned with deionized (DI) water. Do not clean containers 
with strong acids or detergents because these can leave traces of ions on 
the container walls. The ions may interfere with the analysis.

If samples will not be analyzed on the day they are collected, filter them 
through clean 0.45 µm filters immediately after collection; otherwise, 
bacteria in the samples may cause the ionic concentrations to change over 
time. Refrigerating the samples at 4° C (39° F) will reduce, but not 
eliminate, bacterial growth.

Analyze samples containing nitrite or sulfite as soon as possible. Nitrite 
oxidizes to nitrate, and sulfite to sulfate, thus increasing the measured 
concentrations of these ions in the sample. In general, samples that do not 
contain nitrite or sulfite can be refrigerated for at least one week with no 
significant changes in anion concentrations.

3.9.2 Pretreating Samples
Analyze rainwater, drinking water, and air particulate leach solutions 
directly with no sample preparation (other than filtering and possibly 
diluting). 

Filter groundwater and wastewater samples through 0.45 µm filters 
before injection, unless samples were filtered after collection.

Before injection, pretreat samples that may contain high concentrations of 
interfering substances by putting them through Dionex OnGuard® 
cartridges. Refer to the Installation and Troubleshooting Guide for 
OnGuard Cartridges (Document No. 032943) for instructions.

3.9.3 Diluting Samples
Because the concentrations of ionic species in different samples can vary 
widely from sample to sample, no single dilution factor can be 
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recommended for all samples of one type. In some cases (for example, 
many water samples), concentrations are so low that dilution is not 
necessary.

Use eluent or ASTM filtered, Type I (18-megohm) deionized water to 
dilute the sample. When using carbonate eluents, diluting with eluent 
minimizes the effect of the water dip at the beginning of the 
chromatogram. If you dilute the sample with eluent, also use eluent from 
the same lot to prepare the calibration standards. This is most important 
for fluoride and chloride, which elute near the water dip.

To improve the accuracy of early eluting peak determinations, such as 
fluoride, at concentrations below 50 ppb, dilute standards in eluent or 
spike the samples with concentrated eluent to minimize the water dip. For 
example, spike a 100 mL sample with 1.0 mL of a 100 X eluent 
concentrate.

3.10 Loading and Injecting Samples

The two techniques for loading samples into the sample loop are: (1) with an 
autosampler or (2) with a syringe or vacuum syringe through the injection port on 
the ICS-1500 front door. 

For autosampler injections, the injection port tubing is disconnected from the ICS-
1500 injection valve and replaced by the autosampler outlet tubing. Other setup 
requirements depend upon the model of autosampler.

Setup for an AS40 Autosampler
A relay or TTL connection is required for Chromeleon to control sample loading. 
See Section B.18 for AS40 autosampler installation instructions. 

Setup for an AS or AS50 (USB) Autosampler
To use an AS or AS50 (USB) autosampler with the ICS-1500, the following 
requirements must met:

• The ICS-1500 injection valve must be linked to the AS or AS50 (USB) in the 
Chromeleon timebase (see Section B.17.2)

• An injection valve should not be installed in the AS or AS50 (USB)

See Section B.17 for AS or AS50 (USB) autosampler connection instructions. 
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NOTE The ICS-1500 and the AS or AS50 (USB) can be set up
for stand-alone (front-panel) operation. This requires a
TTL cable connection between the AS or AS50 (USB)
and the ICS-1500. See Section D.3 for stand-alone setup
instructions. 

3.10.1 Loading Samples with a Syringe
1. Make sure the injection port on the ICS-1500 front door (see 

Figure 2-1) is connected to the sample port S (5) on the injection valve 
(see Figure 3-11).

2. Fill the 1 cc syringe (P/N 016388) provided in the ICS-1500 Ship Kit 
(P/N 057905) with a calibration standard or sample.

3. Insert the syringe into the injection port on the ICS-1500 front door.

4. Verify that the injection valve is in the Load position. 

5. Overfill the sample loop with several sample loop volumes. Excess 
sample will exit through the injection valve waste line. 

6. Leave the syringe in the port.

7. Switch the injection valve to the Inject position (see Section 3.10.4).

Figure 3-11.  Injection Valve Connections
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3.10.2 Loading Samples with a Vacuum Syringe
1. Disconnect the waste line from port W (6) of the injection valve (see 

Figure 3-11) and attach a shorter line: 25 to 30 cm (10 to 12 inches) of 
PEEK or Teflon® tubing.

2. Place the free end of the line into the sample.

3. Verify that the injection valve is in the Load position.

4. Insert the 1 cc syringe (P/N 016388) provided in the ICS-1500 Ship 
Kit (P/N 057905) into the injection port on the ICS-1500 front door 
(see Figure 2-1) and pull out the plunger to draw the sample into the 
injection valve.

5. Switch the injection valve to the Inject position (see Section 3.10.4).

3.10.3 Loading Samples with an Autosampler
1. Verify that the autosampler output line is connected to port S (5) of the 

ICS-1500 injection valve.

2. Prepare and fill the sample vials and place them in the autosampler 
tray or cassette. Refer to the autosampler manual for detailed 
instructions.

3. The sample loading process depends on the autosampler. Refer to the 
autosampler manual for detailed instructions. In general, use one of 
the following methods:

• Include the commands for controlling sample loading in a 
Chromeleon program. See the examples in Section 3.10.5.

• Enter the commands for loading the sample on the autosampler 
front panel.

4. Switch the injection valve to the Inject position (see Section 3.10.4).
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3.10.4 Injecting Samples
After loading the sample in the sample loop, switch the injection valve to 
the Inject position, using one of the following methods:

• Manually: Click the Inject button on the Chromeleon Control panel 
(see Figure 3-6) or touch the Inject button on the HOME page.

• Automatically: Include the Inject command in a Chromeleon 
program. See the examples in Section 3.10.5.

3.10.5 Example Chromeleon Commands for Loading and 
Injecting Samples
The following examples show commands for loading and injecting 
samples using an AS or AS or AS50 (USB)40 autosampler.

Example AS or AS50 (USB) Program Commands

Example AS40 Program Commands

0.000 Pump_ECD.Autozero ;Zero the baseline.

Load ;Switch the valve to Load.

Wait CycleTimeState ;Wait for cycle time (if any).

Inject ;Switch the valve to Inject.

Wait InjectState ;Wait for injection to complete.

ECD_1.AcqOn ;Start data acquisition.

14.000 ECD_1.AcqOff ;Stop data acquisition.

-2.300 Pump_ECD_Relay_1.Closed Duration=138.00 ;Note 1

 0.000 Pump_ECD.Autozero ;Note 2

ECD_1.AcqOn ;Note 3

Pump_InjectValve.InjectPosition Duration=30.00 ;Note 4

30.00 ECD_1.AcqOff ;Note 5
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AS40 Program Command Notes:

1. Close the ICS-1500 RELAY OUT 1, which is connected to the AS40 
LOAD relay. This signals the AS40 to load the sample.

2. Zero the baseline.

3. Start data acquisition.

4. Switch the valve to Inject.

5. Stop data acquisition.

3.11 Process Samples

Samples can be run either manually (one at a time) or automatically (in groups or 
“batches”).

3.11.1 Manual Sample Processing
To process samples manually, select operating parameters and commands 
from the touch screen pages, or from the Chromeleon menu bar, toolbars, 
and Control panel. Commands are executed as soon as they are entered.

NOTE When you run samples manually from the front panel
(without using Chromeleon), the data is saved only
temporarily in the ICS-1500 memory. For a permanent
record of the data, connect a recording device (chart
recorder, integrator, etc.) to the analog output. See
Section B.19 for analog output connection instructions.

1. Complete the steps in Sections 3.2 through 3.8 to prepare for 
operation and to start up the ICS-1500.

2. Load the sample, using a syringe, vacuum syringe, or autosampler 
(see Section 3.10).

3. In Chromeleon, select Control>Acquisition On. Chromeleon 
records the signal supplied by the detector and displays the signal plot 
on the Control panel.

4. Click the Autozero button on the Control panel or the touch screen 
HOME page.
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5. Inject the sample (see Section 3.10.4).

6. In Chromeleon, monitor the chromatogram on the Control panel and 
select Control>Acquisition Off when sample data is collected.

NOTE Data from Chromeleon manual processing is saved
in the MANUAL sequence folder under the local
datasource. This data is overwritten each time a
new manual sample is processed. To save the data
from a manual run, select the MANUAL folder,
select File>Save As, and enter a new name for the
sequence.

7. If you are controlling the ICS-1500 from the touch screens, select the 
PLOT button on the HOME page to view a plot of the conductivity 
data.

3.11.2 Automatic (Batch) Sample Processing
For batch processing, you use Chromeleon to create a list of samples (a 
sequence) to be processed automatically. For each sample, the sequence 
includes a program with commands and parameters for controlling the 
ICS-1500, controlling the autosampler (if used), and acquiring sample 
data. The sequence also includes a quantification method for peak 
identification and area determination. Additional sample processing 
parameters are included in the sequence (for example, the sample name, 
sample type, injection volume, etc.). 

After defining the sequence, you can start batch processing.

1. Complete the steps in Sections 3.2 through 3.8 to prepare for 
operation and to start up the ICS-1500.

2. Create a new sequence or modify an existing one.

To create a new sequence:

a. In the Browser, select File>New. Select Sequence (using 
Wizard) and click OK. 

b. Complete the steps in the Sequence Wizard, adding the desired 
number of samples and standards to the list. For help with any of 
the steps, click the Help button on the Sequence Wizard page.
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NOTE A simple way to get started is to select the “Use
Application Template” option in Step 4 of the
Sequence Wizard. This option lets you select a
column and suppressor type from a list of
applications. The Wizard then copies a program
and quantification method, appropriate for the
selected application, to the sequence folder and adds
them to the sequence definition.

3. To start the sample processing, make sure the System Control panel is 
open (see Section 3.3) and is the active window. Then, select 
Batch>Edit. The Batch dialog box opens (see Figure 3-12).

Figure 3-12.  Batch Dialog Box



3 • Operation and Maintenance

Doc. 031917-02 9/05 3-21

4. Click the Add button on the Batch List tab and add the sequence you 
created in Step 2. See Figure 3-13 for an example. 

Figure 3-13.  Batch Dialog Box with an Example Sequence Added to the Batch List 

5. To start the batch, click Start.

3.12 Maintenance

This section describes routine maintenance procedures that users may perform. 
All other maintenance procedures must be performed by Dionex personnel.

As Needed
• Regularly check the eluent reservoir and refill when needed.

• Make fresh eluent as needed.

Daily
• Check the ICS-1500 component mounting panel (see Figure 2-8) for leaks or 

spills. Wipe up spills. Isolate and repair leaks (see Section 4.2). Rinse off any 
dried eluent with deionized water.

• Check the waste container daily and empty when needed.
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Weekly
• Once a week, check fluid lines for crimping or discoloration. Relocate any 

pinched lines. Replace damaged lines.

• Check the junctions between the pump heads and the pump casting for 
evidence of liquid leaks. If the piston seal wash tubing is not connected, check 
the drain tubes at the rear of the pump heads for evidence of moisture. Normal 
friction and wear may gradually result in small liquid leaks around the piston 
seal. If unchecked, these leaks can gradually contaminate the piston housing, 
causing the pump to operate poorly. If leaks occur, replace the piston seals 
(see Section 5.6).

• Check the end-line filter (P/N 045987) and change if needed. When new, end-
line filters are pure white. If the system is in continuous operation, change the 
end-line filter weekly, or whenever it becomes discolored. Replace the filter 
more often if bacterial buildup is visible or if the eluent does not contain 
solvent. 

NOTE It is especially important to regularly replace end-line
filters when using aqueous eluents, which may
contaminate the filter with bacteria or algae. The
bacterial buildup may not be visible.

Every Six Months
• Calibrate the cell (see Section 5.1.3).

• Calibrate the vacuum degas assembly (see Section 5.1.5).

• Replace the pump piston rinse seals and piston seals (see Section 5.6).

Yearly
• Rebuild the injection valve (see Section 5.4).

• Replace the AS40 Automated Sampler tip and tubing. The AS40/ASM 
Maintenance Kit (P/N 055647) contains all of the components required to 
replace the sampling tip and the tubing between the tip and the injection 
valve. Instructions are included with the kit.

• Perform the AS or AS50 (USB) preventive maintenance procedure. The AS 
or AS50 (USB) Maintenance Kit (P/N 060581) contains all of the required 
components and instructions for performing the procedure.
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4 • Troubleshooting

This chapter is a guide to troubleshooting minor issues that may arise during 
operation of the ICS-1500. Turn to the section of this chapter that best describes 
the operating problem or symptom that has been observed. Each section lists 
possible causes of the problem or symptom in order of probability. A systematic 
troubleshooting approach is the most effective way to determine the root cause.

If you are unable to resolve a problem by following the instructions here, contact 
Dionex Technical Support. In the U.S., call 1-800-346-6390. Outside the U.S., 
call the nearest Dionex office. Please have this chapter at hand when talking with 
Technical Support personnel.

4.2 Error Messages

The Moduleware (the instrument control firmware installed in each ICS-1500 
module) periodically checks the status of certain parameters. If a problem is 
detected, it is displayed on the touch screen.

Error messages are also reported to Chromeleon and logged in the Audit Trail. 
Each error message is preceded by an icon that identifies the seriousness of the 
underlying problem (see the table below). You can change the severity level 
assigned to a problem whenever appropriate.

Icon Severity Level Description
Warning A message is displayed in the Audit Trail, but the 

current run is not interrupted.

 Error A message is displayed in the Audit Trail, and the 
system attempts to correct the problem (sometimes 
by using an alternative parameter). An Error never 
interrupts the current analysis; however, if it occurs 
during the Ready Check, the analysis will not be 
started.

Abort A message is displayed in the Audit Trail, and the 
running batch is aborted.
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The table below lists the most frequently observed ICS-1500 error messages. For 
troubleshooting assistance, refer to the page indicated in the table.

Alarms and Error Conditions See
Column heater exceeds safe temperature page 3
Column heater open circuit page 3
Column heater short circuit page 3
Degas calibration failed page 3
Hardware not present page 4
Leak sensor wet page 4
Load/inject valve error page 5
Option not installed page 5
Pressure slope calibration error page 5
Pump motor lost control page 6
Pump pressure hardware error page 6
Pump over pressure page 6
Pump under pressure page 7
Suppressor over current page 7
Suppressor over voltage page 8
Suppressor over power page 8
Suppressor not connected page 8
Suppressor stopped for flow rate page 9

Table 4-3. ICS-1500 Alarms and Error Messages Summary
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4.1 Troubleshooting Error Messages

This error occurs when the column heater temperature is higher than the 
maximum allowed. This error may occur if the ICS-1500 is operating in an 
extreme environment (greater than 40 °C (104 °F)). 

To troubleshoot:

Refer to Section A.3 for environmental specifications.

This error occurs when the column heater is unplugged from the component 
panel. 

To troubleshoot:

1. Check that the column heater is plugged into the component panel.

2. If the error persists, the column heater may be faulty. Replace the column 
heater (see Section 5.11).

This error occurs when there is a short circuit on the thermistor input used to 
measure the column heater temperature. This error indicates a faulty column 
heater.

To troubleshoot:

Replace the column heater (see Section 5.11).

This error occurs when the degas vacuum does not reach the expected level 
during calibration.

COLUMN HEATER EXCEEDS SAFE TEMPERATURE

COLUMN HEATER OPEN CIRCUIT

COLUMN HEATER SHORT CIRCUIT

DEGAS CALIBRATION FAILED
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To troubleshoot:

1. Retry the calibration.

2. If calibration still fails, the vacuum degas assembly may need to be 
replaced. Contact Dionex for assistance. 

This error indicates a problem in the ICS-1500 electronics.

To troubleshoot:

• Contact Dionex for assistance. The ICS-1500 electronics components 
cannot be serviced by the user.

The leak sensor is installed in the drip tray at the bottom of the component 
panel (see Figure 2-8). If liquid accumulates in the tray, the sensor signals the 
problem and the “Leak sensor wet” error message appears.

To troubleshoot:

1. Locate the source of the leak by visually inspecting the tubing, fittings, 
and components on the component panel.

2. Tighten fittings or replace tubing and fittings as required. Refer to 
Section 4.2 for detailed troubleshooting of various types of leaks.

3. After fixing the leak, dry the drip tray thoroughly to prevent the leak 
sensor from triggering additional error messages. 

HARDWARE NOT PRESENT

LEAK SENSOR WET
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If the injection valve fails to switch position within 1 second of being toggled, 
the ICS-1500 Moduleware reports an error to Chromeleon and the 
“Load/Inject valve error” message appears.

To troubleshoot:

1. If a sequence is being executed, terminate the sequence by selecting 
Batch>Stop on the Chromeleon menu.

2. Turn off the ICS-1500 power briefly and then restart.

3. Try to toggle the valve from Load to Inject by clicking the Load and 
Inject buttons on the ICS-1500 Control panel in Chromeleon or on the 
touch screen HOME page. 

4. If the problem persists, contact Dionex for assistance.

This error occurs if a command is issued to control an option that is not 
installed.

To troubleshoot:

• Check the Chromeleon Server Configuration program to verify that the 
option is enabled.

This error occurs if you try to calibrate the pressure slope when the pressure is 
less than 3 MPa (500 psi). 

To troubleshoot:

• Contact Dionex for assistance.

LOAD/INJECT VALVE ERROR

OPTION NOT INSTALLED

PRESSURE SLOPE CALIBRATION ERROR
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This error indicates a problem in the pump controller electronics.

To troubleshoot:

• Contact Dionex for assistance. The ICS-1500 electronics components 
cannot be serviced by the user. 

This error indicates a problem in the pump controller electronics.

To troubleshoot:

• Contact Dionex for assistance. The ICS-1500 electronics components 
cannot be serviced by the user. 

If the system pressure exceeds the set limit for at least 0.5 seconds, this error 
message appears and the pump stops. Pressure limits can be set in the 
Chromeleon Server Configuration or in the control program. The limits can 
also be set on the touch screen PUMP page (see Section C.7.1).

To troubleshoot:

1. Check for blockages in the liquid lines by working your way backward 
from the cell to the pump. See Figure 2-10 for the system flow schematic. 

2. Check that the flow rate is set to the correct value.

3. Check that the high pressure limit is set to the correct value.

4. Restart the pump.
 

PUMP MOTOR LOST CONTROL

PUMP PRESSURE HARDWARE ERROR

PUMP OVER PRESSURE
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If the system pressure falls below the low pressure limit, the pump stops and 
this error message appears. Pressure limits can be set in the Chromeleon 
Server Configuration or in the control program. The limits can also be set on 
the touch screen PUMP page (see Section C.7.1).

To troubleshoot:

1. Make sure the eluent reservoir is full.

2. Check for liquid leaks (see Section 4.2).

3. Check that the waste valve is closed.

4. Prime the pump (see Section B.14).

5. Restart the pump.

This error may be caused by an expended or dirty suppressor or by a 
malfunction in the suppressor controller electronics.

To troubleshoot:

1. Follow the instructions in the suppressor manual to regenerate the 
suppressor. Suppressor manuals are included on the Dionex Reference 
Library CD-ROM (P/N 053891).

2. Follow the instructions in the suppressor manual to clean the suppressor.

3. If a malfunction in the suppressor controller is suspected, contact Dionex 
for assistance. The ICS-1500 electronics components cannot be serviced 
by the user. 

PUMP UNDER PRESSURE

SUPPRESSOR OVER CURRENT
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This error occurs if you turn on the suppressor but the ICS-1500 cannot 
establish a connection with the suppressor.

To troubleshoot:

1. Check the suppressor cable connection (see Section 5.10).

2. If the error persists, replace the suppressor (see Section 5.10).

This error occurs when, in order to maintain the selected current, the ICS-
1500 is required to apply a higher voltage than the suppressor can support.

To troubleshoot:

• Reduce the flow rate.

• Rehydrate the suppressor. Refer to the suppressor manual for instructions. 
Suppressor manuals are included on the Dionex Reference Library CD-
ROM (P/N 053891).

• If the error persists, replace the suppressor (see Section 5.10).

This error occurs if you turn on the suppressor and the ICS-1500 cannot 
establish a connection with the suppressor.

To troubleshoot:

1. Check the suppressor cable connection (see Section 5.10).

2. If the error persists, contact Dionex for assistance. There may be a 
problem in the suppressor controller electronics. The ICS-1500 
electronics components cannot be serviced by the user.

SUPPRESSOR OVER VOLTAGE

SUPPRESSOR OVER POWER

SUPPRESSOR NOT CONNECTED
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This error message appears when you click the Shutdown button on the 
Chromeleon Control panel. The message also appears anytime you turn off 
the pump flow while the suppressor is on. The suppressor is automatically 
turned off to prevent damage to the suppressor.

To troubleshoot:

• If the pump stopped unexpectedly, see Section 4.5 for pump 
troubleshooting information.

4.2 Liquid Leaks

• Leaking fitting

Locate the source of the leak. Tighten or, if necessary, replace the liquid line 
connection (see Section 5.3). Refer to Installation of Dionex Liquid Line 
Fittings (Document No. 031432) for tightening requirements. The manual is 
on the Dionex Reference Library CD-ROM (P/N 053891).

• Broken liquid line

Replace the line and fittings with the same length and internal diameter tubing 
(see Section 5.3).

• Blocked or improperly installed line

Make sure the lines are not crimped or otherwise blocked. Also, if the blocked 
line is a waste line, make sure it is not elevated at any point after it exits the 
ICS-1500. If a line is blocked, replace it (see Section 5.3).

• Loose pump check valve

1. Make sure the check valves are firmly seated in the pump head. If they are 
not, tighten them carefully with an open-end wrench just until the leak 
stops.

2. If the leak persists, replace the check valve (see Section 5.5). 

• Leaking seal wash port

Leaking from the seal wash port indicates a leaking piston seal. Replace the 
seal (see Section 5.6).

SUPPRESSOR STOPPED FOR ZERO FLOW RATE
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• Damaged pump piston seal

1. Replace the piston seal (see Section 5.6).

2. If the leak persists, replace the piston (see Section 5.7).

• Pump head not tight against casting

Carefully tighten the pump head mounting nuts just until the leak stops. DO 
NOT OVERTIGHTEN!

• Leaking pressure transducer

1. Make sure the liquid line connections into the pressure transducer are 
tight. Refer to Installation of Dionex Liquid Line Fittings (Document No. 
031432) for tightening requirements. The manual is on the Dionex 
Reference Library CD-ROM (P/N 053891). Replace any damaged 
fittings. 

2. If the pressure transducer continues to leak, contact Dionex for 
assistance.The pressure transducer cannot be serviced by the user. 

• Leaking pump head waste valve

Make sure the waste valve is closed. To close the valve, turn the knob 
clockwise, and tighten fingertight. DO NOT OVERTIGHTEN! 
Overtightening may damage the valve and the pump head.

If the leak persists, replace the waste valve O-ring (see Section 5.8). 

• Leaking suppressor

Refer to the suppressor manual for troubleshooting procedures. Suppressor 
manuals are included on the Dionex Reference Library CD-ROM 
(P/N 053891).

• Leaking injection valve

1. Make sure the liquid line connections to the transducer are tight. Refer to 
Installation of Dionex Liquid Line Fittings (Document No. 031432) for 
tightening requirements. The manual is on the Dionex Reference Library 
CD-ROM (P/N 053891). Replace any damaged fittings.

2. Liquid leaks from behind the valve stator may indicate a scratched rotor 
seal. Rebuild the injection valve (see Section 5.4).
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• Leaking cell

1. Check the waste lines for blockage; trapped particles can plug the lines 
and cause a restriction and/or leak. If necessary, clear the waste lines by 
reversing the direction of flow.

2. Make sure the plumbing downstream from the cell is clear; a blockage 
may overpressurize the cell, causing it to leak. If the problem continues, 
contact Dionex for assistance.

4.3 Pump Difficult to Prime or Loses Prime

Excessive pressure fluctuations (more than 3% difference from one pressure 
reading to the next) indicate that the pump is out of prime.

• Empty eluent reservoir and/or no eluent connected

Fill the reservoir. Make sure all connections are secure.

• Eluent improperly or insufficiently degassed

If the ICS-1500 does not contain a vacuum degas assembly, degas the eluent 
manually (see Section 3.4.2). 

If the ICS-1500 contains a vacuum degas assembly, check the degas settings:

1. Open the Chromeleon Server Configuration program, select the ICS-1500 
device icon under the timebase, and select Edit>Properties (or double-
click the ICS-1500 device icon). 
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2. Select the Options tab (see Figure 4-1).

Figure 4-1.  ICS-1500 Server Configuration Properties: Options

3. Under Installed Options, verify that the Degas check box is selected.

4. Check the Degas Mode settings. Select either the Monitor option or 
the Cycle option. If you select Cycle, set the time On to 30 seconds 
and the time Off to 10 minutes. If Cycle is already selected, try 
increasing the time on or decreasing the time off.

NOTE Degas Mode options can also be selected from
the touch screen PUMP page (see Section C.7).

• End-line filter is dirty or clogged 

When new, end-line filters (P/N 045987) are pure white. If the system is in 
continuous operation, change the end-line filter weekly, or whenever it 
becomes discolored. Replace the filter more often if bacterial buildup is 
visible or if the eluent does not contain solvent.
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NOTE It is especially important to regularly replace end-line
filters when using aqueous eluents, which may
contaminate the filter with bacteria or algae. The
bacterial buildup may not be visible.

• Blockages in inlet tubing

Kinked or clogged tubing causes the pump to be “starved” for eluent. Replace 
the tubing and fittings (see Section 5.3). 

• Dirty check valve

Clean or replace the pump check valve (see Section 5.5).

• Liquid leaks at junction between pump head and pump casting

Use the open-end wrench (P/N 014605) provided in the ICS-1500 Ship Kit 
(P/N 057905) to tighten the two acorn nuts that attach the pump head to the 
pump housing (see Figure 5-9). Tighten the nuts evenly (12 in-lb torque). 

If the leak persists, replace the piston seal (see Section 5.6).

• Liquid leaks from the seal wash port

Replace the piston seal (see Section 5.6).

• Scratched pump piston

Check the pump pistons for scratches and replace if necessary (see 
Section 5.7).

4.4 Pump Does Not Start

• No power (front Power LED indicator is not lit)

Check that the power cord is plugged in.

Check the main power fuses and replace if needed (see Section 5.16).
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• No communication between ICS-1500 and Chromeleon

Verify that the USB cable is connected correctly. See Section B.5 for 
installation instructions.

• Pump is turned off

Turn on the pump from either the Chromeleon Control panel or the ICS-1500 
touch screen HOME page.

• Flow rate is set to 0

Set the flow rate from either the Chromeleon Control panel or the ICS-1500 
touch screen HOME page.

4.5 No Flow

• Pump waste or priming valve open (see Figure 4-2).

Close the valves by turning the knobs clockwise until fingertight. DO NOT 
OVERTIGHTEN! Overtightening may damage the valve and the pump 
head.

• Flow rate is set to 0

Set the flow rate from either the Chromeleon Control panel or from the touch 
screen HOME page.

Figure 4-2.  Waste and Priming Valves

Waste Valve

Priming Valve
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• Eluent valve is closed

Open the eluent valve from either the Chromeleon Control panel or from the 
touch screen PUMP page.

• Pump not primed

Prime the pump (see Section B.14).

• Broken pump piston

Replace the piston (see Section 5.7).

4.6 Erratic Flow/Pressure Reading

• Pump needs priming

Prime the pump (see Section B.14).

• Damaged piston seal

Replace the piston seal (see Section 5.6).

• Dirty pump check valve

Clean or replace the check valve (see Section 5.5).

• Leaking liquid lines or fittings

Check the liquid lines and fittings for small leaks. Tighten or, if necessary, 
replace the liquid line connection (see Section 5.3). Refer to Installation of 
Dionex Liquid Line Fittings (Document No. 031432) for tightening 
requirements. The manual is on the Dionex Reference Library CD-ROM 
(P/N 053891).

4.7 Excessive System Backpressure

• Restriction in the system plumbing

Check all liquid lines for crimping or blockage. Make sure the ferrule fittings 
are not overtightened onto tubing. Refer to Installation of Dionex Liquid Line 
Fittings (Document No. 031432) for details. The manual is on the Dionex 
Reference Library CD-ROM (P/N 053891). If you have trouble isolating the 
restriction, refer to Section 5.2.
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• Plugged or damaged fitting

Isolate the faulty fitting by loosening fittings one by one until the pressure 
returns to normal. Repair or replace the fitting (see Section 5.3).

• Flow rate through the columns too high

Set the correct rate for your application. If an incorrect flow rate calibration is 
suspected, calibrate the flow (see Section 5.1.4).

• Clogged column bed supports

Refer to the instructions in the column manual for troubleshooting guidance. 
Column manuals are included on the Dionex Reference Library CD-ROM 
(P/N 053891).

• Contaminated columns

Clean the columns as instructed in the column manual.

• Plugged injection valve passages

Rebuild the injection valve (see Section 5.4).

4.8 Peak “Ghosting”

“Ghosting” is the appearance of extraneous peaks in a chromatogram. These may 
be late-eluting peaks from a previous injection, or they may be the result of a 
contaminated standard or eluent, or a malfunctioning injection valve. These peaks 
may co-elute with peaks of interest, resulting in nonreproducible peak 
heights/areas.

• Insufficient time between sample injections

Wait until the previous sample has been completely eluted before making 
another injection.

• Insufficient flush between samples

Flush the sample loop with at least 10 loop volumes of deionized water or 
sample between sample injections.

• Incorrect or contaminated standards

Remake standards.
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• Incorrect or contaminated eluent

Remake the eluent according to the instructions in the column manual. 
Column manuals are included on the Dionex Reference Library CD-ROM 
(P/N 053891).

Install or replace the end-line filter on the end of the deionized water line (see 
Section 3.4.3).

• Malfunctioning injection valve

1. Rebuild the injection valve (see Section 5.4).

2. If the valve leak persists, contact Dionex for assistance.

4.9 Nonreproducible Peak Height or Retention Time

• Column overloading

Dilute the sample (see Section 3.9).

• Liquid leaks

Locate and eliminate the leaks (see Section 4.2). 

• Incomplete or imprecise filling of the sample loop

1. Fill the sample loop until excess sample exits the waste line.

2. Inspect the 1-cc syringe (P/N 016388) and replace if damaged.

• Pump not primed properly

Prime the pump (see Section B.14).

4.10 Abnormal Retention Time or Selectivity

• Contaminated or incorrect eluent

Remake the eluent, using concentrated eluent and ASTM filtered, Type I (18-
megohm) deionized water.

• Contaminated or degraded sample

Take appropriate precautions when preparing and storing samples to prevent 
contamination and degradation (see Section 3.9).
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• Contaminated column

1. Clean the column as instructed in the column manual. Column manuals 
are included on the Dionex Reference Library CD-ROM (P/N 053891).

2. If cleaning is unsuccessful, replace the column.

4.11 No Cell Response

• Cell not properly installed

Verify that the cell front cover is flush against the component panel. If 
necessary, tighten the two mounting screws. When the cell is correctly 
installed and the screws tightened, an electronics connector on the cell plugs 
into a receptacle inside the ICS-1500. 

• No flow from pump

This condition has several possible causes. See Section 4.4 and Section 4.5 
for details.

• Cell electronics malfunctioning

Use the Chromeleon Wellness Panel diagnostics to test the electronics (see 
Section 5.1 and the Chromeleon online Help for instructions). If the variance 
reading is outside the tolerance range (less than 1 µS), the electronics are 
malfunctioning. Contact Dionex for assistance. The ICS-1500 electronics 
cannot be serviced by the user.

4.12 High Cell Output

• Background not suppressed by suppressor

Verify that the suppressor is turned on and the current is set to the correct 
value. Refer to the suppressor manual for additional troubleshooting 
guidance. Suppressor manuals are included on the Dionex Reference Library 
CD-ROM (P/N 053891). 

• Sample concentration too high

Dilute the sample Section 3.9.3.

• Wrong eluent

Check that you are using the correct eluent for your application.
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• Background conductivity not offset from conductivity reading

Before making an injection, allow the background conductivity to equilibrate, 
and then press Autozero on the Chromeleon Control panel or the ICS-1500 
touch screen HOME page.

• Cell out of calibration

Recalibrate the cell (see Section 5.1.3).

4.13 Baseline Noise or Drift

• Flow system leak; erratic baseline

Check all fittings and liquid lines for leaks. Tighten or, if necessary, replace 
all liquid line connections. Refer to Installation of Dionex Liquid Line Fittings 
(Document No. 031432) for tightening requirements. The manual is on the 
Dionex Reference Library CD-ROM (P/N 053891).

• Trapped gases

Release any trapped gases in the cell by loosening the lines to and from the 
cell and then retightening them. Also loosen and retighten the fittings to and 
from the suppressor eluent ports.

• Pump not properly primed

Prime the pump (see Section B.14).

• Contaminated or incorrect eluent

Remake the eluent, using concentrated eluent and ASTM filtered, Type I (18-
megohm) deionized water.

• Rapid changes in ambient temperature

Make sure the ambient temperature is between 4 and 40 °C (40 and 104 °F).

Make sure air conditioning and heating vents are directed away from the ICS-
1500 and the ICS-1500 front door is closed.

• Insufficient system equilibration following changes to operating 
parameters; especially apparent when operating at high sensitivities

Allow a longer system equilibration time (up to 2 hours) before starting 
operation.
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• Incorrect suppressor operating conditions

Refer to the suppressor manual for troubleshooting information. Suppressor 
manuals are included on the Dionex Reference Library CD-ROM 
(P/N 053891).

• Cell above or below temperature

Contact Dionex for assistance.

• Damaged piston seal

Replace the piston seal (see Section 5.6).
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4.14 Vacuum Degas Assembly Does Not Run

• Degas option not enabled in Chromeleon

1. Open the Chromeleon Server Configuration program. Select the ICS-
1500 device icon under the timebase and select Edit>Properties (or 
double-click the ICS-1500 device icon). 

Select the Options tab (see Figure 4-3).

Figure 4-3.  ICS-1500 Server Configuration Properties: Options.

2. Under Installed Options, verify that the Degas check box is selected. 

3. Under Degas Mode, verify that the Always Off option is not selected. If 
it is, select one of the following settings:

• Cycle, and select On: 30 seconds and Off: 10 minutes

• Monitor

4. If the Degas Mode settings are correct, but the degas assembly still does 
not run, test the assembly by selecting the Always On option. The pump 
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should turn on immediately. If it does not, the vacuum degas assembly 
may need to be replaced. Contact Dionex for assistance.

NOTE Degas Mode options can also be selected from the touch
screen PUMP page (see Section C.7).

5. If the degas pump runs when you select Always On, but does not run 
when Monitor mode is selected, recalibrate the degas assembly (see 
Section 5.1.5).

Select the Degas Mode, Always On option only when testing the vacuum
degas assembly. Do not select the Always On option for routine use.
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5 • Service

This chapter describes ICS-1500 service and repair procedures that the user can 
perform. All procedures not included here, including electronics-related repair 
procedures, must be performed by Dionex personnel. For assistance, contact 
Dionex Technical Support. In the U.S., call 1-800-346-6390. Outside the U.S., 
call the nearest Dionex office.

Before replacing any part, refer to the troubleshooting information in Chapter 4 to 
isolate the cause of the problem.

5.1 Diagnostic and Calibration Procedures

Diagnostic and calibration procedures can be performed either from the touch 
screen or from the Chromeleon Wellness Panel (see Figure 5-1). 

For an overview of the Wellness Panel features, see Section 5.1.1. For instructions 
on performing calibration and diagnostic procedures, see the following sections:

• Calibrating the Conductivity Cell (Section 5.1.3)

• Calibrating the Flow Rate (Section 5.1.4)

• Calibrating the Vacuum Degas Assembly (Section 5.1.5)

Substituting non-Dionex parts may impair ICS-1500 performance,
thereby voiding the product warranty. Refer to the warranty statement
in the Dionex Terms and Conditions for more information.
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5.1.1 Chromeleon Wellness Panel Overview

NOTE Do not open a System Wellness Control panel if the
name includes "Service.pan." These Wellness panels are
reserved for use by Dionex Service Representatives.

To Open the Wellness Panel

1. Open the Chromeleon Browser and expand the Dionex Templates 
folder. 

2. Expand the Panels folder and then the Wellness folder.

3. In the right pane of the Browser window, double-click ICS-
1000_1500_2000_Wellness_user.pan. The Wellness Panel appears.

4. Open the Control menu and click the name of the ICS-1500 timebase 
at the bottom of the menu. This connects the Wellness Panel to the 
ICS-1500 and enables the controls on the panel.

Figure 5-1.  Chromeleon Wellness Panel
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Use the Wellness Panel to perform the following functions:

• Calibrate the pump flow rate

• Calibrate the vacuum degas assembly

• Calibrate the conductivity cell

• Test the conductivity cell electronics, using a dummy cell

• Upload calibration values from the ICS-1500 to the Chromeleon 
Wellness database

After completing a calibration procedure from the touch screen,
always update the Chromeleon Wellness database by clicking the
Upload button on the Chromeleon Wellness Panel (see Figure 5-1).
This action ensures that the current calibration information is stored
in Chromeleon as well as in the ICS-1500.
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5.1.2 Diagnostic and Calibration Touch Screen Overview
Select DIAGNOSTIC from the touch screen menu of pages. The 
DIAGNOSTIC page opens (see Figure 5-2). From there, you can access 
individual diagnostic and calibration pages.

NOTE The Service button provides access to service
functions that are performed only by Dionex
personnel. An access code is required to go to the
service pages.

Figure 5-2.  System Diagnostic Menu Page
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5.1.3 Calibrating the Conductivity Cell

When to Calibrate

• After every 6 months of use 

NOTE Do not use this procedure to calibrate a new cell. If you
are replacing a cell, see the instructions in Section 5.9 to
install the new cell and calibrate it. 

1. Open the ICS-1500 Wellness Panel in Chromeleon (see 
Section 5.1.1), or open the touch screen ELECTRIC CONDUCTIVITY 
CALIBRATION page (see Figure 5-3). 

Items Needed Description

1.0 mM KCl solution Prepare by dissolving 0.07456 g of reagent-
grade KCl in 1 liter of 18-megohm DI 
water.

Backpressure tubing to provide 
at least 7 MPa (1000 psi)

Use 0.076-mm (0.003-in) ID yellow PEEK 
tubing (P/N 049715).

Figure 5-3.  Electric Conductivity Calibration Page
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2. On the Wellness Panel under Electric Conductivity Cell 
Calibration, click Offset Cal, or touch Run Offset Cal on the ICS-
1500 touch screen.

3. When the offset calibration is complete, click Slope Cal on the 
Wellness Panel, or touch Run Slope Cal on the ICS-1500 touch 
screen.

4. If you are using the Wellness Panel, click Log to record the new 
calibration values in the Audit Trail.

5. Disconnect the pump output line from the injection valve.

6. Disconnect the line from the suppressor ELUENT OUT port to the cell 
inlet and connect the pump output line directly to the cell inlet.

7. Verify that the backpressure is at least 7 MPa (1000 psi).

8. If you are using the touch screens to perform the calibration, open the 
CONDUCTIVITY CELL page (see Figure 5-4).

9. On the Wellness Panel under Conductivity Cell Calibration, click 
Cell 35 C, or touch 35 C on the ICS-1500 touch screen. Allow the cell 
to reach this temperature and then wait an additional 5 minutes to let 
it stabilize. When the temperature has stabilized, “=” is displayed to 
the right of the temperature reading on the CONDUCTIVITY CELL page.

Figure 5-4.  Conductivity Cell Page
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10. Select 1.00 mL/min to begin pumping 1.00 mM KCl through the cell 
at 1.0 mL/min.

11. Wait until the total conductivity reading stabilizes (in about 
15 minutes) and then select Calibrate on the Wellness Panel or the 
touch screen CONDUCTIVITY CELL page.

After calibration, the conductivity reading should be 147.00 ± 2 µS 
and the cell constant should be between 120 and 180. If this is not the 
case, contact Dionex for help.

12. If you are using the Wellness Panel, click Log to record the new 
calibration values in the Audit Trail.

13. If you are using the ICS-1500 touch screen, record the new 
calibration values in the Chromeleon Wellness database. To do this, 
open the Wellness Panel (see Section 5.1.1) and click Upload under 
Update Wellness Database.

14. Flush the KCl solution from the system by pumping deionized water 
through the cell. When the conductivity drops to less than 1 µS/cm, 
stop the pump.

15. Reconnect the pump to the injection valve and reconnect the line 
from the suppressor to the cell inlet.
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5.1.4 Calibrating the Flow Rate

When to Calibrate

If you run the ICS-1500 Operational Qualification or Performance 
Qualification and it fails.

Items Needed

• 0.076-mm (0.003-in) ID yellow PEEK tubing (P/N 049715) to create 
14 ± 2 MPa (2000 ± 300 psi) of backpressure (if needed)

• High purity ASTM filtered, Type I (18 megohm-cm) deionized water

• Balance capable of weighing more than 10 g with 0.001 g readability 

• Tared beaker

To Calibrate

1. Open the ICS-1500 Wellness Panel in Chromeleon (see 
Section 5.1.1), or open the ICS-1500 touch screen FLOW RATE page 
(see Figure 5-5). 

2. Verify that there is 14 ± 1.4 MPa (2000 ± 200 psi) of backpressure.

Figure 5-5.  Flow Rate Page
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3. On the Chromeleon Wellness Panel under Pump Flow Rate 
Calibration, select Reset Cal, or touch Reset Cal on the ICS-1500 
touch screen.

4. Select 1 mL/min to set the flow rate and begin pumping deionized 
water.

5. Allow the pump to stabilize for 20 minutes.

6. If you are using the Wellness Panel, click 5.00 min to start the timer. 
If you are using the touch screen, start an external timer. Immediately 
start collecting water into the tared beaker. 

7. Collect the water for exactly 5.00 minutes.

8. Enter the weight of the water (in grams).

9. If you are using the Wellness Panel, click Calibrate to download the 
value to the ICS-1500.

10. To recheck the value, wait at least 15 minutes, and then repeat the 
calibration. 

11. If you are using the Wellness panel, click Log to record the new 
calibration value in the Audit Trail. 

12. If you performed the calibration from the ICS-1500 touch screen, 
record the new calibration values in the Chromeleon Wellness 
database. To do this, open the Wellness Panel (see Section 5.1.1) and 
click Upload.
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5.1.5 Calibrating the Vacuum Degas Assembly

When to Calibrate

• After every 6 months of use 

1. Open the ICS-1500 Wellness Panel in Chromeleon (see 
Section 5.1.1), or open the ICS-1500 touch screen PUMP DEGAS page 
(see Figure 5-6). 

2. On the Wellness Panel under Degas Calibration, select Calibrate, or 
touch Calibrate on the ICS-1500 touch screen. The degas pump runs 
for 90 seconds to allow a vacuum to be created. After 90 seconds, the 
vacuum degas pressure reading is recorded. When the vacuum degas 
assembly is running in monitor mode, this calibration value is used to 
determine when to turn on the degas pump.

3. If you are using the Wellness panel, click Log to record the new 
calibration value in the Audit Trail. 

4. If you performed the calibration from the ICS-1500 touch screen, 
record the new calibration values in the Chromeleon Wellness 
database. To do this, open the Wellness Panel (see Section 5.1.1) and 
click Upload under Update Wellness Database.

Figure 5-6.  Pump Degas Page
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5.2 Isolating a Restriction in the Liquid Lines

A restriction in the liquid plumbing will cause excessive system backpressure.

1. Begin pumping eluent through the system (including the columns).

2. Follow the ICS-1500 flow schematic in Figure 5-7 and work backward 
through the system, beginning at the suppressor Regen Out port. One at a 
time, loosen each fitting and observe the pressure. The connection at which 
the pressure drops abnormally indicates the point of restriction.

NOTE The numbers on the ICS-1500 flow schematic indicate
the order in which liquid flows through the system
components.

If the restriction has caused such high pressure that the system cannot be 
operated, you must work forward through the flow schematic, adding parts 
one at a time until an abnormal pressure increase (and hence, the restriction) is 
found.

3. If the restriction is in the tubing or fitting, remove the restriction by back 
flushing or by replacing the tubing or fitting (see Section 5.3).



ICS-1500 Ion Chromatography System

5-12 Doc. 031917-02 9/05

NOTE The numbers on the flow schematic indicate the
order in which liquid flows through the system
components.

Figure 5-7.  ICS-1500 Flow Schematic
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5.3 Replacing Tubing and Fittings

The ICS-1500 is plumbed with the tubing and tubing assemblies listed below.

• 10-32 fittings (P/N 043275) and ferrules (P/N 043276) are used for most 
tubing connections. For tightening requirements, refer to Installation of 
Dionex Liquid Line Fittings (Document No. 031432). The manual is on the 
Dionex Reference Library CD-ROM (P/N 053891).

• 1/8-in fittings (P/N 052267) and ferrules (P/N 048949) are used for 
connections to the suppressor REGEN OUT port and the eluent reservoir.

Tubing Size and Type Color Used For

0.125-mm (0.005-in) ID PEEK 
(P/N 044221) 

Red Connection from pump pulse damper 
to pressure transducer

0.25-mm (0.010-in) ID PEEK 
(P/N 042690) 

Black Connections between other system 
components

0.50-mm (0.020-in) ID PEEK
 (P/N 042855)

Orange Connection from injection port to 
injection valve

0.75-mm (0.030-in) ID PEEK 
(P/N 044777)

Green Connection from injection valve to 
waste

1.58-mm (0.062-in) ID Teflon 
(P/N 014157)

Clear Connection from pump to degas or 
eluent reservoir; pump waste

25 µL sample loop 
(P/N 042857)

Orange Connection between ports L (1) and 
L (4) on the injection valve
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5.4 Rebuilding the Injection Valve

Dionex recommends rebuilding the injection valve annually. The Injection Valve 
Rebuild Kit (P/N 057896) contains all required replacement parts.

NOTE Substitution of non-Dionex parts may impair valve
performance and void the product warranty.

1. Turn off the pump from the ICS-1500 Control panel in Chromeleon or from 
the touch screen HOME page.

2. Open the ICS-1500 front door.

3. Disconnect each liquid line connected to the injection valve.

4. Follow the instructions provided in the Rebuild Kit to replace the rotor seal, 
isolation seal, and stator face.

5. Reconnect all liquid lines to the injection valve (see Figure 5-8).

6. Close the door.

7. Turn on the pump.

Figure 5-8.  Injection Valve Plumbing
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5.5 Cleaning and Replacing the Pump Check Valves

A dirty check valve causes erratic flow rates and pressures. In addition, it 
may cause the pump to lose prime and/or be difficult to reprime. If possible, 
replace dirty check valves. If new check valves are not available, follow the 
instructions for cleaning.

Replacing Check Valves
1. Close the eluent valve from the ICS-1500 Control panel in Chromeleon or 

select Eluent Valve Closed on the touch screen PUMP page.

2. Turn off the main power switch, to ensure that you do not unintentionally start 
the ICS-1500.

3. To prevent contamination of pump parts, put on a pair of rubber gloves before 
disassembling the pump head.

4. Disconnect the tube fittings from the inlet and outlet check valve assemblies 
on the primary pump head (see Figure 5-9).

5. Use a 1/2-inch wrench to loosen both check valve assemblies. Remove the 
check valve assemblies from the pump head. 

NOTE The inlet check valve assembly housing has a 1/4-28 port.
The outlet check valve assembly housing has a 10-32 port. 

Figure 5-9.  Pump Heads

Secondary
Pump Head

Primary 
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Valve

Inlet Check 
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Acorn Nuts
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6. If you are installing new cartridges 
(P/N 045994) in the existing check valve 
housings, place the cartridge in the inlet 
check valve housing with the double-hole 
end of the cartridge visible and place the 
cartridge in the outlet housing with the 
single-hole end visible. 

NOTE The pump will not operate
properly unless the cartridge is
installed in the housing in the
correct orientation. Liquid flows
through the check valve in the
large single hole and out the
small double holes. 

7. Install the inlet check valve assembly (P/N 045722) on the bottom of the 
primary pump head. Install the outlet check valve assembly (P/N 045721) on 
the top of the head. Tighten the check valves fingertight, and then use a 
wrench to tighten an additional one-quarter to one-half turn. 

8. Reconnect the liquid lines. Turn on the ICS-1500 main power.

9. Open the eluent valve from the ICS-1500 Control panel in Chromeleon or 
select Eluent Valve Closed on the touch screen PUMP page.

10. Prime the pump (see Section B.14). 

11. When the ICS-1500 is at operating pressure, check for leaks from the check 
valves. Tighten a check valve a little more only if it leaks.

Cleaning Check Valves
1. Carefully remove the check valve cartridges from the valve housings.

2. Place the check valve housings and cartridges in a beaker with methanol. 
Sonicate or agitate the parts for several minutes.

3. Rinse each check valve housing and cartridge thoroughly with filtered 
deionized water.

4. See Step 6 through Step 11 above to reinstall the check valves and complete 
the procedure. 

Overtightening may damage the pump head and check valve housing
and crush the check valve seats.

Inlet
Check 
Valve

Check
Outlet 
Valve 

Double-hole Single-hole 
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5.6 Replacing a Pump Piston Seal and Piston Rinse Seal

A damaged seal allows leakage past the piston, as well as leakage from the 
piston seal wash housing. The pump may be difficult to prime, flow rates may 
be unstable, and there may be baseline noise.

Preparation
1. Rinse the pump flow path with deionized water. Direct the flow to waste by 

opening the waste valve on the secondary pump head (see Figure 5-12). To 
open the valve, turn the knob one-quarter to one-half turn counterclockwise.

2. After rinsing, close the waste valve.

3. Close the eluent valve from the ICS-1500 Control panel in Chromeleon or 
select Eluent Valve Closed on the touch screen PUMP page.

4. To prevent contamination of pump parts, put on a pair of rubber gloves before 
disassembling the pump head.

Removing the Head and Piston
1. Turn off the main power switch, to ensure that you do not unintentionally start 

the ICS-1500.

2. Disconnect all tubing connections to the pump head.

3. Locate the open-end wrench (P/N 014605) provided in the ICS-1500 Ship Kit 
(P/N 057905). Use the wrench to remove the two acorn nuts (see Figure 5-9) 
from the pump head.

4. Slowly pull the head and allow it to separate from the housing. Carefully 
disengage the head from the piston by pulling the head straight off and away 
from its mounting studs.

Lateral motion while disengaging the pump head from the piston may
break the piston.

Un mouvement latéral pendant la séparation de la tête et du piston
peut casser le piston.

Vermeiden Sie Seitwärtsbewegungen, wenn Sie den Kopf vom Kolben
lösen. Andernfalls kann der Kolben brechen. 
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5. Place the head (front end down) on a clean work surface and lift off the spacer 
to expose the piston seal (see Figure 5-10 or Figure 5-11).

Figure 5-10.  Primary Pump Head

Figure 5-11.  Secondary Pump Head

Piston
(P/N 052840)

O-Ring
(P/N 055752)

Piston Seal
(P/N 055870)

Primary Pump Head
(P/N 055711)

Seal Guide
(P/N 058032)

Spacer with Drain
(P/N 057913)

Priming Valve Knob
(P/N 055709)

Inlet Check 
Valve Assembly
(P/N 045722)

Outlet Check 
Valve Assembly

(P/N 045721)

O-Ring
(P/N 059283)

Piston Rinse Seal
(P/N 048722) O-Ring

(P/N 014895)

Piston
(P/N 052840)

Seal Guide
(P/N 058032)

O-Ring
(P/N 055752)

Piston Seal
(P/N 055870)

Secondary 
Pump Head
(P/N 055712)

Spacer with Drain
(P/N 057913)

Waste Valve Knob
(P/N 055710)

O-Ring
(P/N 059283)

Piston Rinse Seal
(P/N 048722) O-Ring

(P/N 014895)



5 • Service

Doc. 031917-02 9/05 5-19

6. The piston does not come off as part of the pump head assembly because it is 
captured by a magnetic retention system. After removing the pump head, hold 
the shaft of the piston (near the base), tilt the piston slightly, and pull the 
piston away from the pump.

Installing the New Piston Rinse Seal
1. Remove the guide from the spacer to expose the piston rinse seal and O-ring. 

Remove the O-ring.

2. Remove the old piston rinse seal from the guide as follows:

a. Hold the guide with the flat side facing up.

b. To dislodge the piston rinse seal, 
gently insert the shaft of the piston 
through the small hole in the center 
of the guide (see photo).

c. Pull the seal off the end of the 
piston shaft and remove the piston 
from the guide.

3. Hold the new piston rinse seal (P/N 
048722) with the grooved side facing 
up.

4. Using your fingertip, gently press the piston rinse seal into the guide until the 
edge of the seal is below the surface of the guide. 

5. Place the new O-ring (P/N 059283) into the groove in the guide.

6. Remove the O-ring from the groove in the flat side of the spacer and replace it 
with the new O-ring (P/N 014895).

7. In one hand, hold the guide with the O-ring and piston rinse seal facing up 
(this prevents the O-ring from falling out). In the other hand, hold the spacer 
with the cavity facing down.

8. Gently press the guide into the cavity in the spacer until it is fully seated.

The piston rinse seal is made of soft plastic. Do not press on the seal
with anything hard or sharp, including your fingernail. If the seal is
nicked or gouged, it will not seal properly and may result in leaks.
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Removing the Piston Seal from the Head
1. Fill the head cavity with deionized water by injecting the liquid through either 

the piston opening or the inlet check valve.

2. Reinsert the piston approximately 3 mm (0.125) inch into the seal.

3. If this is the primary pump head, install a 10-32 fitting plug (P/N 042772) on 
the outlet check valve. Tighten the plug.

4. If this is the secondary pump head, install a 10-32 fitting plug (P/N  042772) 
in both the inlet and outlet ports. Tighten the plugs.

5. Push the piston into the head. (This should hydraulically unseat the seal from 
the head.) Remove the piston and pull off the seal.

NOTE If the piston seal is not removed, make sure the 10-32
fitting plug(s) are tight and add more water. Make sure
the head contains no air bubbles, and then repeat Steps
2 and 5.

6. Remove the 10-32 fitting plug(s).

Installing the New Piston Seal
1. Open the priming valve knob (primary pump head) or waste valve knob 

(secondary pump head) by turning the knob one-quarter to one-half turn 
counterclockwise.

2. Push the piston through the spacer and then through the new seal. Insert the 
piston and seal into the pump head until the seal makes contact with the 
bottom of the counterbore. 

NOTE If necessary, lubricate the seal with a small amount of
isopropyl alcohol to facilitate insertion.

3. To seat the seal, push down on the spacer until it is flush with the head. A 
clicking sound indicates that the seal is correctly seated.

4. Close the priming valve knob or waste valve knob.
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Reinstalling the Head and Piston
Dionex recommends reinstalling the head and piston as a single assembly, so that 
the piston centers itself onto the magnetic follower.

1. Hold the assembled spacer and guide with the drain tubes aligned vertically 
and press the spacer into the head until it is flush with the indented surface of 
the head. 

2. Insert the piston so that 1/4 inch of the shaft is exposed. This ensures that the 
magnet in the follower picks up the piston. (The follower is the cylinder that 
holds the piston in place as it moves in and out of the pump head assembly.)

3. Reinstall the head and piston assembly; use a wrench to tighten the nuts 
evenly (12 in-lb torque).

Completing the Procedure
1. Reconnect all liquid lines to the pump head. 

2. Turn on the main power switch. 

3. Open the eluent valve.

4. Prime the pump (see Section B.14).

5.7 Replacing a Pump Piston

Continued leaking of the piston seal after installation of a new seal (assuming 
the pump head is tight) indicates a dirty, scratched, or broken piston.

Follow the instructions in Section 5.6 to install a new piston (P/N 052840) and 
piston seal (P/N 055870). 
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5.8 Replacing the Waste Valve or Priming Valve O-Ring

A damaged O-ring causes leakage around the base of the waste valve or 
priming valve knob. 

1. Close the eluent valve from the Control panel in Chromeleon or select Eluent 
Valve Closed on the touch screen PUMP page.

2. Turn off the main power switch, to ensure that you do not unintentionally start 
the ICS-1500.

3. To remove the waste valve or priming valve from the pump head (see 
Figure 5-12), turn the knob counterclockwise until it is loose, and then pull 
the knob straight out of the cavity in the pump head.

Figure 5-12.  Waste and Priming Valves

Waste Valve

Priming Valve



5 • Service

Doc. 031917-02 9/05 5-23

4. If the O-ring is removed with the valve knob in Step 3, pull the O-ring off the 
end of the knob (see Figure 5-13). If the O-ring is not removed with the valve 
knob, insert a thin object (for example, the bent end of a paper clip) into the 
cavity in the pump head and carefully pull out the O-ring. Do not scratch the 
cavity.

5. Slide a new O-ring (P/N 055752) over the end of the valve. 

6. To reinstall the valve containing the new O-ring, turn the knob clockwise and 
then tighten fingertight.

NOTE It is normal to encounter resistance after several
rotations of the knob; the O-ring is being pushed
into the cavity of the pump head.

7. Turn on the main power switch. 

8. Open the eluent valve.

9. Prime the pump (see Section B.14).

Scratches in the cavity will cause leaks around the base of the knob
while the pump is being primed.

Figure 5-13.  Waste Valve or Priming Valve O-Ring Replacement

Valve Knob

O-Ring
(P/N 055752)
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5.9 Replacing the Conductivity Cell

1. Turn off the ICS-1500 power.

2. Open the front door and disconnect the tubing from the CELL IN and CELL 
OUT fittings (see Figure 5-14, View A). Loosen the two screws on the cell 
front cover. The screws remain attached (see Figure 5-14, View B).

Figure 5-14.  Removing the Cell Front Cover

3. Grip the two loosened screws 
and pull the cell cover toward 
you to remove it from the 
component panel. Do not pull 
from the CELL IN and CELL 
OUT fittings.

4. Continue pulling on the cover 
until the attached cell assembly 
slides out the front of the ICS-
1500 (see Figure 5-15).

Figure 5-15.  Removing the Cell Assembly

Disconnect

Unscrew

Unscrew

View A View B
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5. Slide the new cell assembly into the opening in the component panel until it 
stops and the cell cover is flush against the component panel. The cell’s 
electronic connector automatically plugs into a connector inside the ICS-1500 
when you push the assembly into the opening. 

6. Tighten the screws on the cell front cover fingertight.

7. Reconnect the inlet and outlet lines.

8. Turn on the ICS-1500 power.

9. Calibrate the new cell in Chromeleon or on the ICS-1500 touch screen 
DIAGNOSTIC page. Cell calibration of a new cell consists of three parts:

• Running the offset calibration, which measures the output of the cell 
electronics alone and determines an offset value to be applied to raw 
conductivity readings.

• Running the slope calibration, which measures the output of the cell 
electronics when a built-in dummy cell, which provides a constant 
conductivity reading of 21 µS, is automatically enabled. The slope value 
is applied to raw conductivity readings.

• Entering the cell constant measured at the factory. The ICS-1500 uses the 
cell constant to determine the measured conductivity.

To calibrate the cell in Chromeleon:

a. Open the Wellness Panel (see Section 5.1.1)

b. Under Electric Conductivity Cell Calibration, click Offset Cal. 

c. When the offset calibration is complete, click Slope Cal. 

d. Click Calibration Details. Under Conductivity Cell Cal Details, enter 
the Cell Constant value printed on the front of the cell.

e. In the field next to the Download button, verify that Current is selected 
and then click Download to download the new value to the ICS-1500.

f. To ensure that the new values are recorded in the ICS-1500 memory, do 
not turn off the ICS-1500 power for at least 1 minute after downloading. 
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To calibrate the cell on the ICS-1500 touch screen DIAGNOSTIC page:

a. Go to the DIAGNOSTIC page and touch Electric Conductivity Cell.

b. On the ELECTRIC CONDUCTIVITY CALIBRATION page (see Figure 5-16), 
touch Run Offset Cal.   

c. When the offset calibration is complete, touch Run Slope Cal. 

d. Touch the Cell Constant field and enter the value printed on the front of 
the cell.

e. To ensure that the new calibration values are recorded in the ICS-1500 
memory, do not turn off the ICS-1500 power for at least 1 minute.

f. Record the new calibration values in the Chromeleon Wellness database. 
To do this, open the Wellness Panel (see Section 5.1.1) and click Upload 
under Update Wellness Database.

Figure 5-16.  Electric Conductivity Calibration Page
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5.10 Replacing the Suppressor

Refer to the suppressor manual for guidance about when to replace a suppressor. 
Suppressor manuals are included on the Dionex Reference Library CD-ROM 
(P/N 053891).

1. Refer to the suppressor quick start guide (shipped with the suppressor) for 
instructions on preparing the suppressor before initial use and for additional 
installation details.

2. Turn off the pump from the ICS-1500 Control panel in Chromeleon or from 
the touch screen HOME page.

3. Open the front door of the ICS-1500.

4. Disconnect the two eluent and the two regenerant lines from the suppressor.

5. To remove the suppressor from the component mounting panel, slide it up to 
detach it from the mounting tabs on the panel and then pull it toward you.

6. Continue pulling the 
suppressor out until the 
yellow connector on the 
cable inside the ICS-1500 is 
outside the panel (see 
Figure 5-17). 

7. Disconnect the suppressor 
cable (twist the ring on the 
yellow connector and pull 
the two connectors apart).

Figure 5-17.  Removing the Suppressor

8. Connect the cable from the new suppressor to the ICS-1500 cable (align the 
pins on the two connectors and push them together).

9. Orient the suppressor with the REGEN OUT fitting on top and the cables to the 
right. 

Yellow
Connector
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10. Push the cables into the opening in the component panel.

11. Align the top of the suppressor 
with the guide line printed on the 
component panel (see 
Figure 5-18) and align the slots 
on the rear of the suppressor 
with the tabs on the panel.

12. Press the suppressor onto the 
tabs and then slide it down until 
it locks into place. Pull slightly 
on the center of the suppressor to 
verify that it is securely fastened. 
Note: Some suppressors require 
more force to secure them onto 
the tabs.

13. Connect the two eluent and two 
regenerant lines to the new 
suppressor.

14. Close the ICS-1500 front door.

Figure 5-18.  Suppressor Guidelines and Mounting 
Tabs on Component Panel

5.11 Replacing the Column Heater

1. Turn off the ICS-1500 power.

2. Open the front door of the ICS-1500.

3. Follow the steps below to remove the existing column heater:

a. Unscrew the two thumbscrews on the heater cover (they remain attached 
to the cover).

b. Pull the heater cover straight out to remove it.
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c. Unscrew the six thumbscrews on the top metal plate (see Figure 5-19) and 
remove the plate.

Figure 5-19.  ICS-1500 Column Heater Cover Removed

d. Remove the columns from the column heater.

e. Pull the column heater straight toward you to remove it from the 
component panel.

4. Before installing the new column heater, write down the two calibration 
values (offset and slope) recorded on the back of the heater. 

5. Align the connector on the back of the new column heater (P/N 058060) with 
the connector on the component panel and push the column heater onto the 
component panel.

6. Remove the heater cover and the metal plate on the new heater.

7. Install the columns in the new heater and replace the top metal plate and 
heater cover.

8. Turn on the ICS-1500 power.

Thumbscrews (6) 
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9. Enter the column heater calibration values in Chromeleon or on the ICS-1500 
touch screen DIAGNOSTIC page as follows.

To enter the calibration values in Chromeleon:

a. Open the Wellness Panel (see Section 5.1.1) and click Calibration 
Details.

b. Under Column Heater Calibration Values, enter the Column Heater 
Offset and Column Heater Slope values recorded in Step 4.

c. In the field next to the Download button, verify that Current is selected 
and then click Download to download the new calibration values to the 
ICS-1500.

d. To ensure the new calibration values are recorded in the ICS-1500 
memory, do not turn off the ICS-1500 power for at least 1 minute after 
downloading the values. 

To enter the calibration values on the ICS-1500 touch screen DIAGNOSTIC 
page:

a. Go to the DIAGNOSTIC page and touch Column Heater Cal Values.

b. On the COLUMN HEATER CAL VALUES page (see Figure 5-20), enter the 
Calibrated Offset and Calibrated Slope values recorded in Step 4. 

Figure 5-20.  Column Heater Cal Values Page
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c. To ensure the calibration values are recorded in the ICS-1500 memory, do 
not turn off the ICS-1500 power for at least 1 minute after entering the 
values. 

d. Record the calibration values in the Chromeleon Wellness database. To do 
this, open the Wellness Panel (see Section 5.1.1) and click Upload under 
Update Wellness Database.

5.12 Replacing the Column Heater Heat Exchanger

1. Turn off the ICS-1500 
power.

2. Open the front door of the 
ICS-1500.

3. Unscrew the two 
thumbscrews on the column 
heater cover (they remain 
attached to the cover).

4. Pull the heater cover straight 
out to remove it.

5. Unscrew the six 
thumbscrews on the top 
metal plate (see Figure 5-21) 
and remove the plate.

6. Disconnect the heat 
exchanger inlet line from 
Port C on the injection 
valve.

Figure 5-21.  ICS-1500 Column Heater Cover Removed

7. Disconnect the heat exchanger outlet line from the guard column inlet.

8. Use an Allen wrench to remove the three screws from the heat exchanger 
metal plate and remove the plate (with the tubing) from the heater.

9. Remove the plastic backing from the new heat exchanger (P/N 059979, with   
0.25-mm (0.010-in) ID tubing; P/N 060943, with 0.125-mm (0.005-in) ID 

Thumbscrews (6) 
Heat 

Exchanger
Screws (3) 
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tubing) and press the heat exchanger onto the heater. Replace the screws 
removed in Step 8.

10. Connect the new heat exchanger inlet line to Port C on the injection valve and 
connect the outlet line to the guard column inlet.

11. Reinstall the top metal plate and the heater cover.

5.13 Replacing the Eluent Valve

1. Turn off the power to the ICS-1500.

2. Open the ICS-1500 front door.

3. To prevent an eluent leak during the valve replacement procedure, disconnect 
the eluent line from the reservoir cap. Or, plug the line on the left side of the 
valve with a union (P/N 039056 and a plug (P/N 037268) after disconnecting 
the liquid line from the valve (see Step 4).

4. Disconnect the two liquid 
lines connected to the 
eluent valve (see 
Figure 5-22).

5. Unscrew and remove the 
two screws that attach the 
valve to the component 
panel (see Figure 5-22). 
Save the screws.

Figure 5-22.  Eluent Valve

Disconnect

Remove
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6. Pull the valve straight out 
from the component panel and 
begin pulling the attached 
cable out of the opening in the 
panel.

7. The cable is connected to a 
matching cable inside the ICS-
1500. Continue pulling until 
the connectors for the two 
cables are outside the panel 
(see Figure 5-23). Disconnect 
the cables.

Figure 5-23.  Eluent Valve Cable

8. Remove the mounting plate on 
the old valve by unscrewing 
and removing the two screws. 
Save the screws. 

9. Thread the cable from the new 
eluent valve through the 
mounting plate.

10. Attach the mounting plate to 
the new valve using the 
screws removed in Step 8.

Figure 5-24.  Removing the Valve Mounting Plate

11. Connect the cable from the new valve (P/N 057945) to the ICS-1500 cable. 
Feed the cables back inside the ICS-1500.

12. Align the new valve on the component panel with the liquid ports facing up 
and attach it with the two screws removed in Step 5. Reconnect the liquid 
lines.

13. Turn on the power to the ICS-1500.

14. Prime the pump (see Section B.14).

Disconnect
Cables

Eluent Valve
Cable

Remove
Screws
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5.14 Replacing the Leak Sensor

1. Turn off the power to the ICS-
1500.

2. Open the ICS-1500 front door.

3. Loosen the screw on the front of 
the leak sensor (see 
Figure 5-25). Note: The screw 
remains attached to the sensor.

Figure 5-25.  Leak Sensor

4. Remove the leak sensor from 
the component panel and pull 
the cable out of the opening in 
the panel.

5. The cable attached to the leak 
sensor is connected to a 
matching cable inside the ICS-
1500. Continue pulling the cable 
until the connectors for the two 
cables are outside of the panel 
(see Figure 5-26).

6. Disconnect the two cables.

Figure 5-26.  Leak Sensor Cable

7. Connect the cable from the new leak sensor (P/N 058053) to the ICS-1500 
cable. 

8. Feed the cables back inside the ICS-1500. Align the leak sensor with the 
component panel opening and fingertighten the screw.

9. Make sure the leak sensor does not touch the bottom of the drip tray.

Leak
Sensor

Loosen
Screw

Disconnect 
Cables
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5.15 Priming the Pump with Isopropyl Alcohol

NOTE Prime the pump heads with isopropyl alcohol only if the
two standard priming procedures described in
Section B.14 are unsuccessful.

1. Connect a 10-mL syringe 
(P/N 054578) filled with 
isopropyl alcohol (IPA) to 
the port in the primary 
pump head (see 
Figure 5-27).

2. Open the waste valve on 
the secondary pump head 
(see Figure 5-27) by 
turning the knob one-
quarter to one-half turn 
counterclockwise.

Figure 5-27.  Priming the Pump Heads with IPA

3. Click Pump On on the Chromeleon Control panel to turn on the pump motor.

4. Open the priming valve on the primary pump head by turning it one-quarter to 
one-half turn counterclockwise.

5. Use the syringe to slowly push alcohol through the pump.

NOTE Be careful not to push any air trapped in the syringe
through the pump. Check the waste line from the
secondary pump head to verify that there are no air
bubbles.

6. Close the priming valve. Do not overtighten. Disconnect the syringe from 
the priming valve. 

7. Let the pump run for several minutes, to purge alcohol from the pump heads, 
and then click Prime and flush the heads with the desired eluent.

10 mL Syringe
(P/N 054578)

Priming Valve 
(open)

Port

Waste Valve
(open)

Primary
Pump Head

Secondary
Pump Head
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8. Close the waste valve. Do not overtighten.

9. Select the flow rate required for the analysis. 

10. Click Pump Off to turn off the pump motor. The pump is now ready for 
operation.

5.16 Changing Main Power Fuses

1. Turn off the main power switch.

2. The fuse holder is part of the main power receptacle (see Figure 5-28) on the 
ICS-1500 rear panel. To remove the fuse holder, squeeze the tab on the top of 
the holder to release it and pull the holder straight out of its compartment.

Isopropyl alcohol may damage some columns. Be sure to thoroughly
rinse the alcohol from the pump, using the process described in
Step 7.

HIGH VOLTAGE—Disconnect the main power cord from its source and
also from the rear panel of the ICS-1500.

HAUTE TENSION—Débranchez le cordon d'alimentation principal de
sa source et du panneau arrière du ICS-1500.

HOCHSPANNUNG—Ziehen Sie das Netzkabel aus der Steckdose und
der Netzbuchse auf der Rückseite des ICS-1500.

Figure 5-28.  Main Power Fuse Holder
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3. Replace the two fuses in the holder with new IEC 127 fast-blow fuses rated 
3.15 amps (P/N 954745). Dionex recommends always replacing both fuses.

4. Reinsert the fuse holder into its compartment and push in until the tab clicks 
in place.

5. Reconnect the main power cord and turn on the power.
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A • Specifications

A.1 Electrical

A.2 Physical

A.3 Environmental

Main Power 85 to 265 Vac, 47 to 63 Hz. The ICS-1500 power supply is auto-
sensing and requires no voltage adjustment

 Fuses Two 3.15 amp fast-blow IEC 127 fuses (P/N 954745) 

Dimensions
(without

reservoir)

Height: 56.1 cm (22.1 in)
Width: 22.4 cm (8.8 in)
Depth: 53.3 cm (21.0 in)

Weight 30 kg (66 lb)

Decibel Level < 52 dbA

 Operating
Temperature

4 to 40 °C (40 to 104 °F)

Humidity 5 to 95% relative humidity, noncondensing

Operating
Pressure

35 MPa (5000 psi) maximum liquid path (tubing, valve, columns, 
etc.)
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A.4 Front Panel

A.5 Pump

Power LED On when power is present; off when no power is present

LCD Touch
Screen

¼ VGA (320 x 240 pixels) liquid crystal display with touch screen, 
which provides:

• Local control of ICS-1500 components: pump, detector, 
suppressor, injection valve, column heater, vacuum degas, 
TTLs, and relays

• Display of conductivity data plot and operating status

• Local control of calibration and diagnostic functions

Type Dual-piston (in series), variable speed, 100 µL per revolution

Flow Rate Settable range: 0.00 to 5.00 mL/min, in 0.01 increments
Optimal Operational Range: 0.40 to 2.0 mL/min

Flow Accuracy <1% of set value within the optimal operational range

Flow Precision <0.2%

Operating
Pressure

35 MPa (5000 psi), maximum

High Pressure
Limit

0.7 to 34.4 MPa (100 to 5000 psi)

Low Pressure
Limit

0.0 to 33.7 MPa (0 to 4900 psi)

Delay Volume <800 µL

Pressure Ripple <1% at 13.8 MPa (2000 psi) and 1.0 mL/min
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A.6 Detector

A.7 Conductivity Cell with Heat Exchanger

A.8 Injection Valve

A.9 Vacuum Degas Assembly (Optional) 

Range 0 to 15000 µS (digital output)

Temperature
Compensation

1.7% per °C

Cell Drive 8 kH square wave

Linearity Correlation >0.999
%RSD <5% to 800 µS

Cell Body PEEK

Electrodes Passivated 316 stainless steel

Active Volume 1.0 µL

Operating
Temperature

30 to 55 °C (86 to 130 °F); must be at least 7 °C above the ambient 
temperature

Maximum
Pressure

2 MPa (300 psi)

Injection Valve Two-position, six-port, electrically-activated valve with PEEK 
wetted components

Channel Single-channel degas channel with degas membranes

Pump Dual-stage diaphragm vacuum pump

Materials Wetted materials, PEEK, PTFE
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A.10 Column Heater  

Operating
Temperature

30 to 60 °C (86 to 140 °F); must be at least 5 °C above the ambient 
temperature
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B • Installation

This chapter provides instructions for the initial installation of the ICS-1500 Ion 
Chromatography System. 

NOTE These installation instructions are also shipped with the
ICS-1500 as a stand-alone printed manual (Document
No. 031916).

NOTE The order of the steps is important. It is especially
important to install Chromeleon before connecting the
USB cable and turning on the ICS-1500 power.

B.1 Facility Requirements

• Make sure the ICS-1500 installation site meets the power and environmental 
specifications listed in Appendix A.

• Provide a sturdy workbench for the ICS-1500 of a height that ensures 
convenient access to the interior of the ICS-1500.

• Allow at least 15 cm (6 in) behind the ICS-1500 for power connections and 
ventilation. For optimal performance, install the ICS-1500 in a draft-free 
location, out of the path of air conditioning and heating vents.

• (Optional) Provide a clean gas source regulated to between 0.55 and 
0.83 MPa (80 and 120 psi) for pressurization of the eluent reservoir.

• Use ASTM filtered, Type I (18-megohm) deionized water when preparing 
eluent and regenerant.
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B.2 Unpacking the ICS-1500 System

1. After removing the ICS-1500 from the shipping box and removing the top 
layer of foam, remove the next layer of foam (see Figure B-1).

Figure B-1. ICS-1500 After Removing Shipping Box and First Layer of Foam

2. Set the eluent bottle on top of the ICS-1500 (see Figure B-2).

Figure B-2. ICS-1500 with Eluent Bottle

 (Remove this foam)

Eluent 
Bottle
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3. Remove the next layer of foam and remove the Ship Kit box (see Figure B-3).

Figure B-3. ICS-1500 with Ship Kit

4. The bottom foam layer has two cutouts on either side of the ICS-1500 
module; use these as handholds when lifting the module (see Figure B-3). 

5. Lift the ICS-1500 out of the bottom layer of foam and set it on a workbench. 
Inspect the ICS-1500 for any shipping damage.

Two or more persons should lift the ICS-1500, which weighs 30 kg
(66 lb). Lift the ICS-1500 only from each side of the cabinet bottom.
Lifting from the front door will damage the door hinges.

Au moins deux personnes peuvent soulever le ICS-1500:  il pèse 30 kg
(66  lb). Ne soulevez le ICS-1500 que par chaque côté du fond de
l'armoire. Son soulèvement par la porte du panneau avant
endommagera les charnières de la porte.

Der ICS-1500 wiegt über 20 kg. Daher sollte das Gerät nur von zwei
oder mehr Personen angehoben werden. Greifen Sie dazu an beiden
Seiten unter das Gerät. Heben Sie den Autosampler nicht an der
Vordertür an, da dadurch die Türangeln beschädigt werden könnten.
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B.2.1 Unpacking the Computer (North America only)

NOTE These instructions assume that Chromeleon
software was installed on the computer before
shipping. 

1. Remove the central processing unit (CPU), keyboard, mouse, and all 
documentation from the computer box and place these items on a 
workbench.

2. Remove the monitor from its box and place it on the workbench.

3. Follow the instructions in the computer installation guide to hook up 
the monitor, mouse, keyboard, and CPU.

4. Go on to Section B.4, “Installing the Chromeleon Software License.”

B.2.2 Unpacking the Computer (outside North America)

1. Refer to Installing the Chromeleon IC System (Document No. 
031883) to verify that the computer being used meets Chromeleon 
specifications. The manual is on the Dionex Reference Library CD-
ROM (P/N 053891).

2. Remove the central processing unit (CPU), keyboard, mouse, and all 
documentation from the computer box and place these items on a 
workbench.

3. Remove the monitor from its box and place it on the workbench.

4. Follow the instructions in the computer installation guide to hook up 
the monitor, mouse, keyboard, and CPU.

5. If Chromeleon is not installed on the computer, go on to Section B.3, 
“Installing Chromeleon.”

6. If Chromeleon is already installed on the computer, go on to 
Section B.4, “Installing the Chromeleon Software License.”
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B.3 Installing Chromeleon

NOTES
• Windows® 2000 or Windows XP is required for controlling the ICS-1500 

with Chromeleon. Chromeleon version 6.5 SP2 or later is required.

• To install Chromeleon, you must log onto Windows 2000 or XP with 
administrator privileges. Administrator privileges are not required to 
run Chromeleon.

1. Turn on the computer power.

2. Follow the Windows setup steps as they appear on the screen.

3. Verify that the monitor display is set to a minimum of 1024 x 768 with 16 bit 
color.

4. Insert the Chromeleon CD-ROM into the CD-ROM drive.

5. The Chromeleon Setup menu appears.

6. If the Setup menu does not appear automatically, go to the Autorun folder on 
the Chromeleon CD-ROM and double-click autorun.exe.

7. Select Launch Chromeleon Setup.

8. Setup now guides you through the installation procedure; follow the on-
screen instructions as they appear. 

9. When prompted, select whether to add the Chromeleon Server Monitor to the 
Startup group. If you select yes, the Server Monitor starts automatically when 
the computer is started, and the program icon appears in the taskbar.

10. When complete, go on to Section B.4, “Installing the Chromeleon Software 
License.” 



ICS-1500 Ion Chromatography System

B-6 Doc. 031917-02 9/05

B.4 Installing the Chromeleon Software License

For the Chromeleon computer to control the ICS-1500, a valid software license 
must be installed. To install the license, you first install a dongle on the computer 
and then enter a license “Key Code” in Chromeleon. (A dongle is an adapter that 
is connected to the parallel PC interface or USB port. The dongle stores the serial 
number of a Chromeleon computer.)

NOTE If the software license is managed via a License
Server, a dongle is not required. 

1. Plug the dongle into the appropriate port on the computer (either the parallel 
or USB port, depending on the type of dongle). Tighten the connector screws 
on a parallel port dongle.

2. If it is not already running, start the Chromeleon Server Monitor (select 
Start>Programs>Chromeleon>Server Monitor). The Server Monitor 
window opens. 

IMPORTANT
Installing DX-LAN Devices
If you will also be installing a module that requires a DX-LAN interface 
connection, verify that the following steps are completed before continuing:

1. If it is not already installed, install the DX-LAN card in the module. Refer 
to the operator’s manual for the module for installation instructions.

2. Install the DX-LAN card in the computer.

3. Connect the module to the DX-LAN.

4. Install the DX-LAN card driver.

Instructions for Steps 2 through 4 are in Installing the Chromeleon 
Chromatography Management System with a Dionex Ion Chromatograph (IC) 
(Document No. 031883).
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3. Check the server status:

• If “Chromeleon Server is running idle” is displayed, the license Key Code 
was entered before shipping the computer, and you can omit the 
remaining steps in this section. Click Close and go on to Section B.5.

• If “Chromeleon Server is running idle (Evaluation Mode)” is displayed 
(see Figure B-4), the license Key Code has not yet been entered. If this is 
the case, go on to Step 4.

Figure B-4. Server Evaluation Mode

4. Open Chromeleon (select Start>Programs>Chromeleon>Chromeleon).
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5. Select File>Preferences to open the Preferences dialog box (see Figure B-5). 
Select the License tab and click Dongle. Enter the Key Code exactly as it 
appears on the Chromeleon Software License key code sheet. Click OK.

Figure B-5. Preferences: License Page

6. Check the Server Monitor status. It should now display “Chromeleon Server 
is running idle.” (see Figure B-6).

Figure B-6. Server Running

7. Click Close to close the Server Monitor window.

8. Go on to Section B.5.
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B.5 Connecting the ICS-1500 to the Chromeleon PC

The ICS-1500 rear panel provides a USB receptacle for connecting the ICS-1500 
to a USB port on the Chromeleon PC. The rear panel also provides two USB ports 
for connecting other Dionex USB-compliant modules to the system.

B.5.1 Connecting the ICS-1500 to the PC

1. Locate the USB cable (P/N 960779) in the ICS-1500 Ship Kit 
(P/N 057905).

2. Plug the cable’s “A” connector into a USB port on the Chromeleon 
PC and plug the cable’s “B” connector into the USB receptacle 
(labeled FROM PC) on the ICS-1500 rear panel (see Figure B-7).

Do not turn on the power to the ICS-1500 or other USB module(s) until
after you connect the USB cable.

Before connecting the USB cable, verify that Chromeleon is installed.
If not, Windows will be unable to identify the new USB device when
the power is turned on. See Section B.3 to install Chromeleon. 

Figure B-7. Example Connections: One ICS-1500 Connected to the Computer

ICS-1500

USB Cable A

B

Plug the “B”
into the FROM PC 

receptacle on the ICS-1500.

USB cable’s 
connector 

Plug the “A”
into USB 

port on the Chromeleon PC.

USB cable’s 
connector the 

Chromeleon PC

FROM PC USB receptacle 
on the ICS-1500 rear panel
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B.5.2 Connecting Additional USB Devices

The ICS-1500 provides two USB ports for connecting additional Dionex 
USB-compliant modules to the system.

To connect an additional USB module, plug the “A” connector on a USB 
cable into an “A” port (labeled TO MODULE) on the ICS-1500 rear panel 
and plug the cable’s “B” connector into the USB receptacle on the USB 
module (see Figure B-8).

NOTE If the number of USB devices in the system exceeds the
number of available USB ports, connect the devices to
the system with a USB-compliant, full-speed external
hub. One or more hubs is also required if the ICS-1500
or other USB device is more than 5 meters (16 ft) from
the PC. Refer to the manual provided by the hub vendor
for complete installation instructions. 

Figure B-8. Example Connections: Two Dionex USB Modules 
Connected to the ICS-1500

The USB standard limits the USB cable length to 5 meters (16 ft). Each
USB device can be separated from the PC by no more than five hubs.
Thus, each USB device can be located no more than 30 meters
(32 yds) from the PC.
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B.6 Connecting the Power Cord

Connect the power cord (IEC 320 C13) (ordered separately) from the main power 
receptacle on the rear panel to a grounded power source. The ICS-1500 power 
supply is auto-sensing, so no adjustment is required to select the line voltage.

SHOCK HAZARD—To avoid electrical shock, use a grounded
receptacle. Do not operate the ICS-1500 or connect it to AC power
mains without an earthed ground connection.

The power supply cord is used as the main disconnect device. Make
sure the socket-outlet is located near the ICS-1500 and is easily
accessible. 

Operation at AC input levels outside of the specified operating voltage
range may damage the ICS-1500.

DANGER D'ÉLECTROCUTION—Pour éviter toute électrocution, il faut
utiliser une prise de courant avec prise de terre. Ne l'utilisez pas et ne
le branchez pas au secteur C.A. sans utiliser de branchement mis à la
terre.

Le cordon d'alimentation principal est utilisé comme dispositif
principal de débranchement. Veillez à ce que la prise de base soit
située/installée près du module et facilement accessible.

STROMSCHLAGGEFAHR—Zur Vermeidung von elektrischen
Schlägen ist eine geerdete Steckdose zu verwenden. Das Gerät darf
nicht ohne Erdung betrieben bzw. an Wechselstrom angeschlossen
werden.
Das Netzkabel ist das wichtigste Mittel zur Stromunterbrechung.
Stellen Sie sicher, daß sich die Steckdose nahe am Gerät befindet und
leicht zugänglich ist.
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B.7 Turning On the ICS-1500 Power

1. If it is not already on, turn 
on the computer power and 
log onto Windows 2000 or 
Windows XP as an 
administrator.

2. If the Chromeleon Server is 
not running (the icon on the 
taskbar is crossed out in red 

), start the Server by 
right-clicking the icon and 
selecting Start Server. 
When the server starts, the 

icon changes to gray . 

3. Press the power switch on 
the ICS-1500 rear panel (see 
Figure B-9) to turn on the 
power. 

Figure B-9. ICS-1500 Rear Panel

4. Windows automatically detects the new USB device. A message flashes on 
the screen to inform you that new hardware was found. 

Before turning on the ICS-1500 power, verify that Chromeleon
software is installed. See Section B.3 for installation instructions. If
Chromeleon is not installed first, Windows will be unable to identify
the new USB device.

Power
Switch
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5. The Found New Hardware Wizard appears. This wizard installs the ICS-1500 
device into the Windows Device Manager. Complete the wizard by selecting 
the following options:

• If asked whether Windows can connect to Windows Update to search for 
software, select No, not this time.

• It is not necessary to insert a hardware installation CD or floppy disk. 
When asked, simply select the Install the software automatically 
(Recommended) option (see Figure B-10). 

• After you click Next, Windows installs the software.

• When the wizard finishes installing the software, click Finish.

6. Go on to Section B.8.

Figure B-10. Windows Found New Hardware Wizard
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B.8 Setting Up Chromeleon

NOTE This section provides brief instructions for setting up
Chromeleon. For details about any of these steps, refer
to the Chromeleon user’s guide or online Help.

B.8.1 Assigning the ICS-1500 to a Timebase

After the ICS-1500 power is turned on and the Windows Found New 
Hardware Wizard is finished, the Chromeleon USB Auto Configuration 
Wizard automatically appears. The wizard presents two options (see 
Figure B-11):

Figure B-11. Chromeleon USB Auto 
Configuration Wizard: Page 1
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To create a new timebase:

1. Select the Create a new timebase option and click OK.

Page 2 of the wizard appears (see Figure B-12).

Figure B-12. Chromeleon USB Auto Configuration Wizard: Page 2

2. Review the names displayed in the Unassigned USB Devices 
Detected window. If the list includes the name of a device that you do 
not want to configure now, clear the check mark before the device 
name.

If you are installing more than one ICS-1500, you can verify the serial 
numbers for each by checking the label on the component panel. The 
serial number is also shown on the INFORMATION touch screen page. 
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3. In the Mode window, select a pre-defined configuration template for 
the new timebase. Typically for the ICS-1500, one configuration is 
available: Single (1 timebase with single system but no sharing 
device). The Description box lists the devices included in the mode. 
Devices in brackets are optional.

4. Select the Launch Server Configuration upon closing this wizard 
check box.

The check box is disabled if the Server Configuration program is 
already running.

5. Click Accept to create a new timebase. 

The Server Configuration automatically starts running when you 
close the wizard. If the Server Configuration was already running, it 
is updated with the new configuration information.

To add an unassigned USB device to an existing timebase: 

1. In the Chromeleon USB Auto Configuration Wizard, select the Add 
device to an existing timebase option and click OK.

This launches the Server Configuration program. 

2. Select an existing timebase to which the ICS-1500 can be assigned.

3. When you finish making changes here, click OK to close the dialog 
box.

The Server Configuration program window appears.



Setting Up Chromeleon

Doc. 031917-02 9/05 B-17

To verify the configuration:

1. In the Server Configuration program, click the + icon next to the 
server name to expand the folder. The timebase you created is 
displayed (see Figure B-13).

Figure B-13. Server Configuration with ICS-1500 Timebase

2. To verify that the ICS-1500 is correctly connected to the timebase, 
double-click its name under the timebase. Click Yes if the following 
message appears: “Communication to the device will be stopped…Do 
you want to continue?”
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3. The ICS-1500 System dialog box opens (see Figure B-14). The 
General page shows the Device Name (Pump_ECD), the Mode 
(Live), and the Module Serial No. 

Figure B-14. ICS-1500 System Properties

4. Close the dialog box and then save the configuration (select 
File>Save Installation).

5. If you are going to add one or more DX-LAN devices to the timebase, 
go on to Section B.8.2. Otherwise, exit the Server Configuration 
program and then go on to Section B.9.
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B.8.2 Assigning DX-LAN Devices to the Timebase (Optional)

Follow the instructions in this section if you are adding one or more 
devices to the timebase that are connected to the PC through a DX-LAN 
interface (not through USB connections).

1. Follow the instructions in Installing the Chromeleon 
Chromatography Management System with a Dionex Ion 
Chromatography (IC) (Document No. 031883) to add the DX-LAN 
card to the server configuration as a sharable device.

2. Select the timebase that was created for the ICS-1500 (see 

Figure B-15); then, click the Add device icon  on the toolbar (or 
select Edit>Add Device).

Figure B-15. Example: ICS-1500 Timebase

The Add device to timebase dialog box appears.
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3. Under Manufacturers, select Dionex: IC Modules and then select 
the device from the Devices list. 

Figure B-16. Add Device to Timebase Dialog Box

4. Click OK. A configuration properties dialog box for the device 
appears. Figure B-17 shows an example of the properties for an AS50 
Autosampler.

Figure B-17. AS50 Configuration Properties
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5. On the General tab page, clear the Demo Mode check box if it is 
currently selected, and then select the DX-LAN Device ID number. 
Note: Devices display their DX-LAN ID numbers when their power 
is turned on.

6. Click OK to close the dialog box. 

7. Save the configuration (select File>Save Installation). 

8. Exit the Server Configuration program.

9. Go on to Section B.9.
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B.9 Installing and Plumbing the Columns and Suppressor

NOTE This section provides brief installation and plumbing
instructions for the columns and suppressor. Before
beginning the installation, refer to the column and
suppressor manuals for detailed start-up and
installation instructions. The manuals are provided on
the Dionex Reference Library CD-ROM (P/N 053891).

Before beginning:

• Remove the guard column, separator column, and suppressor from their 
boxes. 

• Remove the fitting plugs from the ends of each column and from all ports on 
the suppressor. 

• Discard any tubing temporarily connecting the suppressor ports.

B.9.1 Setting Up the Column Heater 

1. Cut off the two 
shipping ties from 
the column heater 
and remove them 
(see Figure B-18).

2. Loosen the two 
thumbscrews on 
the heater cover 
(they remain 
attached to the 
cover).

3. Pull the heater 
cover straight out 
to remove it.

Figure B-18. ICS-1500 Column Heater Setup

Thumbscrew (2)

Shipping Tie (2)
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4. Unscrew the six 
thumbscrews on the 
top metal plate (see 
Figure B-19) and 
remove the plate.

5. Go on to 
Section B.9.2.

Figure B-19. ICS-1500 Column Heater Cover Removed

B.9.2 Installing the Columns

1. Remove the union connecting GUARD IN and GUARD OUT.

2. Connect GUARD IN to the guard column inlet. Check the arrow on the 
column label; it should point down (flow away from the injection 
valve).

3. Connect GUARD OUT to the guard column outlet.

4. Push the guard column onto the back column clip.

5. Remove the union connecting COL IN and COL OUT. 

6. Connect COL IN to the separator column inlet. Connect COL OUT to 
the separator column outlet. Check the arrow on the column label. It 
should point up (flow toward the cell).

7. Push the separator column onto the front column clips.

8. Replace the top metal plate on the column heater.

Thumbscrew (6) 
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B.9.3 Installing the Suppressor

1. Locate the suppressor 
mounting tabs on the 
component panel (see 
Figure B-20). Reach 
into the opening 
between the tabs and 
pull the yellow 
connector and attached 
cable slightly out of the 
opening.

2. Connect this cable to the 
cable from the 
suppressor (align the 
pins on the two 
connectors and push 
them together).

Figure B-20. Suppressor Mounting Tabs 
and Guidelines

3. Orient the suppressor with the REGEN OUT fitting on top and the 
cable to the right. 

4. Feed the cable into the opening in the component panel.

5. Align the top of the suppressor with the guideline printed on the 
component panel (see Figure B-20) and align the slots on the rear of 
the suppressor with the tabs on the panel.
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6. Press the suppressor onto the tabs 
and then slide it down to lock it in 
place. Pull slightly on the center of 
the suppressor to verify that it is 
securely fastened. Figure B-21 
shows an SRS suppressor installed 
on the component panel.

7. Remove the union connecting 
ELUENT IN and ELUENT OUT and 
connect these lines to the 
corresponding ports on the 
suppressor.

Figure B-21. Suppressor Installed 
(SRS Shown)

8. Remove the fitting plug from REGEN IN and connect it to the REGEN 
IN port on the suppressor. Connect the TO SRS/AES REGEN OUT line 
to the REGEN OUT port on the suppressor.

9. Replace the cover on the column heater, making sure the GUARD IN 
line is aligned with the slot on the side of the heater cover. 

10. Go on to Section B.10.
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B.10 Connecting the Waste Lines

The ICS-1500 has the following waste lines:

• PUMP WASTE carries prime waste from the pump. 

• TO WASTE OUT carries sample overflow from the injection valve. 

• WASTE, GAS SEPARATOR carries system waste from the suppressor.

1. Untape the coiled waste lines from the rear panel. Place the ends of the PUMP 
WASTE and TO WASTE OUT lines into a waste container. 

2. Direct the WASTE, GAS SEPARATOR line from the top of the ICS-1500 to the 
rear panel. Snap the line onto one of the tubing clips on the rear panel. 
Connect the line to the gas separator waste tube (see Section B.10.1).

NOTE To prevent waste from siphoning back into the system,
check the lines periodically to be sure they are not bent,
pinched, or elevated at any point.

B.10.1 Installing the Gas Separator Waste Tube

1. Locate the gas 
separator waste tube 
assembly in the ICS-
1500 Ship Kit 
(P/N 057905). 

2. Connect the WASTE, 
GAS SEPARATOR 
line from the 
suppressor to one of 
the 3-mm (1/8-in) ID 
white Teflon lines on 
the gas separator 
waste tube assembly 
(see Figure B-22).

Figure B-22. Gas Separator Waste Tube Installation

3. Place the gas separator waste tube assembly into the waste container. 
Make sure the tubing junction (where the white Teflon tubing meets 
the black polyethylene tubing) is above the top of the container and 

Gas Separator
Waste Tube
Assembly

Waste

Waste, Gas
Separator Line

(from the suppressor)

This line is 
provided for a 
second system
if needed.

Open to 
the air
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that the gas separator waste tube and the waste container are open to 
the atmosphere.

4. Go on to Section B.11.

DO NOT CAP THE WASTE CONTAINER: The ICS-1500, Atlas
Electrolytic Suppressor, and Self-Regenerating Suppressor (SRS) use
an electrolytic process that results in the production of small amounts
of oxygen or hydrogen gas. To ensure that the gas is not trapped in a
closed container and allowed to concentrate, install a 1.3-cm (0.52-in)
ID black gas separator waste tube (P/N 045460) in an uncapped waste
container. Connect the Waste, Gas Separator line to the waste tube
(see Figure B-22).

NE FERMEZ PAS LE CONTENEUR DE GAZ RÉSIDUEL: Le ICS-1500, le
Atlas Electrolytic Suppressor, et le Self-Regenerating Suppressor
(SRS) travaillent avec un proces d´électrolyse, qui produit des petites
quantités de gaz d´oxygène ou d´hydrogène. Afin de garantir que le
gaz ne soit pas enfermé dans un conteneur fermé et puisse s´y
concentrer, connectez un tube noir à gaz résiduel (diamètre intérieur =
1,3 cm; n° de commande 045460) à un conteneur ouvert (non fermé).
Connectez le conteneur résiduel au tube résiduel/gaz séparateur
(désigné: « Waste, Gas Separator»). 

VERSCHLIESSEN SIE DEN ABFALLBEHÄLTER NICHT: Der ICS-1500,
Atlas Electrolytic Suppressor und Self-Regenerating Suppressor
(SRS) verwenden einen Elektrolyseprozess, wodurch kleine Mengen
an Sauerstoff und Wasserstoff entstehen. Führen Sie einen
schwarzen Gasabscheiderschlauch (ID = 1,3 cm; Bestell-Nr. 045460) in
einen offenen (unverschlossenen) Abfallbehälter, damit sich das Gas
nicht in einem geschlossenen Behälter sammelt und aufkonzentriert.
Verbinden Sie die mit Waste, Gas Separator bezeichnete Leitung mit
dem Abfallschlauch.



ICS-1500 Ion Chromatography System

B-28 Doc. 031917-02 9/05

B.11 Setting Up the Eluent Reservoir

1. Rinse the eluent reservoir.

2. Prepare the eluent as instructed in the manual for the column being installed. 
The column manual is included on the Dionex Reference Library CD-ROM 
(P/N 053891).

3. Fill the reservoir with the prepared eluent.

4. Place the reservoir on top of the ICS-1500.

5. Install the cap and handtighten.

NOTE The ICS-1500 does not require pressurized reservoirs.
However, if eluent is manually degassed or is sensitive to
contamination, Dionex recommends pressurizing the
reservoir with helium or nitrogen. See Section B.20 for
instructions.

6. Go on to Section B.12.
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B.12  Setting Up a Chromeleon Application

Chromeleon provides application templates, which you can use to quickly get 
started running. To use the application templates, you need to know the type of 
column and suppressor you will be using. This section shows how to create a list 
of samples to be processed (a sequence) and how to use an application template.

1. Identify the type of column and suppressor installed in the ICS-1500.

2. Start Chromeleon (select Start>Programs>Chromeleon>Chromeleon). 
The Chromeleon main window and Browser appear (see Figure B-23).

Figure B-23. Chromeleon Main Window and Browser

NOTE As an alternative to the Sequence Wizard and
application templates described here, Chromeleon also
includes an Application Wizard, which can be used to
set up an application and create a sequence. To start the
Application Wizard, go to the Browser and select
Tools>Application Wizard. The wizard guides you
through the application and sequence setup process.
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3. In the Browser, select File>New and select Sequence (using Wizard) (see 
Figure B-24).

Figure B-24. Creating a New Sequence

The Sequence Wizard Welcome page appears (see Figure B-25).

Figure B-25. Sequence Wizard Welcome Page



Setting Up a Chromeleon Application

Doc. 031917-02 9/05 B-31

NOTE For details about a Sequence Wizard step, click the Help
button on the Sequence Wizard page.

4. Click Next>.

The Sequence Wizard Timebase page appears (see Figure B-26). 

Figure B-26. Example: Sequence Wizard Step 1 

5. Select the ICS-1500 timebase and click Next>.
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The Unknown Samples page appears (see Figure B-27). 

Figure B-27. Example: Sequence Wizard Step 2 

6. Select Use Template from the drop-down list. 

7. In the Template for Sample Name field, type Sample, click the right arrow, 
and select Sample Number #n. 

8. In the Number of Vials field, type 1.

9. Use default settings for the remaining parameters on the page.

NOTE You can edit the sequence later, to add more samples
and select the injection parameters appropriate for your
application.
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10. Click Apply>>. 

Figure B-28 shows Sequence Wizard Step 2 after a sample is defined.

Figure B-28. Example: Sequence Wizard Step 2 with Sample Defined 

11. Click Next>. 
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The Standard Samples page appears (see Figure B-29). 

Figure B-29. Example Sequence Wizard Step 3 

12. Click Next> to omit this step and define standard injections later. Or, define 
one or more standard injections, and then click Next>. 

The Methods & Reporting page appears.
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13. Select the Use Application Template check box.

14. From the drop-down lists, select the type of suppressor to be installed and 
then select the column. 

In the example in Figure B-30, the 4-mm ASRS suppressor and AS17 column 
are selected.

Figure B-30. Example: Sequence Wizard Step 4 

15. To select a report template, click the Browse button, go to the Dionex 
Templates/Reports folder, and select a template (for example, default).

16. Click Next>. 

The Saving the Sequence page appears.
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17. Enter a name for the sequence and a location (see the example in 
Figure B-31). 

Figure B-31. Example: Sequence Wizard Step 5 

18. Click Finish> and then click Done on the last page of the Sequence Wizard.
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The Browser appears, displaying the sequence you created (see Figure B-32). 
Notice the three files in the top pane of the Browser window. 

Figure B-32. Example Browser with Open Sequence

• The .pgm file (program) contains commands and parameters for controlling 
the ICS-1500, controlling the autosampler (if used), and acquiring sample 
data. 

• The .qnt file (quantification method) contains peak identification and area 
determination parameters.

• The .pan file (Control panel) lets you control and/or monitor the ICS-1500 
and other modules that are connected to the timebase. 

NOTE The sequence that you create here is intended as a
starting point only. You can add additional samples to
the sequence, change injection parameters, and edit the
.pgm and .qnt files. Refer to the Chromeleon online Help
for details. 

NOTE After completing the installation, see Section 3.11 for
how to process the samples and standards in the
sequence. 



ICS-1500 Ion Chromatography System

B-38 Doc. 031917-02 9/05

19. Double-click the .pan file to open the Control panel for your system (see the 
example in Figure B-33).

Figure B-33. ICS-1500 System Control Panel Example

NOTE If the Connected check box is not selected, click the box
to connect the ICS-1500 to the Control panel.

B.12.1 Verifying Chromeleon Communication

Verify that Chromeleon is communicating with the ICS-1500 by clicking 
the Inject and then the Load button on the Control panel. If 
communication is occurring, you will hear the valve actuate as it changes 
position. Go on to Section B.13.
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B.13 Setting the Eluent Level

After filling the reservoir, open the touch screen HOME page and enter the volume 
of liquid in the reservoir in the Eluent Level field (see Figure B-34), or enter the 
volume in the Eluent Bottle field on the Chromeleon Control panel (see 
Figure B-35). The ICS-1500 determines the eluent usage, by monitoring the flow 
rate and the length of time the pump is on, and updates the field as the eluent is 
used up. A warning is displayed if the level falls below 200 mL. The warning is 
repeated at 100 mL and at 0 mL. 

In order for the eluent level displayed on the screen to be accurate,
the level must be entered by the user when the reservoir is filled. The
ICS-1500 does not automatically detect when the reservoir is filled,
nor when it is empty.

Figure B-34. Home Page: Setting the Eluent Level

Figure B-35. Chromeleon Control Panel: Setting the Eluent Level

Enter the volume of
liquid in the reservoir

Note: The Eluent Level 
field is updated as the 
liquid is used up.

Enter the volume of
liquid in the reservoir

Note: The Eluent Bottle 
field and slider gauge 
are updated as the 
liquid is used up.



ICS-1500 Ion Chromatography System

B-40 Doc. 031917-02 9/05

B.14 Priming the Pump

1. Verify that the eluent reservoir is filled, the reservoir cap is installed and hand 
tightened, and the liquid line from the ICS-1500 to the reservoir cap is 
connected (see Section B.11).

2. Verify that the waste lines are directed to a waste container.

3. The priming procedure consists of two parts:

• Priming the eluent lines with a syringe. Perform this procedure at initial 
installation, after changing eluents, or when eluent lines are empty.

• Priming the pump heads with the Prime button. Perform this procedure 
after the eluent lines are primed.

B.14.1 Priming the Eluent Lines with a Syringe 

NOTE Prime the eluent lines after initial installation, after
changing eluents, or when eluent lines are empty.

1. Verify that the pump is turned off.

2. Connect a 10 mL syringe (P/N 054578) to the port in the priming 
valve on the primary pump head (see Figure B-36). 

Figure B-36. Priming the Eluent Lines

10 mL Syringe
(P/N 054578)

Priming Valve 
(open)

Port

Waste Valve
(close)

Primary
Pump Head

Secondary
Pump Head
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3. Open the priming valve by turning it one-quarter to one-half turn 
counterclockwise.

4. On the Chromeleon Control Panel, click Pump Settings and then 
click Eluent Flow Valve Open (see Figure B-37).

Figure B-37. Chromeleon Control Panel: Pump Settings 

5. Draw the syringe back to begin pulling eluent through the flow path. 
It may take several syringe draws to remove all air or previous eluent 
from the tubing.

NOTE If the vacuum degas assembly is installed, draw
out an additional 20 mL of eluent.

6. After priming the lines thoroughly, close the priming valve. Do not 
overtighten the priming valve. 

7. Close the eluent valve (click Eluent Flow Valve Closed on the 
Control Panel).
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B.14.2 Priming with the Prime Button

NOTE Perform this procedure after priming the eluent
lines (see Section B.14.1).

1. Check that the priming valve on the primary pump head is closed (see 
Figure B-38).

2. Open the waste valve on the secondary pump head by turning the 
knob one-quarter to one-half turn counterclockwise (see 
Figure B-38). Opening the valve directs the eluent flow path to waste 
and eliminates backpressure.

3. Click Prime on the Chromeleon Control Panel (see Figure B-37). The 
pump will begin pumping at approximately 3 mL/min.

4. Continue priming the ICS-1500 until no air bubbles are exiting the 
pump waste line.

5. Press Pump Off.

6. Close the waste valve. Do not overtighten. The pump is now ready 
for operation.

NOTE If the two standard priming procedures described above
are unsuccessful, prime the pump with isopropyl
alcohol.See Section 5.15 for instructions. 

Figure B-38. Priming the Pump

Priming Valve

Waste Valve

Primary
Pump Head

Secondary
Pump Head

(open)

(close)
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B.15 Equilibrating the System

1. After priming the pump, turn on the pump and set the flow to the operating 
rate.

2. Flush the system for about 5 minutes to equilibrate.

3. Monitor the system pressure from the Chromeleon Control panel to make sure 
it is at the expected pressure for the installed column (refer to the column 
manual for details) and is stable. If the pressure is less than the expected 
amount, gas may be trapped in the system. Release the gas by removing the 
pump fitting on the injection valve. The fitting is labeled P (2). Allow the air 
to escape and then reconnect the fitting.

4. Check that liquid is flowing out of the suppressor REGEN OUT waste line and 
that the pressure is stable.

5. Monitor the baseline conductivity. In general, it should be <30 µS for a system 
set up for anion analyses, and <2 µS for a system set up for cation analyses. 
Equilibration time varies and it can take some time to reach these expected 
values.

B.16 Verifying Operational Status

After the system has equilibrated, verify the actual pump pressure and stability by 
monitoring the pump pressure reading on the Chromeleon Control panel (or the 
touch screen HOME page). Write down the short-term pressure fluctuations; they 
should be less than 0.13 MPa (20 psi).

This completes the ICS-1500 installation procedure. For routine operating 
instructions, refer to Chapter 3.
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B.17 Connecting an AS or AS50 (USB) Autosampler 
(Optional)

To use an AS or AS50 (USB) autosampler with the ICS-1500, the following 
requirements must be met:

• The ICS-1500 injection valve must be linked to the AS or AS50 (USB) in the 
Chromeleon timebase (see Section B.17.2)

• An injection valve should not be installed in the AS or AS50 (USB) (see the 
note below)

After the AS or AS50 (USB) is connected to the ICS-1500 and the valve is linked 
in Chromeleon, all autosampler injection valve commands will control the ICS-
1500 injection valve (whether issued from the AS or AS50 (USB) front panel or 
from Chromeleon). In addition, all AS or AS50 (USB) modes of injection (full-
loop, partial-loop, partial-loop limited-sample, and others) are supported.

NOTE Dionex recommends using AS or AS50 (USB) models
that do not have injection valves (see the list below). If a
valve is installed in the autosampler, it is switched at the
same time as the valve in the ICS-1500. This causes
unnecessary wear on the autosampler valve. If required,
the autosampler valve can be disconnected from the AS
or AS50 (USB) electronics. If you wish to do this, contact
Dionex for assistance. The AS or AS50 (USB) electronics
components cannot be serviced by the user. 

The following AS50 (USB) and AS models can be used with an ICS-1500:

Part 
Number

Autosampler 
Model

Injection 
Valve

Sample 
Preparation

Sample Tray 
Cooling

061130 AS50 (USB) No No Yes
061132 AS50 (USB) No Yes Yes
061134 AS50 (USB) No No No
061136 AS50 (USB) No Yes No
063102 AS No No No
063103 AS No Yes No
063106 AS No No Yes
063107 AS No Yes Yes
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NOTE The ICS-1500 and the AS or AS50 (USB) can be set up
for stand-alone (front-panel) operation. This requires a
TTL cable connection between the AS or AS50 (USB)
and the ICS-1500. See Section D.3 for stand-alone setup
instructions. 

B.17.1 AS or AS50 (USB) Connections

1. Place the autosampler to the left of the ICS-1500 on the workbench. 

2. Open the ICS-1500 and autosampler doors.

3. The needle seal line that extends from the inject port in the 
autosampler is coiled inside the autosampler door, on the right side. 
Route this line through the autosampler right side slot (see 
Figure B-39) and the ICS-1500 left side slot to the ICS-1500 
injection valve.

The needle seal line from the autosampler inject port to the ICS-1500
injection valve is calibrated for use with the ICS-1500. To ensure
injection precision, do not shorten (by cutting) or lengthen this line, or
replace it with a different (uncalibrated) line. 

Figure B-39. Autosampler Drip Tray

Insert the waste 
line from the ICS-
1500 injection 
valve here

Route autosampler 
needle seal line to 
ICS-1500 injection 
valve 
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4. Connect the needle seal line 
from the autosampler to 
port S (5) on the injection 
valve (see Figure B-40).

The green waste line that is 
connected to port W (6) on 
the injection valve (see 
Figure B-40) is connected 
with a union to a Teflon 
waste line (see 
Figure B-41) and routed 
through the tubing chase to 
the ICS-1500 rear panel.

Figure B-40. ICS-1500 Injection Valve

5. Disconnect the green waste 
line (labeled AS/AS50 
TRAY) from the union and 
route the line to the drip 
tray in the autosampler 
compartment.

You can either leave the 
disconnected Teflon waste 
line and union in the tubing 
chase, or pull the line out 
from the front.

Figure B-41. Injection Valve Waste Line Union

6. Push the end of the green AS/AS50 TRAY line into the small round opening on 
the right side of the AS or AS50 (USB) tray (see Figure B-39).

NOTE Bend the waste line tubing about 5-mm from the end to
ensure it stays in place in the opening in the drip tray.
When bending the tubing, be sure not to restrict the
inner diameter.

Make sure the injection valve waste line is not elevated above the
injection valve at any point between the valve and the autosampler
drip tray. 

Autosampler
Needle Seal

Line

Waste
Line

Union

Tubing
Chase

Teflon
Waste
Line

AS/AS50 TRAY 
Waste Line 
(disconnect from 
union)
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B.17.2 AS or AS50 (USB) Chromeleon Setup

1. If you have not already done so, add the autosampler to the 
Chromeleon timebase (see Section B.8).

2. In the ICS-1500 Server Configuration properties, verify that the 
injection valve is controlled by the autosampler. To do this:

a. Open the Chromeleon Server Configuration program and select 
the ICS-1500 device in the timebase. 

b. Select Properties on the Edit menu.

c. Select the Inject Valve tab. 

d. Verify that the Pump_InjectValve check box is selected and that 
AS is listed in the Controlled By column (see Figure B-42). 

e. If ICS-1500 is listed in the Controlled By column, select the 
Pump_InjectValve name and press the F2 key. A dialog box 
appears. Select AS in the Controlled by drop-down list.

Figure B-42. ICS-1500 Inject Valve Server Configuration Properties
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B.18 Connecting an AS40 Automated Sampler (Optional)

1. Place the AS40 to the left 
of the ICS-1500 on the 
workbench. 

2. Open the front door of the 
ICS-1500 and thread the 
outlet line from the AS40 
through the left side slot 
at the front of the ICS-
1500.

3. Connect the outlet line 
from the AS40 to port 
S (5) of the injection valve 
(see Figure B-43).

Figure B-43. ICS-1500 Injection Valve

4. Locate the relay control cable (P/N 047946) supplied with the AS40.

5. Remove the 2-position connector plug from the pair of wires labeled LOAD on 
the relay control cable.

6. Locate the 12-position connector 
plug (P/N 923686) in the ICS-
1500 Ship Kit (P/N 057905) (see 
Figure B-44).

7. Attach the red wire from the 
relay control cable to position 1 
on the plug, and attach the green 
wire to position 2. This will be 
used to connect the AS40 LOAD 
relay to RELAY OUT 1 on the 
ICS-1500.

To attach a wire to the plug, strip the end of the wire, insert it into the plug, 
and use a screwdriver to tighten the locking screw.

When attaching wires to the connector plug, be careful not to allow
stray strands of wire to short to the adjoining position on the
connector.

AS40
Sample

Outlet Line

Figure B-44. 12-Position Connector Plug

Position 1

Position 12

Locking 
Screws
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NOTE If RELAY OUT 1 is not available, you can connect to
RELAY OUT 2 or to one of the TTL outputs. For RELAY
OUT 2, connect the red wire to position 3 and the green
wire to position 4. For TTL OUT 1, connect the red wire
to position 5 and the green wire to position 11. For TTL
OUT 2, connect the red wire to position 6 and the green
wire to position 12. 

8. Connect the relay control cable's 10-position connector plug to the RELAY 
CONTROL connector on the AS40 rear panel (see Figure B-45).

9. Plug the 12-position connector plug into the TTL and relay connector on the 
ICS-1500 rear panel (see Figure B-45). Make sure the red wire connects to 
position 1 and the green wire connects to position 2.

The AS40 Load relay is now dedicated to the ICS-1500 RELAY OUT 1. Use this 
relay for running with Chromeleon. When you set up the ICS-1500 application 
(see Section B.12), commands for controlling the AS40 Load relay and switching 

Figure B-45. Example AS40 Autosampler Connection
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the ICS-1500 injection valve are included by default in the program file (see 
Figure B-46). 

Figure B-46. Example Program for AS40 Control

B.19 Connecting the Analog Output (Optional)

The analog output connector on the ICS-1500 rear panel outputs an analog voltage 
signal proportional to the conductivity measured by the cell. The selected data rise 
time (see Section C.9.1) filters the output. The analog output can be connected to 
an analog-to-digital converter such as an integrator or other recording device. 
Refer to the documentation for the device for connection instructions. 

Analog output is 0 to 1V, scaled to the selected range (see Section C.9.3).

For an example setup for ICS-1500 stand-alone operation with an AS or AS50 
(USB) autosampler, see Section D.3.

B.20 Pressurizing the Eluent Reservoir (Optional)

The ICS-1500 does not require pressurized reservoirs. However, if eluent is 
manually degassed or is sensitive to contamination, Dionex recommends 
pressurizing the reservoir with helium or nitrogen. The air regulator accessory 
bracket and other items needed for pressurizing the eluent reservoir must be 
ordered separately (P/N 060054).

Relay 1 turned on to start 
the AS40 Load cycle and 

Relay 1 turned off after 
 

 load the sample loop 
138 seconds

Injection valve
 switched to Inject 

Injection valve
 switched back
to Load
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B.20.1 Connecting the Gas Source (Optional)

1. Locate the barbed fitting (P/N 030071), pipe thread reducer 
(P/N 030087), 3-mm (1/8-in) ID tubing (P/N 040793), and ICS-1500 
air regulator accessory (P/N 060054). These parts must be ordered 
separately.

2. Use the barbed fitting and pipe thread reducer to connect the 3-mm 
(1/8-in) ID tubing to a clean gas source, regulated to between 0.55 
and 0.83 MPa (80 and 120 psi).

3. Push the other end of the tubing onto the inlet of the air regulator (see 
Figure B-47).

4. Remove the eluent reservoir cap.

5. Connect the gas line from the eluent reservoir cap to the gas line on 
the air regulator outlet.s

6. Slip the air regulator accessory bracket over the neck of the eluent 
reservoir (see Figure B-47). 

Figure B-47. ICS-1500 Pressurized Eluent Reservoir Connections (Optional)

Gas Inlet Line 
3-mm (1/8-in) ID

Connect to 
gas source

Eluent Gas Line

Air Regulator 
Accessory 
Bracket
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B.20.2 Pressurizing the Eluent Reservoir (Optional)

NOTE Do not pressurize the ICS-1500 until after the
reservoir is plumbed.

1. Pull out the air regulator knob and turn it fully counterclockwise to 
ensure there is no pressure to the reservoir when the gas source is 
turned on. 

2. Turn on the gas source.

3. Pull out the air regulator knob and turn it clockwise to pressurize the 
eluent reservoir. 

4. Adjust the pressure to between 0.03 and 0.04 MPa (5 and 6 psi). Push 
the regulator knob back in. 

Do not pressurize the eluent reservoir above 0.07 MPa (10 psi).

Ne mettez jamais les réservoirs d'éluants sous une pression
supérieure à 0,07 MPa (10 lb/po²).

Setzen Sie den Eluentbehälter auf keinen Fall einem Druck über 0,07
MPa aus. 
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B.21 Pump Continuous Seal Wash Connections (Optional)

The pump includes a seal wash assembly that can be set up to continuously rinse 
the back of the piston seals to remove salt crystals and prolong the life of the seals. 
Follow the steps below to set up this feature.

1. Fill a flush bottle with either deionized water or a combination of deionized 
water and 10% or 20% isopropyl alcohol. (Isopropyl alcohol will inhibit 
bacterial growth in the water.)

2. Place the flush bottle on top of the ICS-1500. During operation, gravity 
maintains flow through the pump heads.

3. The flush solution is carried to the piston seal wash assembly and out to waste 
via 1.5-mm (0.06-in) ID tubing (P/N 055847). Locate this tubing in the ICS-
1500 Ship Kit and cut the tubing into three unequal pieces in the following 
lengths:

• 117 cm (46 in)

• 152 cm (60 in)

• 15 cm (6 in)

4. Install the tubing as follows (see Figure B-48 and Figure B-49):

a. Push the 117-cm (46-in) piece of clear tubing onto the drain tube on the 
bottom of the secondary pump head. Place the free end of this tubing in 
the flush bottle. Make sure the end of the tubing is near the bottom of the 
bottle.

Figure B-48. Primary and Secondary Pump Heads with Drain Tubes

Secondary
Pump Head

Primary Pump 
Head

Drain Tube

Drain Tube

Note: The drain 
tubes on the 
bottom of each 
pump head are not 
visible in the 
photo.
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b. Push the 152-cm (60-in) piece of clear tubing onto the drain tube on the 
top of the primary pump head. This is the waste line. Route this waste line 
through the lower tubing chase and out the back of the ICS-1500.

c. Push the 15-cm (6-in) piece of clear tubing over the drain tube on the top 
the secondary pump head. Push the other end of the tubing over the drain 
tube on the bottom of the primary pump head.

d. Place a 10 mL syringe (P/N 054578) at the end of the waste line, press the 
syringe against the line to form a seal, and draw out all of the air.

e. Push approximately 5 cm (2 in) of black 0.25-mm (0.01-in) ID tubing 
(P/N 057057) into the end of the waste line. 

NOTE The black tubing creates a flow restriction. Assuming a
height difference of about 76 cm (30 in) between the
flush bottle and the waste container, this setup provides
a flow of one drop of flush solution every 5 to 30 seconds. 

f. Place the end of the waste line in a waste container.

g. This completes the piston seal wash installation. Periodically refill the 
flush bottle and empty the waste container as required.

Figure B-49. Piston Seal Wash Flow Schematic

Flush
Bottle

Waste
Container

Insert black tubing into
end of waste line

Tubing, 15 cm (6 in) long

Tubing, 117 cm (46 in) long

Tubing, 152 cm (60 in) long

Primary Pump Head

Secondary Pump Head
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B.22 Manually Connecting to a Control Panel

This section describes how to manually connect the ICS-1500 to a Control panel if 
you do not use the application templates described in Section B.12.

1. In the Browser, expand the Dionex Templates\Panels\Dionex_IC\ICS-1500 
System Panels folder. Several System Control panels, corresponding to 
various system configurations, are provided.

2. Open the panel for your system configuration by double-clicking its name in 
the list. For example, if your system includes an ICS-1500 and an AS50 
autosampler, double-click either ICS-1500_System_AS50.pan or ICS-
1500_Traditional_System_AS50.pan.

NOTE The two types of panels (system and traditional
system) are similar in function, but have different
“looks.” You can select either style, depending on
your personal preference.

When the Control panel opens, the controls on the panel are not enabled (see 
Figure B-50). 

Figure B-50. ICS-1500 Traditional System Control Panel (Unconnected) 
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3. To connect the Control panel to the ICS-1500, open the Control menu and 
click the name of the ICS-1500 timebase at the bottom of the menu.

The Control panel is now connected to the ICS-1500 and the controls are 
enabled (see Figure B-51).

Figure B-51. ICS-1500 Traditional System Control Panel (Connected to the ICS-1500)
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B.23 Installation Troubleshooting

Problem: When the ICS-1500 power is turned on for the first time, a Windows 
message box appears asking for a USB configuration file (cmwdmusb.inf). 

Possible Cause: The USB cable was connected and the power turned on before 
Chromeleon was installed.

Solutions: 

Follow these steps to resolve the problem:

1. Click Cancel in the Windows message box. 

2. Turn off the power to the USB device and unplug the USB cable from the 
computer. 

3. Install Chromeleon (see Section B.4).

4. Reconnect the USB cable to the computer and turn on the power to the 
device. Windows will now automatically recognize the USB device.
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C • Touch Screen Operation

The LCD touch screen on the ICS-1500 front panel allows local control of most 
ICS-1500 functions. This chapter describes how to operate the ICS-1500 from the 
touch screen.

When the ICS-1500 starts up, the touch screen displays a startup page. This is 
followed by the INFORMATION page, which displays version and serial numbers 
and a list of installed options. After a few seconds, the HOME page (see 
Figure C-1) is displayed. The HOME page provides controls for all normal, daily 
operation of the ICS-1500.

C.1 Using the Touch Screen

NOTE To adjust the screen contrast, open the front door and
adjust the knurled knob under the screen (see
Figure 2-8).

Figure C-1. ICS-1500 Touch Screen Home  Page

Edit Field

Command
Button

(selected)

Command
Button

(unselected)

Status Field
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• Edit fields and command buttons have blue text on a lightly shaded 
background. Fields that display status information are not shaded. 

• Edit fields have square corners while command buttons are rounded.

• To edit a field or select a command button, touch and release the field or 
button with your fingertip. 

NOTE When you touch a button or edit field, the action takes
effect when you lift your finger. If you unintentionally
touch a button or field, you can cancel the action by
sliding your finger away from the button or field before
lifting.

• Touching a command button (for example, ) executes the command 
immediately. 

• Selecting a command button changes the button’s appearance to white text on 
a dark background (for example, ).

• Touching an edit field (for example, ) opens a page with a 
number keypad (see Figure C-2). Use the keypad to enter the desired 
numerical value for the field and then touch the ENTER button.

Figure C-2. Number Keypad

Touch a
number to

enter the
value. Touch ENTER to 

confirm the 
entry and return 
to the previous 
page.

Touch CANCEL 
to cancel the 
entry and return 
to the previous 
page.
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• Touching the page name (for example, ) in the bottom right 
corner opens a menu of pages (see Figure C-3).

Figure C-3. ICS-1500 Touch Screen Menu of Pages

• Touching a page name on the menu of pages displays the selected page. For 
example, touching SUPPRESSOR displays the SUPPRESSOR page (see 
Figure C-4). 

Figure C-4. Suppressor Page
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different 
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return to the

previous
page.
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• Touching  returns you to the HOME page.

• Touching  opens a list of options (see Figure C-5). 

C.2 Using the Touch Screen with Chromeleon

When the ICS-1500 is connected to a Chromeleon Control 
panel, the status field at the bottom center of the HOME page 

displays Remote Mode. In this mode, most of the controls on the touch screen 
pages are disabled. This prevents touch screen commands from conflicting with 
Chromeleon commands. 

In general, when the ICS-1500 is connected to Chromeleon, you can:

• View all ICS-1500 operational status information (pressure, flow rate, 
conductivity readings, etc.)

• Go to any of the touch screen pages

• View a plot of the conductivity data from the PLOT page and adjust the plot 
display using the controls on the page. See Section C.5 for details. 

To restore touch screen (local) control, clear the Connected check box on the 
Chromeleon Control panel.

Figure C-5. Suppressor Page: Selecting an Option

Touch an 
option to 
select it.

Note: To cancel 
and retain the 
current selection,
touch outside of 
the list.
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C.3 Overview of ICS-1500 Touch Screen Pages

Figure C-6 illustrates the organization of the ICS-1500 touch screen pages.

Figure C-6. Overview of ICS-1500 Touch Screen Pages
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C.4 Home Page

C.4.1 Home Page Pump Controls

Pressure Display
The HOME page indicates the current pressure reading from 
the pressure transducer. The pressure unit can be set to psi 
(the factory default), MPa, or bar (see Section C.7.1).

The minimum and maximum pressure limits are displayed 
below the current pressure reading. If the pressure reading 
goes outside these limits, the pump is stopped and an error 
message appears in the Chromeleon Audit Trail and on the 
touch screen. See Section 4.1 for troubleshooting 
information. See Section C.7.1 for how to set the pressure 
limits.

Flow Rate
The flow rate can be set to 0.00 (which turns off the pump) and to between 0.05 
and 5.00 mL/min. The recommended operating flow rate is between 0.40 and 

Figure C-7. ICS-1500 Touch Screen Home  Page
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2.00 mL/min. Refer to the column manual for the flow rate to use with your 
column and application. Column manuals are included on the Dionex Reference 
Library CD-ROM (P/N 053891).

Pump On/Off Control
Touching the On button immediately starts the pump flow at the rate displayed in 
the Flow Rate field. Touching Off stops the flow.

Prime
The Prime button is reserved for use during the pump head priming procedure. 
Touching the Prime button displays a confirmation page that reminds you to open 
the waste valve. Open the valve, and then touch the OK button to begin priming. 
Or, to exit the page without priming, touch the Cancel button. To stop priming, 
touch the Off button. During priming, the flow rate is approximately 3 mL/min. 
See Section B.14 for detailed priming instructions.

Eluent Level
Use this field to monitor the amount of liquid in the eluent reservoir. When you 
fill the reservoir, enter the amount of liquid in the reservoir. For example, if the 
reservoir contains 200 mL and you add 1 liter, enter 1.2 liters. Thereafter, the ICS-
1500 determines the eluent usage by monitoring the flow rate and the length of 
time the pump is on. The ICS-1500 updates the Eluent Level field as the eluent is 
used up. A warning first appears if the level falls below 200 mL. Warnings are 
repeated at 100 mL and 0 mL. 

In order for the eluent level displayed on the screen to be accurate,
the level must be entered by the user when the reservoir is filled. The
ICS-1500 does not automatically detect when the reservoir is filled,
nor when it is empty.
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C.4.2 Home Page Column Heater

The temperature of the column heater can be controlled to 
between 30 and 60 °C. For optimal performance, set the 
column heater to at least 5 °C above the ambient 
temperature. To set the temperature, touch the Column 

Heater field and enter the desired temperature on the number pad. To turn the 
column heater off, set the temperature to 0. The display to the right of the 
temperature setting indicates the heater status:

C.4.3 Home Page Injection Valve Controls

The Inject and Load buttons select the position of the 
injection valve. A dark background and white text on a 
button indicates the current valve position. For details about 
the valve positions, see Section 2.4.4.

The ELAPSED TIME field displays the amount of time since 
the last injection.

C.4.4 Home Page Detector Controls

Conductivity Readings
The offset conductivity is displayed in large numbers above 
the total conductivity. The offset conductivity is the total 
conductivity minus the current offset. 

To determine the offset, allow the system to equilibrate after 
startup. At equilibration, the conductivity reading is the background conductivity 
(the eluent conductivity before sample injection). Touch Autozero to zero the 
conductivity and offset this background reading from the total reading.

NOTE You can reverse the conductivity display to show the
total conductivity in large type, with the offset
conductivity below it in small type. Select this option on
the MODULE SETUP page (see Section C.11).

= column temperature is at equilibrium
↑ column temperature is rising
↓ column temperature is falling
Off column heater is off
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Cell Heater Controls
The temperature of the cell can be set to between 30 °C and 
55 °C, but must be at least 7 °C above the ambient 
temperature. To set the temperature, touch the Cell Heater 
field and enter the desired temperature on the number pad. 

To turn off the cell heater, set the temperature to 0. The display to the right of the 
temperature setting indicates the heater status:

Suppressor Controls
The Suppressor controls indicate the suppressor current 
setting and the type of suppressor installed.

To set the suppressor type, change the current setting, or 
turn the suppressor on or off, touch the suppressor button. 

The SUPPRESSOR page appears (see Section C.8).

C.4.5 Other Home Page Controls

This field displays Remote Mode when the ICS-1500 is 
connected to Chromeleon and Local Mode when the 
system is not connected to Chromeleon.

Opens the PLOT page, which provides a real-time plot of the detector 
conductivity output. See Section C.5 for details.

Opens the STATUS page, which displays the status of various operating 
parameters. See Section C.6 for details.

= cell temperature is at equilibrium
↑ cell temperature is rising
↓ cell temperature is falling
Off cell heater is off
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C.5 Plot Page

The PLOT page provides a real-time plot of the detector conductivity output. To 
open the page, touch the PLOT button on the HOME page, or select PLOT from the 
menu of pages. The page can display up to 60 minutes of data. Data older than 
60 minutes is discarded. You can view the plot and adjust the display when the 
ICS-1500 is under either local or computer control.

Plot Controls
• The plot offset button offsets the current background conductivity reading 

and sets the plot baseline to zero. Subsequent output is plotted in relation to 
the new zero point. Offsetting the plot does not affect the data sent to 
Chromeleon, the analog output, or the data displayed on other pages.

• The range field sets the highest conductivity reading displayed on the plot 
(the vertical scale). If the tops of peaks are cut off, select a higher range. If 
peaks are short, select a lower range. Select Auto to have the scaling of the 
signal plot automatically adjusted to the height of the signal.

• The elapsed time field displays the time since injection.

• The plot time field sets the length of time plotted on the page (the horizontal 
scale).

Figure C-8. Plot Page
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C.6 Status Page

The STATUS page displays the current status of various operating parameters. To 
open this page, touch the STATUS button on the HOME page or select STATUS from 
the menu of pages.

Status Page Controls
• Pressure and conductivity readings are the same as those displayed on the 

HOME page.

• The eluent bottle depicts the level of liquid in the eluent reservoir. The scale is 
always 0 to 4 liters (regardless of the size of reservoir installed). After filling 
the reservoir, go to the HOME page and enter the amount of liquid in the 
reservoir (see Section C.4.1). The ICS-1500 monitors the eluent usage, based 
on the flow rate and the length of time the pump is on. The “liquid” level in 
the bottle falls as the reservoir empties. An error message is first displayed on 
the screen when the level falls below 200 mL. The message is repeated at 
100 mL and then at 0 mL.

Figure C-9. Status Page

In order for the eluent level displayed on the screen to be accurate,
the level must be entered by the user when the reservoir is filled. The
ICS-1500 does not automatically detect when the reservoir is filled,
nor when it is empty.
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• The fields to the right of the bottle display the status of four other operating 
parameters. You can choose from six possible parameters to display here. 
Figure C-9 shows the default parameters: Eluent time, Flow rate, Cell temp, 
and Suppressor. To select different parameters, touch the Setup button. See 
Section C.6.1 for details about how to change the status parameters, and 
Section C.6.2 for a description of each parameter. 

• Touching the Busy button displays the BUSY page (see Figure C-10).

Figure C-10. Busy Page
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C.6.1 Viewing Other Status Parameters

Follow the steps below to view the status of a parameter that is not 
currently displayed on the STATUS page.

1. Touch the Setup button. A drop-down list replaces the label for each 
field, and the Setup button changes to Apply (see Figure C-11).

Figure C-11. Status Page Setup
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2. Touch the down arrow next to the field you want to change. A list of 
the available status parameters appears (see Figure C-12).

3. Touch the parameter you want to display.

4. When finished, touch the Apply button.

Figure C-12. Status Page Parameter List
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C.6.2 Status Parameter Details

C.7 Pump Page

Use the PUMP page to set parameters related to pump operation, including 
pressure limits, pressure unit, vacuum degas pump settings, and eluent valve 
control. To open this page, select PUMP from the menu of pages. The current 
system pressure is displayed at the top of the screen. 

Status Parameter Description
Eluent time The number of hours the eluent supply will last, if the pump runs 

continuously at the current flow rate.
Flow rate The actual flow rate currently output by the pump.
Suppressor The actual current applied to the suppressor.
Elapsed time The number of hours since the last injection.
Cell temp The temperature of the cell heater (°C), followed by a status 

symbol (=, ↑, or ↓).
Column temp The temperature of the column heater (°C), followed by a status 

symbol (=, ↑, or ↓).

Figure C-13. ICS-1500 Touch Screen Pump Page

Current 
system 
pressure



ICS-1500 Ion Chromatography System

C-16 Doc. 031917-02 9/05

C.7.1 Setting Pump Pressure Limits and Selecting the 
Pressure Unit

The first time the power to the ICS-1500 is turned on, the maximum 
system pressure limit is 34.5 MPa (5000 psi) and the minimum pressure 
limit is 0.

NOTE Pump pressure limits can also be changed in
Chromeleon (in the Server Configuration program or in
the control program). 

• To change the high pressure limit, touch the HIGH field and enter the 
desired limit on the number pad. The high limit must be at least 
0.7 MPa (100 psi) above the low limit.

• To change the low pressure limit, touch the LOW field and enter the 
desired limit on the number pad.

To select the pressure unit for all touch screen pages that display pressure 
values, touch the pressure unit field and select the desired unit on the list 
(PSI, bar, or MPa) (see Figure C-14). 

Figure C-14. Pump Page: Selecting the Pressure Unit

Select the 
pressure unit
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C.7.2 Setting Degas Operating Parameters (Optional)

By default, the ICS-1500 monitors the degas pressure reading and turns 
the degas pump on and off as required. To change the degas operating 
option:

1. Select PUMP from the menu of pages. 

2. Under Degas Settings, touch the options drop-down list. A list of 
available options appears (see Figure C-15).

NOTE Degas options can also be selected from the Chromeleon
Server Configuration program (see Section 2.4.1).

3. Select the desired option:

Always Off: The degas pump is always off.

Always On: The degas pump is always on. This setting is reserved for 
test purposes by a Dionex Service Representative.

Duty Cycle: The degas pump cycles on and off according to the times 
specified in the Duty Cycle and Time Off fields. Duty Cycle specifies 
for how long the degas pump runs during a cycle; Time Off specifies 
the time between cycles.

Monitor: The ICS-1500 monitors the degas pressure reading and 
turns the degas pump on and off as required.

Figure C-15. Pump Page: Selecting Degas Options

Select the Degas Mode, Always On option only when testing the vacuum
degas assembly. Do not select the Always On option for routine use.

Select the 
degas option
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C.7.3 Controlling the Eluent Valve

The eluent valve controls flow from the 
eluent reservoir. During routine operation, 
the valve opens and closes automatically 

when the pump flow is turned on and off. However, during eluent line 
priming, you can use the controls on the PUMP page to manually open the 
valve, allowing liquid to flow through the lines when the pump is off. See 
Section B.14.1 for eluent line priming instructions.

C.8 Suppressor Page

Use the SUPPRESSOR page to specify the type of suppressor installed in the ICS-
1500, turn the suppressor on and off, and select the amount of current supplied to 
the suppressor. To open this page, touch the suppressor button on the HOME page, 
or select SUPPRESSOR from the menu of pages.

Suppressor Controls
• The suppressor type is typically selected at initial installation and does not 

need to be changed. However, if a different type of suppressor is installed 
later (or if the suppressor is removed from the system), touch the Type field 
and select the new suppressor type (None/MMS, SRS, or AES) from the list.

Figure C-16. Suppressor Page
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• To set the current, touch the Current field and enter the desired setting (in 
milliamperes) on the number pad.

The appropriate suppressor current setting depends on several variables: the 
suppressor type, the column, the eluent, and the flow rate. Refer to the 
suppressor manual for the recommended current setting for your application. 
The suppressor manuals are included on the Dionex Reference Library CD-
ROM (P/N 053891). 

NOTE When Chromeleon is used to control the ICS-1500, the
Program Wizard automatically calculates the current
required for the application.

• To manually control the suppressor power, touch the Off and On buttons. 

• To automatically control the suppressor power simultaneously with the pump 
flow, select Automatically turn on with pump.

NOTE The suppressor always turns off when the pump is off,
regardless of whether the “Automatically turn on with
pump” option is selected.
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C.9 Detector Page

Use the DETECTOR page to set the data rise time and to select parameters for 
adjusting the analog output. To open this page, select DETECTOR from the menu 
of pages.

C.9.1 Setting the Data Rise Time

The data rise time determines the amount of filtering performed on the 
conductivity data. The rise time is a measure of how quickly the detector 
responds to a change in signal, and is defined as the time it takes the 
output signal to rise from 10% of its final value to 90% of its final value. 

The selected data rise time is used to filter both the digital data output, 
which is sent to the computer and the PLOT page, and the analog data 
output. The default rise time is 2 seconds.

Choosing an appropriate rise time value can optimize performance by 
keeping the signal-to-noise ratio at a minimum level. A longer rise time 
allows averaging of the noise frequencies, and subsequently, the baseline 
will contain much less short-term noise. However, longer rise times may 
have the following effects on peaks:

• Peak shape will become asymmetric.

Figure C-17. Detector Page
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• The peak maximum will be shifted.

• The peak height will be reduced.

The rise time should be approximately 25% of the peak width at one-half 
the height of the narrowest peak of interest.

For example, for a peak width of 5 seconds, calculate the rise time as: 
(5 sec) 25% = 1.25 sec. Because 1.25 seconds is not one of the available 
settings for rise time, select the next fastest rise time, 1 second.

To set the data rise time, touch the Data Rise Time field and select the 
desired time from the list (see Figure C-17).

C.9.2 Selecting the Conductivity Polarity

To change the polarity of the conductivity data, touch the Conductivity 
Polarity field. Select either Normal or Inverted. In applications in which 
the analyte output is lower than the background conductance, the polarity 
must be inverted to have peaks instead of dips on the chromatogram.

C.9.3 Setting Analog Out Options

The analog output connector on the ICS-1500 rear panel outputs an 
analog voltage signal proportional to the conductivity measured by the 
cell. The output is filtered using the selected data rise time (see 
Section C.9.1). The analog output can be connected to an analog-to-
digital converter device, such as an integrator or a chart recorder.

The Analog Out options on the DETECTOR page (see Figure C-17) let 
you configure the output for your application.

• Output: Select Normal to output a signal corresponding to the offset 
conductivity reading from the detector (see “Conductivity Readings” 
on page C-8) and the selected Analog Out parameters. Use the other 
two settings to calibrate an analog-to-digital converter device. Select 
Zero to set the output signal to zero volts. Select Full Scale to set the 
output signal to the full-scale voltage (1000 mV).

• % Offset: To adjust the zero position of the analog output when it is 
plotted, enter a percentage in the % Offset field. The value entered is 
a percentage of the full-scale analog output. An offset allows a 
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recording device to plot the signal if it becomes negative. The offset 
percentage does not affect the magnitude of the output signal.

• Polarity: Select the polarity of the analog output signal: positive (the 
default settings) or negative. In applications in which the analyte 
output is lower than the background conductance, the polarity must 
be negative to have peaks instead of dips on the chromatogram.

• Range: Select the range in microSiemens (µS) of a full-scale detector 
response. For the ICS-1500, the full-scale voltage is 1000 mV. For 
example, if the range is 100 µS, then 1 µS is equal to 10 mV from the 
analog output. The range to use depends on the conductivity readings 
expected for the application.
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C.10 Information Page

The INFORMATION page displays the version numbers of the ICS-1500 control 
programs (Moduleware and Boot Block), the serial number of the ICS-1500, and 
the options that are installed in the ICS-1500. The INFORMATION page is 
displayed at start-up. You can open the page from the menu of pages at any time. 

Moduleware is the firmware program installed in the ICS-1500 that controls 
instrument functions. Moduleware also sends status information and data to 
Chromeleon and receives control parameters from Chromeleon. 

The Boot Block is the first program to be executed when the ICS-1500 power is 
turned on. It starts the Moduleware program.

Figure C-18. Information Page
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C.11 Module Setup Page

The MODULE SETUP page lets you select options for the touch screen display and 
conductivity readings. To open this page, select SETUP from the menu of pages.

Module Setup Options
• Backlight Duration: Select 2-hour time-out to turn off the backlight after 2 

hours if the touch screen is not used during that time. Select Always On to 
have the backlight remain on continuously.

• Screen Time-out: If the touch screen is not used 
during the selected time-out, the display will 
change to show the screen selected from the list. 
For example, if you select 5 min and BUSY, the 
display will change to the BUSY page (see 
Figure C-10) 5 minutes after the last time the 
touch screen was used. Select Never to always 
display the page that was used last. 

• Conductivity Display: Select either Offset (the 
default setting) or Total as the primary 
conductivity display value. The selected value is 
shown in large bold type on the HOME and STATUS screens, with the other 
value in smaller type.

Figure C-19. Module Setup Page

Time-out
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C.12 Input/Output Page

The INPUT/OUTPUT page provides control of the ICS-1500 TTL inputs and TTL 
and relay outputs. To open this page, select INPUT/OUTPUT from the menu of 
pages. For details about relay and TTL control, see Appendix D.

Figure C-20. Input/Output Page
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C.13 Diagnostic and Calibration Pages

Diagnostic and calibration functions can be performed either from the touch 
screen diagnostic and calibration pages or from the Chromeleon Wellness Panel. 
To open a touch screen diagnostic or calibration page, select DIAGNOSTIC from 
the menu of pages. The DIAGNOSTIC page opens (see Figure C-21). From there, 
you can select the type of diagnostic or calibration to perform.

For detailed instructions on how to perform the various calibration and diagnostic 
procedures, see Section 5.1.

NOTE The Service button provides access to service functions
that are performed only by Dionex personnel. An access
code is required.

Figure C-21. System Diagnostic Menu Page
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D • TTL and Relay Control

D.1 TTL and Relay Connections

A 12-pin connector strip for TTL/relay control is located on the ICS-1500 rear 
panel. The connector provides two relay outputs, two TTL outputs, and four TTL 
inputs (see Figure D-1). 

Figure D-1. TTL and Relay Connector on Rear Panel

Relay loads in excess of 200 mA or with included power supplies over
60 V may damage the relay drivers on the CPU.
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Description

Solid State Relay Contacts Output

Pin Function

3
4

Solid State Relay Contacts Output

TTL Output 1 (1 k  pull up to +5, 100 mA sink) Ω5
TTL Output 2 (1 k  pull up to +5, 100 mA sink) Ω6

7
8
9
10
11

12 Ground

Ground

TTL Input 2 ⎯ Autozero

TTL Input 3   Pump/Suppressor On⎯ 

TTL Input 4 Mark⎯ 
Note: The TTL input 
functions can be reassigned 
to different inputs.

Connector 
Position

TTL Input 1 ⎯ Inject/Load
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The outputs can be used to control functions in external devices such as an 
autosampler or another Dionex module. When connected to a controlling device, 
the inputs can be programmed to perform the following ICS-1500 functions:

• Switch the injection valve position (load/inject)

• Perform an autozero command (set the conductivity to zero)

• Turn the pump on and off (also turns the suppressor on and off)

• Send a chart mark signal to the analog output. The mark is 10% of the full-
scale voltage, and the duration is 0.5 seconds. A mark can be used, for 
example, to indicate the injection.

Relay outputs 1 and 2 can be programmed to switch any low-voltage control. 
Switched current must be less than 200 mA and 42 V peak.

Connecting a TTL or Relay
1. Locate the twisted pair of 

wires (P/N 043598) and the 
12-position connector plug 
(P/N 923687) (see 
Figure D-2) in the ICS-1500 
Ship Kit (P/N 057905). 

2. Follow these basic steps to 
connect the TTL or relays.

a. For each relay or TTL to 
be used, connect an 
active wire (red) and a ground wire (black) to the 12-position connector 
plug at the appropriate pin locations. Refer to Figure D-1 or the label on 
the ICS-1500 rear panel for the connector pin assignments. 

To attach a wire to the plug, strip the end of the wire, insert it into the 
plug, and use a screwdriver to tighten the locking screw. If necessary, 
multiple ground wires can be attached to a single TTL input/output 
ground pin. 

b. Plug the connector into the 12-pin connector on the ICS-1500 rear panel.

When attaching wires to the connector plug, be careful not to allow
stray strands of wire to short to the adjoining position on the
connector.

Figure D-2. 12-Position Connector Plug

Position 1

Position 12

Locking
Screws
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c. Connect the wires from the ICS-1500 connector plug to the TTL or relay 
connector pins on the other module(s). Additional connector plugs are 
provided with other Dionex modules.

NOTE Check the polarity of each connection. Connect signal
wires to signal (+) pins and ground wires to ground (-)
pins. 

3. If you connected a TTL input, verify that the correct function is assigned to 
the input and that the correct input control type is selected. Select different 
settings if necessary. Input functions and control types are assigned from 
either the INPUT/OUTPUT touch screen page or Chromeleon (see 
Section D.1.1).

D.1.1 Selecting TTL Input Functions and Control Types

To select TTL input functions and the control type from Chromeleon, 
open the Chromeleon Server Configuration program and double-click the 
ICS-1500 icon under the timebase. Select the TTL Inputs tab (see 
Figure D-3).

Figure D-3. ICS-1500 Server Configuration Properties: TTL Inputs
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To select TTL input functions and the control type from the touch screen, 
go to the INPUT/OUTPUT touch screen page (see Figure D-4). 

TTL Input Control Types

The ICS-1500 TTL inputs respond to four types of 
signals to accommodate different controlling devices. 
The default control type, Normal Edge, is compatible 
with the output signals provided by Dionex modules. 

If the device connected to the ICS-1500 does not send a normal edge 
signal, select the appropriate control type. Refer to the documentation 
provided with the controlling device and the information below to select 
the correct type.

• Normal Edge: In normal edge 
operation, the negative (falling) 
edge of a signal turns on the 
function. For example, for the 
Load/Inject function, the 
negative edge switches the 
injection valve position to Load.

Figure D-4. Input/Output Page: Selecting TTL Functions

Select a
Function

Select a 
Control 
Type
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The action of the positive (rising) edge depends on the function: For 
the Load/Inject function, the rising edge switches the injection valve 
to the Inject position. For the Pump On function, the rising edge turns 
off the pump (and suppressor). For Autozero and Mark, the rising 
edge has no effect.

• Inverted Edge: The inverted 
edge mode works identically to 
the normal edge mode except 
that the positive and negative 
edges are reversed in function.

• Normal Pulse: In normal pulse 
operation, the negative (falling) 
edge of the TTL signal is the 
active edge and the positive 
(rising) edge is ignored. 

A pulse width of 50 ms or more 
is guaranteed to be detected. A pulse width of 4 ms or less is 
guaranteed to be ignored. The action for pulse widths that are greater 
than 4 ms and less than 50 ms is undefined.

• Inverted Pulse: The inverted 
pulse mode operates identically 
to the normal pulse mode 
except that the positive and 
negative edges are reversed in 
function.

D.2 Controlling TTL and Relay Outputs

The ICS-1500 provides two TTL outputs and two relay contacts for control of 
functions in external devices, such as an integrator or autosampler. The relay 
outputs can be used to switch any low-voltage control. Switched current must be 
less than 200 mA and 60 V peak blocking. The relay-contact closures are 
normally open. When the relay is closed, current flows to the connected device. 

Relay loads in excess of 200 mA or with included power supplies over
60 V may damage the relay drivers on the CPU.
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The TTL outputs are normally at 5 volts. Setting a TTL output to 0 volts turns on 
the action in the connected device.

The TTL and relay output states can be controlled from Chromeleon, either by 
issuing direct control commands from the Chromeleon Control panel or by 
including the commands in a control program. Figure D-5 shows an example relay 
program command for controlling an AS40 autosampler.

Figure D-5. Example Program for AS40 Control

To control the TTL and relay output states from the touch screen, select 
INPUT/OUTPUT from the menu of pages. The INPUT/OUTPUT page appears (see 
Figure D-4).

• To set a relay, touch the relay field and select the desired state (Open or 
Closed). For example, if Relay 1 is connected to the Load input on an AS40 
autosampler, touch the Relay 1 field and select Closed to start the AS40 load 
cycle.

• To set a TTL outputs, touch the TTL field and select the desired state (5 Volts 
or 0 Volts).

Relay 1 turned on to start 
the AS40 Load cycle and 

Relay 1 turned off after 
  load the sample loop 
138 seconds
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D.3 Example Setup for Stand-Alone Operation

This section describes an example setup for stand-alone operation (operation 
without Chromeleon software) with an AS or AS50 (USB) autosampler and a 
third-party analog-to-digital converter and controller. If your configuration 
includes different devices, use the following steps as guidelines and refer to your 
product documentation for specific connection details.

Connect the AS or AS50 (USB) Autosampler
Follow the instructions in Section B.17.1 to connect the AS or AS50 (USB) 
autosampler to the ICS-1500 injection valve.

Connect the TTLs and Relays
1. Locate two twisted pairs of 

wires (P/N 043598) and 12-
position connector plugs 
(P/N 923686) (see 
Figure D-6) in the ICS-1500 
and AS or AS50 (USB) Ship 
Kits. 

2. Attach the wires to the 
connector plug positions 
indicated in Figure D-7.

To attach a wire to a connector plug, strip the ends of the wire, insert into the 
desired connector position, and tighten the locking screw with a screwdriver.

3. Plug the connector plugs into their respective TTL/Relay connectors on the 
rear panel of each module.

Make sure the red wires connect to active (+) pins on each module and the 
black wires connect to ground (-) pins.

When attaching wires to the connector plug, be careful not to allow
stray strands of wire to short to the adjoining position on the
connector.

Figure D-6. 12-Position Connector Plug

Position 1

Position 12

Locking 
Screws
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Figure D-7. Example Connections for Stand-Alone Operation

ICS-1500 TTL Inputs
TTL IN 1 = Inject
TTL IN 2 = Autozero
TTL IN 3 = Pump On/Off
TTL IN 4 = Mark

AS50 TTL Inputs
TTL IN 1 = (unassigned)
TTL IN 2 = Start/Continue Schedule
TTL IN 3 = Tray/Temp. On/Off
TTL IN 4 = Therm. Compart. On/Off

System Function

Inject
Autozero

Start/Continue Schedule

Pump On/Off
Start Data Acquisition

AS50 TTL Out 1 to ICS-1500 TTL In 1

 to AS50 TTL In 2

AS50 TTL Out 2 to ICS-1500 TTL In 2
AS50 RLY Out 2 to ICS-1500 TTL In 3
AS50 RLY Out 1 to Third-party DAC RLY In
Third-party ADC RLY OUT

Connection

Analog Data Transfer

AS50 Rear Panel ConnectionsICS-1500 Rear Panel Connections

red: pos. 7,8,9

1 2 3 4 5 6 7 8 9 10 11 121
2(+)

TTL OUT

1

2
TTL GND

(-)

1
2
3

4

TTL IN
(+)

1

2

RELAY 
OUT

TTL 2 OUT (+)
TTL 1 OUT (+)

RLY 2 OUT

RLY 1 OUT

TTL 1 IN (+)
TTL 2 IN (+)

TTL 3 IN (+)
TTL 4 IN (+)

TTL 
IN/OUT (-)

Third-Party Analog-to-Digital Converter and Controller

RELAY OUT

red pos.
1,3,5,6

red black red black

Start/Continue Schedule

Inject

1

2

3

4

5
6

7

8
9
10
11

12

black pos.
4,11,12,12

Autozero

ANALOG 
OUTPUT

+
-

ANALOG IN

Pump On/Off

black: 
pos. 11,12,12 Start Acquisition

RELAY IN
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Assign ICS-1500 Input Functions
Go to the ICS-1500 INPUT/OUTPUT touch screen page and verify that the Inject 
function is assigned to TTL input 1, that Autozero is assigned to TTL input 2, and 
that the TTL Input Control Type is Normal Edge (see Figure D-8).

Enable AS or AS50 (USB) Control of the Injection Valve
1. On the AS or AS50 (USB) front panel, press Menu and 0 to go to the TIME 

FUNCTION OUT screen. In the LOAD/INECT VALVE: TTL 1 field, select 
ENABLED.

2. Turn the AS or AS50 (USB) power off and then back on.

Figure D-8. Input/Output Page

Figure D-9. AS or AS50 (USB) Time Function Out Screen

Help Prompt

TIME FUNCTION OUT

TTL
1
2

LOAD/INJECT VALVE:
LOAD/INJECT VALVE:

ENABLED
DISABLED

STATE
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You can now issue commands from the AS or AS50 (USB) to switch the ICS-
1500 injection valve position. 

Connect the Analog Output
1. Locate the analog cable for the third-party analog-to-digital converter and 

controller.

2. Connect the analog input connector on the third-party controller to the 
ANALOG OUTPUT connector on the ICS-1500 rear panel (see Figure D-7).

Configure the ICS-1500 Analog Output
Go to the ICS-1500 DETECTOR touch screen page and select the settings shown in 
Figure D-10:

Figure D-10. Detector Page
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Create an AS or AS50 (USB) Method and Schedule
Figure D-11 is an example of AS or AS50 (USB) method timed events that can be 
used with the TTL/Relay connections shown in Figure D-7.

Timed Event Notes:

• At time INIT, the injection valve is set to Load. 

• At time 0.00, the injection valve is set to Inject, an autozero is performed 
(TTL2=1), the data acquisition mark is sent (RLY1=1), and the pump is 
turned on (RLY2=1). 

• At time 0.5, TTL2 and RLY1 are switched back to 0 to be ready for the next 
run. RLY2 remains at 1 to keep the pump on.

• TTL1 does not need to be set in the timed events because the Load and Inject 
commands control the ICS-1500 injection valve automatically (see “Enable 
AS or AS50 (USB) Control of the Injection Valve” on page D-9).

To run the above method, set up an AS or AS50 (USB) schedule. The example in 
Figure D-12 includes a four-point calibration (Lines 1 – 4) followed by two 
samples (Lines 5 and 6).

Figure D-11. Example AS or AS50 (USB) Method for Stand-Alone Operation

Figure D-12. Example AS or AS50 (USB) Schedule for Stand-Alone Operation

Help Prompt

METHOD:TIMED EVENTS

1 1 1

TIME
INIT LOAD

INJECT0.00

VALVE TTL1 TTL2 RLY1 RLY2
1

CSV

0 0 10.50

Help Prompt

SAVE TO RUNSCHEDULE

25.0

5.0

1

1

1 4 3
5 5 1
6 6 1

1

MISSING VIAL ACTION:
INJ/ INJ
VIAL METHODVOL(uL)

VIAL#
LINE ENDSTART

EDIT
SKIP

11 1

1-4
5
6

-
-

-
-

25.0
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E • Reordering Information

Part Number Item

Reservoirs
046548 2-L plastic reservoir assembly (includes stopper and cap)
039164 4-L plastic reservoir assembly (includes stopper and cap)

Pump
057937 Primary pump head assembly
057938 Secondary pump head assembly
045721 Outlet check valve assembly, 10-32
045722 Inlet check valve assembly, 1/4-28
045994 Check valve cartridges
052840 Piston
055870 Piston seal

048722 Piston rinse seal

055752 O-ring for waste valve or priming valve 
057945 Eluent valve
054578 10-cc syringe (for priming eluent lines)

Sample Loop and Injection Valve
042857 25-µL sample loop
057968 Injection valve
024305 Luer adapter fitting, 1/4-28 (for manual injections)
016388 1-cc syringe (for manual injections)
057896 Injection valve rebuild kit

Suppressors, Cell, and Column Heater
056116 AAES Anion Atlas Electrolytic Suppressor
056118 CAES Cation Atlas Electrolytic Suppressor
053946 ASRS-Ultra 4-mm Anion Self-Regenerating Suppressor
053949 CSRS-Ultra 4-mm Cation Self-Regenerating Suppressor
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057985 DS6 heated conductivity cell
058060 Column heater assembly
059979 Column heater heat exchanger, 0.25-mm (0.010-in) ID tubing
060943 Column heater heat exchanger, 0.125-mm (0.005-in) ID tubing
058062 Column heater cover assembly

Relay/TTL
923686 12-position connector plug
043598 Twisted pair of wires

Miscellaneous
954745 IEC 127 fast-blow fuses, rated 3.15 amps
060494 USB cable, 5 m (16 ft)
060392 External USB hub
058053 Leak detector

Maintenance Kits
055647 AS40/ASM Preventive Maintenance Kit
060581 AS/AS50 Preventive Maintenance Kit
057954 ICS-1500 Preventive Maintenance Kit

Part Number Item
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F • FAQ

F.1 How do I hook up an autosampler?

For instructions on how to connect the ICS-1500 to an AS or AS50 autosampler, 
see Section B.17 of this manual. To connect an AS40, see Section B.18. Also refer 
to the autosampler operator’s manuals, which are included on the Dionex 
Reference Library CD-ROM (P/N 053891).

F.2 How do I print?

Click the Print toolbar button in Chromeleon (see Section 2.3).

F.3 Why are the retention times moving?

Retention times can shift if the pump flow is erratic or if the column or eluent is 
contaminated. See Section 4.6 for pump flow rate troubleshooting. If a 
contaminated column is suspected, clean the column as instructed in the column 
manual. The column manual is included on the Dionex Reference Library CD-
ROM (P/N 053891).

F.4 How do I adjust retention times?

Retention times are calculated during calibration. The Use Recently Detected 
Retention Time parameter in the Chromeleon QNT Editor (General tab) can be 
used to compensate for some types of retention time drifts; for example, 
evaporation of volatile components in pre-mixed solvents or an aging column. 
Refer to the Chromeleon online Help or user’s guide for details.

F.5 When should I remake standards?

Standards are used only for calibration and should always be made fresh (they 
have a lifetime of only one week).
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F.6 When should I remake eluents?

Eluents should be remade every two or three weeks. 

F.7 How do I start Chromeleon?

Click Start on the Windows taskbar, and then select Programs >Chromeleon > 
Chromeleon.

F.8 How do I delete data?

In the Chromeleon Browser, highlight the sequence you want to delete and then 
select File >Delete.

F.9 How do I back up data?

In Chromeleon, select File >Export/Backup. Back up the data and indicate the 
backup source. 

F.10 How do I shut off the system?

In Chromeleon, click the System Shutdown button on the Control panel (see 
Figure 2-12). On the ICS-1500, turn off the power switch on the rear panel (see 
Figure 2-9).

F.11 How do I store columns?

Columns should be stored in eluent. See the column manual for complete 
instructions. The column manual is included on the Dionex Reference Library 
CD-ROM (P/N 053891).

F.12 How do I know when a column is dirty?

See the troubleshooting section of the column manual.
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F.13 How do I clean a column?

See the troubleshooting section of the column manual.

F.14 Why is the conductivity high?

Possible reasons for high conductivity include:

• The suppressor needs regeneration. See the suppressor manual for 
troubleshooting information. The suppressor manual is included on the 
Dionex Reference Library CD-ROM (P/N 053891).

• The cell is out of calibration. See Section 5.1.3 for calibration instructions.

• See Section 4.12 for additional troubleshooting information.
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G • Glossary

Analytical Column
Synonymous with Separator Column.

Band Spreading
The broadening of the sample band as it travels through the column. Band 
spreading can also occur in the injection valve, detector cell, and interconnecting 
tubing.

Calibration Curve
A graph showing detector response in peak height or area versus analyte 
concentration.

Capacity Factor (k´)
The number of column volumes of eluent, pumped through the column, required 
to elute an analyte. Capacity factor is a dimensionless measure of retention which 
is independent of column length or eluent flow rate. It is calculated as follows: 

Where: tr = retention time
to = retention time of unretained solute (column void volume)

k′
tr to–

to
--------------=
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Cell Constant (k)
A factor determined experimentally by measuring the conductance (G) of a 
standard solution of known equivalent conductivity (k).

The value of k depends upon the surface area of, and distance between, the 
electrode faces in the conductivity detector cell.

Where: l = length
A = area of one electrode (the other electrode is equal to
the first)

Channeling
The preferential flow of liquid along more open, less resistant paths through the 
column packing. This causes Band Spreading.

Column Efficiency (N)
A measure of the narrowness of analyte bands as they elute from the column. 
High efficiency is desirable because resolution between closely spaced bands 
improves with greater efficiency. For a symmetrical (Gaussian) peak, column 
efficiency can be determined by the following:

N = 5.54(t1/W1/2)2

Where:  t1 = the peak retention time (in seconds)
W1/2 = the peak width at 1/2 height (in seconds)

Column efficiency is proportional to column length: for a given resin and column 
diameter, increasing the column length increases the column efficiency. 
Synonymous with Theoretical Plates.

Column Selectivity (a)
Describes the relative separation of the band maxima between two adjacent peaks. 
Selectivity can be determined by the following:

a = (t2 - t0)/(t1 -t0)

Where: t1 and t2 = retention time of components 1 and 2, respectively
t0 = retention time of unretained components (void volume)

Concentrator Column
A short column used to retain and concentrate analytes from a measured volume 

k κ G⁄=

k l A⁄=
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of relatively clean sample. This allows large volumes of sample to be injected, 
lowering concentration detection limits.

Conductivity
A measure of the ease with which electrical current flows through a liquid 
contained between two opposite charged electrodes. Conductivity is a 
characteristic of ions in solution. Units are siemens.

Counterion
Ions carrying a charge opposite that of the sample ions (e.g., Na+) may be the 
counterion of a Cl- analyte. These ions preserve electrical neutrality in solution.

% Crosslink
Divinylbenzene content in a polystyrene/divinylbenzene (PS-DVB) resin; this 
contributes to the mechanical strength of the resin and determines 
chromatographic properties.

Equivalent Conductivity (λ)
The contribution of an ionic species to the total conductivity of a solution as 
measured in a standard cell having electrodes 1 cm2 in area and exactly 1 cm 
apart.

Guard Column
A small column that prevents poisoning of the separator column by sorbing 
organic contaminants and removing particulates. It is filled with the same packing 
as the separator column. Synonymous with Pre-Column.

HETP (H)
Height Equivalent to a Theoretical Plate. A measure of column efficiency which 
allows comparison between columns of different lengths.

HETP = H = L/N

Where: L = the column length (in mm)
N = the number of theoretical plates

Ion-Exchange Capacity
The number of active ion exchange sites in a given weight or volume of resin; this 
is usually expressed in meq/g or meq/mL.

Ion-Exchange Resin
An insoluble polymer matrix containing fixed-charge exchange sites (anionic or 
cationic). IC resins are formed into small spherical particles (beads).
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Packing
The material that fills a chromatographic column; usually a resin or silica-based 
material.

Pellicular Resin
A resin with a solid, nonporous core coated with a thin layer of more porous 
material. The exchange sites of pellicular ion exchange resins are located only on 
the surface layer of the bead. These resins have a low ion-exchange capacity.

Pre-Column
Synonymous with Guard Column.

Regenerant
A dilute acid or base that converts ion exchange sites in a MicroMembrane 
Suppressor back to the form that suppresses the eluent conductivity.

Resin
See Ion-Exchange Resin.

Resolution (R)
A measure of the separation between two sample components. This is expressed 
as the ratio of the distance between the two peak maxima to the mean value of the 
peak width at the baseline.

R = 2(t2 - t1)/(W2 + W1)

Where: t1 and t2 =the retention times of components 1 and 2,
respectively
W1 and W1 = the baseline width of peaks 1 and 2,
respectively (measured in the same units as the retention
time)

R is proportional to the square root of efficiency (N). A value of R = 1.5 
represents “baseline separation” of the two peaks.

Retention Time
The time from injection to peak maximum; the basis for identification of a species 
in chromatographic analysis.

Separator Column
The column used to perform a chromatographic separation; also called an 
analytical column.
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Siemens (S)
Unit measure of conductance; the reciprocal of the electrical resistance of a 
solution.

Suppressor
A device used to minimize eluent conductivity and convert sample species to a 
common form, thus increasing detection sensitivity.

Temperature Coefficient
The percent of change in the conductivity of a solution with a 1 oC change in 
temperature. Every solution has a characteristic temperature coefficient which is 
determined experimentally. 

Theoretical Plates (N)
See Column Efficiency.

Void Volume (V0)
The volume occupied by the eluent in a packed column. This volume includes the 
volume between the injection valve and the column, as well as between the 
column and the detector cell. Unretained components are eluted in the void 
volume.
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Index

Symbols
% Offset (analog out), C-21

A
Adjusting the contrast, 2-2, C-1
Air particulate samples, 3-13
Air regulator, B-51 – B-52
Alarm conditions, 4-3 – 4-8

See also Error messages
Ambient temperature, 4-19
Analog output, C-20 – C-21, D-2

% Offset, C-21
Configuring, C-21, D-10
Connections, D-10
Connector, 2-9
Full scale, C-21
Range, C-22

Analog-to-digital controller, D-10
Anion separations, 3-12
AS/AS50 (USB) Autosampler

Connections for stand-alone operation, D-7
Enabling injection valve control, D-9
Installation, B-44
Method for stand-alone operation, D-11
Sample injection, 3-16
Schedule for stand-alone operation, D-11
Time Function Out screen, D-9
Yearly maintenance, 3-22

AS40 Automated Sampler
Installation, B-48
Sample injection, 3-16
Yearly maintenance, 3-22

Atlas Electrolytic Suppressor, 2-8
See also Suppressor

Audit Trail, 2-18
Error messages, 4-1

Icons, 4-1
Automated control, 2-13
Autosampler

Loading samples with, 3-16
See also AS/AS50 (USB) Autosampler
See also AS40 Automated Sampler

Autozero, 2-19, 3-12, 3-18, C-8

B
Background conductivity

High, 4-18
Offsetting, 3-12, C-8, C-10

Backlight
Time-out, C-24

Backpressure, 2-25
Restriction in plumbing, 5-11
Troubleshooting, 4-15

Bar, C-16
Baseline

Drift, 4-19
Equilibration, B-43
Noise, 2-12, 4-19, C-20
Stability, 2-29
Zeroing, C-8

Batch processing, 3-2
Starting, 3-20
See also Sample processing

Blockages
Liquid lines, 4-6, 5-11

Bottle
See Reservoir

Browser, 2-14, 3-5, B-55
Busy page, C-24
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C
Cables

AS40 Relay Control, B-48
Power cord, 5-36
USB, B-9

Calibration, 5-1
Conductivity cell, 5-5
Flow rate, 5-8
Vacuum degas assembly, 5-10

Cation separations, 3-12
Cell

See Conductivity cell
Cell calibration, 5-5
Cell drive, A-3
Cell heater, C-9
Check valves

Cleaning procedure, 5-15 – 5-16
Replacement procedure, 5-15 – 5-16

Chromatogram, 1-3
Zeroing the baseline, C-8

Chromeleon, 2-13
Adding devices to a timebase, B-19
Alarm conditions, 4-3
Audit Trail, 4-1
Audit Trail error messages, 4-1
Browser, 2-14, 3-5
Control panel, 2-13, 3-18
Creating a sequence, 3-19
Degas options, 4-21
Direct control, 2-13
Error messages, 4-3
Installation, B-5, B-14
Interface, 2-13
License installation, B-5 – B-6
Menu, 2-13, 3-18
Programs, 2-13, 2-17, 3-16 – 3-17
Starting, 3-4, B-29
System properties dialog box, B-18
Timebase, 3-5
Toolbars, 2-13, 3-18
Using the touch screen with Chromeleon, 

C-4
Verifying communication, B-38

Wellness panel, 5-1
Chromeleon Server

Starting, 3-4, B-12
Chromeleon Server Configuration program

Timebase, B-17
Column heater, 2-7, 2-28

Chromeleon control, 2-19
Home page control, C-8
Replacement procedure, 5-28
Specifications, A-4

Column heater alarms
Column heater exceeds safe temperature, 

4-3
Column heater open circuit, 4-3
Column heater short circuit, 4-3

Columns, 2-7
Cleaning, F-2 – F-3
Contaminated, 4-18
Damage from IPA, 5-36
Installing, B-22
Storing, F-2

Commands
Chromeleon, 2-13, 3-19, B-37

Component panel, 2-6
Computer

Connections, B-9
Operating system requirements, B-5
Unpacking, B-4

Conductivity, C-8
Causes of high conductivity, F-3
Changing the display, C-24
Offset, C-8, C-24
Temperature effect, 2-29
Total, C-8, C-24

Conductivity cell, 2-8, 2-29
Calibrating, 5-5
Calibration constant, 5-25
High cell output, 4-18
Leaking, 4-11
No response, 4-18
Replacement procedure, 5-24
Setting the temperature, C-9
Specifications, A-3
Volume, 2-29



Index

Doc. 031917-02 9/05 Index-3

Conductivity cell specifications
Active volume, A-3
Cell body, A-3
Electrodes, A-3
Maximum pressure, A-3

Conductivity polarity, C-21
Contacting Dionex, 5-1
Contamination

Column, 4-16, 4-18
Eluents, 4-17
Sample, 4-17
Standard, 4-16

Control panel (Chromeleon), 2-13, 2-15, 3-18
System panel, 2-15 – 2-20
Wellness panel, 2-15

Current, C-18

D
Daily maintenance, 3-21
Data

Backing up, F-2
Deleting, F-2
Filtering, C-20
Saving, 3-18 – 3-19

Data acquisition, 3-18
Data analysis description, 1-3
Data rise time, B-50, C-20 – C-21
Decibel level, A-1
Degas tubing assembly

See Vacuum degas assembly
Degas calibration failed alarm, 4-3
Degassing eluents, 2-21, 3-6
Delay volume, A-2
Detection description, 1-3
Detector controls on Control panel, 2-19
Detector controls on Home page, C-8

See also Conductivity cell
Detector page, C-20

Setting analog out options, C-21
Setting the data rise time, C-20

Detector specifications
Cell drive, A-3

Linearity, A-3
Range, A-3
Temperature compensation, A-3

Diagnostic pages, C-26
Diagnostics, 5-1
Dimensions, A-1
Dionex

Contacting, 5-1
Direct control, 2-13
Dongle, B-6
Drip tray, 2-7
DS6 Heated Conductivity Cell

See Conductivity cell
Duty cycle, 2-22, C-17

E
Elapsed time, C-8, C-10
Electrical specifications

Fuses, A-1
Main power, A-1

Eluent
Aqueous, 3-22, 4-13
Degassing, 2-21
Delivery process, 1-2
Filtering, 3-7
Preparing, 3-6
When to remake, F-2

Eluent bottle
See Eluent reservoir

Eluent level, 3-8, B-39, C-7
Eluent reservoir

Connecting, 3-9, B-28
Filling, 3-7
Gas connection, B-51
Monitoring liquid level in, 3-8, B-39, C-7
Pressurization, B-52
Storage on top cover, 2-5

Eluent valve, 2-7, C-18
Chromeleon control, 2-19
Replacing, 5-32

End-line filter
See Filter, end-line
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Environmental specifications
Humidity, A-1
Operating pressure, A-1
Operating temperature, A-1

Equilibration time, 3-12
Error messages, 4-3 – 4-8

Audit Trail description, 4-1
Column heater exceeds safe temperature, 

4-3
Column heater open circuit, 4-3
Column heater short circuit, 4-3
Degas calibration failed, 4-3
Hardware not present, 4-4
Leak sensor wet, 4-4
Load/inject valve error, 4-4
Option not installed, 4-5
Pressure slope calibration error, 4-5
Pump motor lost control, 4-5
Pump over pressure, 4-6
Pump pressure hardware error, 4-6
Pump under pressure, 4-6
Suppressor not connected, 4-8
Suppressor over current, 4-7
Suppressor over power, 4-7 – 4-8
Suppressor stopped for zero flow rate, 4-8

F
Facility requirements, B-1
Filter, end-line

Bacterial contamination, 3-22, 4-13
Dirty or clogged, 3-22, 4-12
Installation, 3-7

Filtering data, C-20
Fittings

Leaking, 4-9
Replacing, 5-13
Requirements, 5-13

Flow rate, 2-7, A-2, C-6
Calibration, 5-8
Troubleshooting, 4-14

Flow schematic, 2-11
FROM PC

USB connections, B-9
Front panel, 2-1

Specifications, A-2
See also Touch screen

Full-scale analog output, C-21
Fuses

Replacement procedure, 5-36
Requirements, A-1

G
Gas separator waste tube, B-26

Installation, B-27
Gas source

Connection, B-51
Installation, B-51
Pressure requirement, B-51

Ghosting, 4-16
Guard column, 2-7, B-22

Installation, B-23

H
Hardware not present error, 4-4
Heater, column, 2-28

See also Column heater
High pressure alarm, 4-6
High pressure limit, A-2
Home page, 2-2, C-1, C-6, C-8 – C-9

Column Heater control, C-8
Detector controls, C-8
Injection valve controls, C-8
Pump controls, C-6

Humidity limits, A-1

I
Information page, C-23
Injecting samples, 3-14

Via autosampler, 3-16
Via syringe, 3-15
Via vacuum syringe, 3-16
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Injection port, 2-1
Injecting via syringe, 3-15

Injection valve, 2-7, 2-26
Chromeleon control, 2-19
Controlling with an AS50, D-9
Home page controls, C-8
Leaking, 4-10
Plumbing connections, 2-26
Rebuilding, 5-14
Specifications, A-3
Troubleshooting, 4-5

Input/Output page, C-25, D-9
Installation, B-1 – B-57

Adding devices to a timebase, B-19
Analog output connection, D-10
AS/AS50 (USB) Autosampler, B-44
AS40 autosampler, B-48
Assigning devices to a timebase, B-17
Chromeleon, B-5, B-14
Columns, B-22
Computer, B-4
Eluent reservoir, B-28, B-52
Equilibrating the system, B-43
Gas separator waste tube, B-26
Gas source, B-51
Guard column, B-23
Key code, B-8
Operating system requirements, B-5
Operational status verification, B-43
PC connections, B-9
Plumbing, B-28
Power connection, B-11
Priming, B-40 – B-42
Separator column, B-23
Software license, B-5 – B-6
Stand-alone operation setup, D-7 – D-8
Starting the ICS, B-12
Suppressor, B-24
TTL and relay connections, D-1 – D-2
Unpacking, B-2
USB connections, B-9 – B-10
Waste lines, B-26

Installation troubleshooting, B-57
Installed options, C-23

Inverted edge TTL input control, D-5
Inverted peaks, C-21
Inverted pulse TTL input control, D-5
Ion chromatography

Overview, 1-1
Ion exchange, 1-3
Isocratic delivery system, 1-2
Isopropyl alcohol, 5-35 – 5-36

K
Key code (Chromeleon), B-6

L
LCD screen, 2-1 – 2-2, C-1

Specifications, A-2
See also Touch screen

Leak sensor, 2-7
Leak sensor wet alarm, 4-4
Replacement, 5-34

Leaks
Cell, 4-11
Fittings, 4-9
Injection valve, 4-10
Liquid, 4-9
Pressure transducer, 4-10
Pump check valve, 4-9
Pump head, 4-10
Pump head waste valve, 4-10
Pump piston seal, 4-10
Suppressor, 4-10

LED, A-2
License (Chromeleon), B-5 – B-6
License server (Chromeleon), B-6
Linearity requirements, A-3
Liquid leaks, 4-9

See also Leaks
Load/inject valve alarm, 4-4
Loading samples, 3-14
Local Mode, C-9
Locked Remote mode, C-4
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Loop
See Sample loop

Low pressure limit, A-2

M
Main power receptacle, 2-10
Maintenance, 3-21

Daily, 3-21
Ongoing, 3-21
Weekly, 3-22
Yearly, 3-22

Manual sample processing, 3-2
MicroMembrane Suppressor, 2-8

See also Suppressor
Module Setup page, C-24
Moduleware, 4-1, C-23
MPa, C-16

N
Nitrite in samples, 3-13
Noise, baseline, C-20
Normal edge TTL input control, D-4
Normal pulse TTL input control, D-5

O
Offset conductivity, C-24
Offset percentage (analog out), C-21
Offsetting background conductivity, 3-12, C-8
Operating features, 2-1
Operating pressure, A-1
Operating ranges

Cell heater, 2-8, C-9
Column heater, 2-7, C-8
Flow rate, 2-7, C-6

Operating system requirements, B-5
Operating temperature, A-1
Operation

Equilibration time, 3-12
Overview, 3-1

Priming, 3-10, 5-35, B-42
Reservoir setup, 3-6
Sample preparation, 3-13
Sample processing, 3-2
Setting operating conditions, 3-11
Starting Chromeleon, 3-4
System power-up, 3-3

Operational status verification, 3-11
Option not installed error, 4-5
Options installed, C-23
Oven

See Column heater
Overview, 1-4

P
Panels

Chromeleon Control panel, 2-13, 3-18
Chromeleon Wellness panel, 5-1
Component panel, 2-6

Parameters
Chromeleon operating commands, 2-13, 

3-19, B-37
PC

See Computer
Peak ghosting, 4-16
Peak height

Effect of rise time on, C-21
Reproducibility, 2-29
Troubleshooting, 4-17

Peak shape, C-20
Peak width, C-21
Peaks

Effect of rise time on, C-20
Extraneous (ghosting), 4-16
Inverted, C-21
Reversed, C-21 – C-22

PEEK
Conductivity cell body, 2-29

Physical specifications
Decibel level, A-1
Dimensions, A-1
Weight, A-1
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Piston seals
Replacement procedure, 5-17 – 5-18, 

5-20 – 5-21
Pistons

Replacement procedure, 5-21
Plot, 2-19 – 2-20
Plot offset, C-10
Plot page, C-9 – C-10

Elapsed time, C-10
Plot offset, C-10
Range, C-10

Plotting detector output, 2-20, C-10
Plumbing

Columns and suppressor, B-28
Injection valve, 5-14
Replacing tubing and fittings, 5-13
Troubleshooting, 5-11

Polarity
Selecting the conductivity polarity, C-21

Power
Turning on, 3-3, B-12

Power cord, 5-36, B-11
Power receptacle, 2-10, B-11
Power requirements, A-1
Power-up conditions, 3-3
Pressure

Home page display, C-6
Limit, 4-7, C-6, C-16
Pump operating specifications, A-2
System, 4-7, C-16
Unit (selecting), C-16

Pressure ripple, A-2
Pressure slope calibration error, 4-5
Pressure transducer, 2-7, 2-25

Leaking, 4-10
System backpressure, 2-25

Pressurizing
Eluent reservoir, B-52

Prime button, C-7
Priming, 3-10, 5-35, B-40 – B-42

Pump is out of prime, 4-12
With a syringe, B-40
With isopropyl alcohol, 5-35
With the Prime button, B-42

Priming valve
Opening, 2-24
O-ring replacement procedure, 5-22

Printing, F-1
Problems

See Troubleshooting
Processing samples, 3-2, 3-18 – 3-19

Automatically (batch), 3-2, 3-19
Manually, 3-2, 3-18

Product warranty, 5-1
Program time, 2-17
Programs (Chromeleon), 2-13, 2-17

AS/AS50 (USB) example, 3-17
AS40 example, 3-17
Controlling an autosampler, 3-16
Run time, 2-17

PSI, C-16
Pulse damper, 2-12, 2-25
Pump, 2-23

Chromeleon control, 2-19
Flow rate, 2-7, C-6
Home page controls, C-6
Leaks, 4-10
Operating pressure, A-2
Over pressure alarm, 4-6
Primary pump head, 2-23
Priming, 3-10, B-40
Priming problems, 4-11
Secondary pump head, 2-24
Selecting the pressure unit, C-16
Setting pressure limits, C-16
Troubleshooting, 4-13
Under pressure alarm, 4-6

Pump check valve leaking, 4-9
Pump components, 2-23
Pump degas

See Vacuum degas assembly
Pump head waste valve

Leaking, 4-10
O-ring replacement procedure, 5-22

Pump heads, 5-15
Pump motor lost control alarm, 4-5
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Pump page, C-15
Changing the pressure unit, C-16
Setting degas parameters, C-17
Setting pressure limits, C-16

Pump pressure hardware error, 4-6
Pump priming valve

O-ring replacement procedure, 5-22
Pump specifications

Flow rate, A-2
Operating pressure, A-2
Type, A-2

R
Range, C-10, C-22
Rear panel, 2-9

Analog output connector, 2-9
Power receptacle, 2-10
USB connections, 2-9

Rebuilding the injection valve, 5-14
Recorders

Analog output setting, C-22
Relay connections

AS40, B-48
Rear panel connector, 2-10, D-1

Relay outputs
Controlling, D-5
Voltage and current specifications, D-2

Remote Mode, C-9
Reordering information, E-1
Reproducibility, 2-29
Reservoir

Connecting, 3-9
Filling, 3-7
Monitoring liquid level in, 3-8, B-39
Storage on top cover, 2-5

Restriction in liquid lines, 4-6, 5-11
Retention time

Adjusting, F-1
Moving, F-1
Troubleshooting, 4-17

Reverse peaks, C-21
Rise time, C-20

Run time, 2-17
Running samples, 3-18

See also Processing samples

S
Safety messages, 1-6
Sample loop, 2-7, 2-26

Changing, 5-13
Injecting, 2-26
Injection valve connections, 2-26, 5-14
Loading, 2-26
Reordering, E-1

Sample processing, 3-2, 3-18 – 3-19
Batch, 3-2, 3-19
Manual, 3-2, 3-18
With Chromeleon, 3-18 – 3-19

Samples
Collecting and storing, 3-13
Diluting, 3-13
Filtering, 3-13
Injecting, 3-14, 3-16
Loading, 3-14
Pretreating, 3-13

Saving data, 3-18 – 3-19
Schematic

Flow, 2-11
Seal replacement, 5-18, 5-20 – 5-21
Selectivity

Troubleshooting, 4-17
Self-Regenerating Suppressor, 2-8

See also Suppressor
Separation process, 1-3
Separator column, 2-7, B-22

Installation, B-23
Sequence, 2-13

Creating, 3-19
Sequence Wizard, 3-19
Serial number, B-18
Server Configuration program

AS50 configuration properties, B-20
Starting, 3-4, B-12
Timebase, B-17
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Server Monitor, B-6
Service chase, 2-5, 2-8
Service procedures, 5-16

Check valve cleaning, 5-15 – 5-16
Check valve replacement, 5-15
Conductivity cell replacement, 5-24
Fuse replacement, 5-36
Injection valve rebuilding, 5-14
Isolation of liquid lines restriction, 5-11
Leak sensor replacement, 5-34
Piston replacement, 5-21
Piston seal replacement, 5-17
Priming valve O-ring replacement, 5-22
Rebuilding the injection valve, 5-14
Replacing tubing and fittings, 5-13
Suppressor replacement, 5-27
Tubing and fittings replacement, 5-13
Waste valve O-ring replacement, 5-22

Sharable device, B-19
Signal plot, 2-19 – 2-20
Signal-to-noise ratio, C-20
Software license, B-5 – B-6
Specifications

Column heater, A-4
Conductivity cell, A-3
Electrical, A-1
Environmental, A-1
Injection valve, A-3
LCD touch screen, A-2
Physical, A-1
Pump, A-2
Vacuum degas assembly, A-3

Stand-alone operation, D-7 – D-11
Analog output connection, D-10
AS/AS50 (USB) setup, D-9, D-11
Example connections, D-8
TTL and relay connections, D-7

Standards
When to remake, F-1

Starting Chromeleon, B-29
Status page, C-9, C-11
Sulfite in samples, 3-13
Suppression description, 1-3
Suppressor

Controlling the current to, 2-20, C-18
Description, 2-8, 2-28
Installation, B-24
Leaking, 4-10
Replacement procedure, 5-27
Selecting the type, C-18

Suppressor alarms
Suppressor not connected, 4-8
Suppressor over current, 4-7
Suppressor over power, 4-7 – 4-8
Suppressor stopped for zero flow rate, 4-8

Suppressor page, C-18
Syringe injection, 3-15

Vacuum, 3-16
System

Shutdown, F-2
Startup, 3-3
Status, 3-11

System backpressure, 2-25
System components

Descriptions, 2-21
System Control panel, 2-15, 3-5, B-55

 See also Control panel
System overview, 1-4
System properties dialog box, B-18

T
Technical Support, 4-1, 5-1
Temperature

Cell heater, 2-29, C-9
Column heater, 2-7, 2-28, C-8
Minimizing the effect of variations, 2-29

Temperature compensation, 2-29, A-3
Time, 2-17
Timebase (Chromeleon), 3-5

Adding devices to a timebase, B-19
Assigning the ICS to a timebase, B-14, 

B-17
Time-out (screen), C-24
TO MODULE

USB port connections, B-10
Top cover, 2-5
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Total conductivity, C-8, C-24
Touch screen, 2-1, C-1

Adjusting the contrast, 2-2, C-1
Number keypad, 2-3, C-2
Operation, 2-2, C-1
Specifications, A-2
Time-out, C-24
Using with Chromeleon, C-4

Touch screen pages
Busy page, C-24
Detector page, C-20
Diagnostic pages, C-26
Home page, 2-2, C-1, C-6, C-8 – C-9
Information page, C-23
Input/Output page, C-25, D-9
Module Setup page, C-24
Overview, C-5
Plot page, C-9 – C-10
Pump page, C-15
Status page, C-9, C-11
Suppressor page, C-18

Troubleshooting, 4-1
Alarm conditions, 4-3
Baseline noise or drift, 4-19
Calibrations, 5-1
Diagnostics, 5-1
Error messages, 4-3
Excessive backpressure, 4-15
Flow rate, 4-14
High cell output, 4-18
Installation, B-57
Liquid leaks, 4-9
No cell response, 4-18
Peak ghosting, 4-16
Peak height, 4-17
Pump, 4-11 – 4-13
Retention time, 4-17
Selectivity, 4-17
Vacuum degas assembly, 4-21

TTL and relay connector, D-1
Connection instructions, D-2
Pin assignments, D-1

TTL inputs
Assigning functions to, D-4, D-9

Control type, D-9
Default function assignments, D-2
Rear panel connector, 2-10

TTL outputs
Controlling, D-5
Rear panel connector, 2-10

Tubing
Replacing, 5-13
Requirements, 5-13
Routing clips, 2-10

Tubing connections
Isolating a restriction, 4-6, 5-11

TUV, 1-8

U
Unpacking, B-2

Computer, B-4
USB cable, B-10
USB connections, 2-9, B-9 – B-10

V
Vacuum degas assembly, 2-21

Calibration, 5-10
Components, 2-21
Fails to run, 4-21
Priming, B-41
Setting operating parameters, C-17
Specifications, A-3
Troubleshooting, 4-11

Valve
See Eluent valve
See Injection valve
See Waste valve

Version number, C-23

W
Warranty, voiding, 5-1
Waste container

Preventing gas buildup, B-27
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Waste lines
Blocked, 4-9
Connection, B-26
Connection to AS50, B-46

Waste valve, 2-24
Opening, 2-24, 5-17
O-ring replacement procedure, 5-22

Water samples, 3-13
Weekly maintenance, 3-22
Weight, A-1
Wellness panel, 2-15, 5-1

Y
Yearly maintenance, 3-22

Z
Zero position (analog out), C-21
Zeroing the baseline, C-8
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